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IBM Lotus Notes, Domino, Domino Designer 8 Release Notes 

About this release 

Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), 
Domino for System i, Domino for System z 

Welcome to IBM Lotus Notes , Domino, and Domino Designer 
Welcome to the IBM® Lotus® Notes® and IBM Lotus Domino® Server family of software products.  Lotus 
Notes 8 Beta and Lotus Domino 8 Beta are the latest releases of the world's leading products for 
information management, messaging, collaboration and application development. 

These Release Notes contain information on the many new features and enhancements included in the 
Notes and Domino software products.  For an overview of the features in this release, see the "About this 
release" chapter, "New in this release" section, of these release notes. For more detailed information on 
the features, see the online help for each product, as well as the "Documentation Updates" chapter of 
these release notes. 

Before installing, please review the "Installation, migration, upgrade, and configuration information" 
chapter of these Release Notes. 

Note: These release notes represent an overview of new features and platforms that are available in IBM 
Lotus Notes and IBM Lotus Domino 8 Beta.  These release notes apply only to the current Beta release of 
Notes and Domino 8, and may not accurately represent the features or platforms available in the final 
release. Features are subject to change. 

To ensure that you have the very latest version of these Lotus Notes and Domino 8 Beta 2 Release 
Notes, please visit the following website: 

http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi?CTY=CA&FNC=SRX 
&PBL=GC23597600 

Lotus Notes 

Lotus Notes 8 Beta: Client overview 
IBM Lotus Notes 8 offers major enhancements to the core functionality of Lotus Notes, and adds 
innovative new features which represent a major shift in the way people communicate and collaborate.  
Lotus Notes 8 presents the end user with a dynamic work environment which can be tailored to the user's 
roles and responsibilities.  Built on IBM's version of the Eclipse Rich Client Platform, Lotus Notes 8 was 
developed on a componentized service-oriented architecture (SOA).  As a result, Lotus Notes 8 is more 
extensible and, as a server-managed client, less time-consuming to administer. 

The core functions of Lotus Notes - Mail, Calendaring, and Contacts - have been enhanced in a variety of 
ways to increase personal productivity and effectiveness. Lotus Notes 8 includes new ways to sort, filter, 
and preview e-mail; tools for managing personal calendars and interactions with others have been 
improved; and persistent access to collaborative tools helps keep critical information and frequently used 
applications at the user's fingertips.  
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Three innovative new capabilities in Lotus Notes 8 dramatically increase personal and organizational 
productivity: 

Composite applications - Composite applications combine components from multiple applications into 
a single, role-based work environment. With support for composite applications, Lotus Notes 8 offers 
greater flexibility to organizations seeking to rapidly respond to competitive markets. Combining 
multiple technologies into a single application provides significant business value by enabling 
companies to protect and extend their existing assets with increasing degrees of flexibility and to 
respond quickly and cost-effectively to their emerging business requirements, with applications that 
are significantly easier to create than those of alternative application development environments. 
Composite applications can be composed of any combination of Notes applications and 
Eclipse-based components.  When components are interconnected in such a fashion, data that is 
changed in one application affects the corresponding data and views in connected 
applications/components. 

IBM Lotus Productivity Tools - Lotus Notes 8 comes with a complete set of integrated productivity 
tools for creating, editing, and sharing a variety of document types.  The productivity tools include IBM 
Lotus Documents (word processing), IBM Lotus Spreadsheets, and IBM Lotus Presentations. 

Activities  - Lotus Notes 8 is built to provide activity-centric computing, which lets users organize, 
navigate, manage, and share information based on specific projects or team activities.  Activity-centric 
computing organizes tasks and projects by associating multiple types of communications and 
resources into a cohesive grouping. Note: The activities server is not provided with this Notes Domino 
8 Beta release. 

Note: To take full advantage of the Notes 8 Mail and Calendar experience, you need to upgrade to the 
Notes 8 Mail template. To take full advantage of composite applications and Activities, see the Installation 
notes section of these release notes to learn what server products you need to install. 

Besides increasing end-user productivity, these new software innovations in Lotus Notes 8 let developers 
combine their existing Lotus Notes applications with line-of-business application components to solve 
specific business problems. 

More specific information about the new capabilities in Lotus Notes 8 is provided below. 

User interface 
The Lotus Notes 8 user interface has been re-designed to greatly enhance usability. Some of the 
highlights of the new user interface include: 

z	 Consolidated user preferences 

z	 The new Open button provides a drop-down menu with quick access to all your bookmarks and 
frequently used applications. You can access the Open button from within any Notes 8 screen. 

z	 The sidebar provides easy access to Sametime Contacts (optional), Feeds, Day At-A-Glance, 
and Activities (limited availability in this beta release). 

z	 Intelligent addressing for improved typeahead, based on your collaboration history. 

z	 Lotus Notes 8 supports common keyboard and mouse shortcuts and gestures, including the 
selection of multiple messages using the Control key and the left-mouse button. 

z	 The new user interface gives users greater flexibility to view open messages and other

documents in Lotus Notes 8:


Flat tabs. You can view each item as a tab. 

Group tabs. You can view each application as a tab. 

New window. You can open messages and documents in separate windows. 
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z	 New Search Center UI for queries and results (Domain Search, Find People and Find Application, 
Web / Intranet Searches) 

z	 Multiple level "undo" command 

z	 On-the-fly spell checking 

Mail 

z	 Lotus Notes 8 Mail offers visual clues for linking messages with associated threads. Threaded 
e-mails can be gathered together and presented at the view level.  Users can easily expand mail 
threads and see all messages related to a specific topic.  A new brief preview message feature 
allows users to quickly see information contained in individual mail messages. 

z	 Users now have the option of previewing messages vertically or horizontally. 

z	 By double-clicking on an item, users can launch the item in a separate window.  A user can then 
interact with open messages and other Notes elements more easily. 

z	 Users have greater control to toggle Lotus Notes mail fields on or off.   For example, users can 
select or deselect the "bcc:" field in the Lotus Notes memo form. 

z	 Message recall capability 

z	 Improved rendering of HTML messages 

Calendar 

z	 Unprocessed invitations appear as "ghosted" or highlighted entries in the monthly calendar view.  
Users can simply double-click on the highlighted date to accept, decline, or counter the invitation. 

z	 When scheduling conflicts arise, the meeting chairperson can deselect non-critical attendees to 
find dates and times that accommodate the remaining attendees. 

Contacts 

z	 Business card-like views for displaying individual contact information. 

z	 Contact records can include a photograph of the person. 

z	 Instant messaging chats can be initiated from the Contact view. 

z	 Contact delegation to allow others access to your list of personal contacts. 

z	 Drop-down addressing and the "Recent Contacts" view in Contacts presents a list of people you 
have recently collaborated with to speed the addressing of outbound messages.

z	  "Collaboration History" provides an easy way to see documents that have been recently 

collaborated on with specific people.


IBM Lotus Productivity Tools 

z	 Support the OASIS Open Document Format (ODF), an international standard for sharing and 
editing editable documents.  These open standards-based applications give users and 
organizations a choice of file formats and frees them from proprietary vendor formats. 

z	 Can also open, edit, and save documents in certain Microsoft Office formats. 

z	 SmartSuite formats can be imported to the Lotus Productivity Tools through an included filter. 
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Composite applications 

z	 End users can access composite applications from within the Lotus Notes interface. 

z	 Organizations can deploy composite applications made up of only Notes applications or they can 
create composite applications using a variety of component types including Eclipse/Java 
applications.  

z	 Composite applications in Lotus Notes 8 can be used online or offline. 

Activities (The activities server is not provided with this Notes Domino 8 Beta release.) 

z	 E-mail, instant messaging chats, documents, web pages, and images are grouped together under 
the activity or project to which they are related. 

z	 Graphical, hierarchal format makes it easier to refer to past work, visualize project status, and 
discover opportunities for further progress.  

z	 Users can quickly create new activities or access existing activities via the Activities viewer. 

z	 Team members can edit documents, make comments and add information as needed. 

z	 Activities can be searched and filtered.  

More features 

For a more detailed listing of Lotus Notes 8 features, see the About this Release > New Features section 
of these Release Notes. 

Using Lotus Notes 8 on low-memory machines 

A basic configuration of Notes 8 is available for cases involving low-memory client machines. As in 
previous releases of Notes, clients running this basic configuration can access only applications that 
reside on Domino servers. For more information on what Notes 8 features are available with this 
configuration, see "Features not available in "basic" configuration of Notes 8" in these release notes. 

Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), 
Domino for System i, Domino for System z 

Help - usage and availability 
Help represents a draft of features that are available in IBM Lotus Notes and IBM Lotus Domino 8 Beta.  
Help applies only to the current Beta release of Notes and Domino 8, and may not accurately represent 
the features available in the final release.  Features are subject to change. 

Lotus Notes Help 

Lotus Notes 8 Beta includes an Eclipse-based Help system that lets you display context-sensitive help in 
a side panel while you work. In addition to help for Lotus Notes, this Help includes sections on Sametime 
Connect, Activities, Feeds, Composite Application Editor, Portal Template Library and Portal Application 
Catalog, Google Desktop Search, and IBM Lotus Productivity Tools, all of which might be installed as part 
of the client installation. 
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You can access Notes Help in the following ways. 

z	 Click Help --> Help Contents from the menu bar 

z	 For context-sensitive help, press F1 (Ctrl+F1 for Linux users), click Help --> Dynamic Help from the 
menu bar, or click the "?" in the toolbar or in the top right corner of most dialog boxes 

Also see the Documentation Updates section of these release notes. 

Domino and Domino Designer Help 

Lotus Domino 8 and Lotus Domino Designer 8 Beta includes Help .NSF files for Lotus Domino 
Administrator (Server) and Lotus Domino Designer Help. The Help .NSF files are installed by default in 
the HELP directory of your Domino or Notes data directory. 

Title Database file name Description 

Lotus Domino Designer 8 HELP8_DESIGNER.NSF Lotus Domino Designer and programming 
Help language Help 

Lotus Domino HELP8_ADMIN.NSF Lotus Domino server and Lotus Domino 
Administrator 8 Help Administrator Help 

You can access Domino and Domino Designer Help in the following ways: 

z	 Click the link to Help on the Notes, Domino Designer, or Domino Administrator Welcome pages 

z	 Click Help --> Help Topics from the menu bar 

z	 Press F1 

z	 Click the "?" in the top right corner of most dialog boxes 

z	 Click File --> Application --> Open and browse to your local directory or a Domino server 

z	 Visit the Domino and Notes Documentation site at http://www.lotus.com/doc 

Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), 
Domino for System i, Domino for System z 

Release notes - updated information available on-line 
The Release Notes that are available on-line are more up-to-date than the Release Notes that are 
shipped with the product.  This is due to production schedules; after the product ships, updates are 
sometimes made to the Release Notes and posted on the Lotus Documentation website. 

To ensure that you have the very latest version of these Lotus Notes and Domino 8 Beta 2 Release 
Notes, please visit the following website: 

http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi?CTY=US&FNC=SRX 
&PBL=GC23597600 
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Lotus Notes 

Reporting Notes 8 Beta issues and problems

If you experience any problems installing or using Lotus Notes 8 Beta, we want to hear from you in the

form of a software problem report. Information about what to include in the problem report and the

process by which you can submit a problem report to IBM Lotus are provided below. 


Information to include in the problem report 
The problem report should provide as much information as possible to recreate the problem. This includes 
the following: 

1. As much build and platform related information as is relevant  

2. Detailed steps to reproduce the problem

3. Actual test case contents, or links to the test cases

4. Screen shots if applicable showing relevant messages

5. All of the supporting logs

6. All environment variables in printed list form (for example, type "set" into a DOS command window on

the test machine and provide the resulting printed list of ENV variables)


What logs and files do I need to attach ?

The answer is all of them. The best way to do this is to use IBM Support Assistant (ISA).


Preferred Option - Running the Integrate d IBM Support Assistant  (ISA) from within Notes 8 Beta to 
create problem reports 
Use the integrated collector to gather the information. From Notes 8 Beta, start the IBM Support Assistant 
(click Help > Support > IBM Support Assistant to start the Support Assistant). Once you have started the 
Support Assistant, click Service along the top menu, then click Collect Data. Make sure that all collectors 
are marked to generate data. Once collected, attach the results to the problem report. By using this 
collector, all logs are terminated properly allowing for easier handling by the recipient.  
Also be sure to attach a list of all environment variables in printed list form (for example, type "set" in a 
DOS command window on the test machine and also send the resulting printed list of ENV variables). 
The integrated IBM Support Assistant is described in Notes 8 Beta online Help by clicking Help > Help 
Contents > IBM Support Assistant User's Guide. 

Secondary Option - Running a Standalone IBM Support Assistant  (ISA) to create problem reports 
If the integrated collector is not available, then second option is to use the standalone collector. 
From the <installdir>\rcp directory, run the startcollector.bat (Windows), or startcollector.sh (Linux) to 
gather the information. 
Once collected, attach the results to the problem report along with a list of all environment variables in 
printed list form (for example, type "set" into a DOS command window on the test machine and also send 
the resulting printed list of ENV variables). 

Third Option - Manual Collection

Collect the following files:  (see "Where is the Workspace?" section below for locating the <workspace>) 


z <workspace>\.config directory contents 
z <workspace>\.config\org.eclipse.update contents including subdirectories 
z	 <workspace>\logs directory contents 
On Windows 
z %TEMP%\rcpInstallerTemp.properties 
z	 %TEMP%\rcp_install.log  
On Linux 
z <installdir>\rcp_install.log 
z Environment variables list 
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Note: On Notes 8 Beta, the files referencing <installdir>\rcp are located in <installdir>\framework\rcp. 
z	 <installdir>\rcp\plugin_customization.ini 
z	 <installdir>\rcp\rcplauncher.properties 
z	 <installdir>\rcp\deploy directory contents 

Then zip them up and attach to the problem report. Please note in the problem report that these were

manually collected. 


 The following is representative of the files that would be collected based upon above (and what is 

collected by ISA):


<workspace >\.config\args.properties

<workspace >\.config\config.ini

<workspacw >\.config\org.eclipse.update

<workspace >\.config\rcpinstall.properties

<workspace >\.config\org.eclipse.update\error_recovery.log

<workspace >\.config\org.eclipse.update\history

<workspace >\.config\org.eclipse.update\install.log

<workspace >\.config\org.eclipse.update\platform.xml

<workspace >\.config\org.eclipse.update\history\1170947398000.xml

<workspace >\.config\org.eclipse.update\history\1170947431000.xml

<workspace >\.config\org.eclipse.update\history\1170947596000.xml

<workspace >\logs\error-log-0.xml

<workspace >\logs\error-log-1.xml

<workspace >\logs\Log_Viewer.xml

<workspace >\logs\trace-log-0.xml

<workspace >\logs\trace-log-1.xml

<workspace >\logs\Trace_Viewer.xml

<workspace >\logs\Viewer_Translations.js

%TEMP%\rcpInstallerTemp.properties

%TEMP%\rcp_install.log

<installdir >\rcp\plugin_customization.ini

<installdir >\rcp\rcplauncher.properties

<installdir >\rcp\deploy\install.xml

<installdir >\rcp\deploy\platform_plugin_customization.ini

<installdir >\rcp\deploy\provisioning.log


Where is the workspace ?

On Windows platforms, the workspace is going to be located based on environment variable settings.


z	 %HOMEDRIVE%%HOMEPATH%\IBM\RCP%rcp.install.id%%USERNAME%. 
z	 If HOMEDRIVE and HOMEPATH are not set, then 

%USERPROFILE%\IBM\RCP%rcp.install.id%%USERNAME% is used. 

On Linux platforms, the workspace is going to be located based on environment variable settings 

z	 $USER_HOME/IBM/RCP/$rcp.install.id/$USER 

On both platforms, the workspace may have also been specified on the command line such as 
rcplauncher -data c:\temp 

The value of rcp.install.id is specified as a property in the <installdir 
>\rcp\rcplauncher.properties file (<installdir 
>\framework\rcp\rcplauncher.properties on Notes 8 Beta). 
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New in this release 

Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), 
Domino for System i, Domino for System z 

New features in IBM Lotus Notes  8 Beta

The following list represents an overview of the new features that are available in the IBM Lotus Notes 8 

Beta client.  These features apply only to the current Beta release of Notes 8, and may not accurately 

represent the features available in the final release.  Features are subject to change.  For more 

comprehensive information about new features, please refer to the on-line Help files, and to the 

Documentation Updates chapter of these release notes.


Client 

User Interface (UI) 

z	 A new, Java-based client option with a newly-designed UI, including an "Open" button to access your 
bookmarks. 

z	 Better single log-on integration.  For more information, see the Client Help topic "Synchronizing your 
Windows NT/2000 password with your Notes password" 

z	 Name change from 'Welcome Page' to 'Home Page'. 

z	 Support for Themes - Notes components support the OS theme for increased font size, and when 
using High Contrast mode. 

z	 Support for displaying view column sizes in KB, MB, or GB. 

z	 Replication/Sync page improvements. 

z	 Unified Mail and Calendar preferences. 

z	 Hover Help/Tool Tips for Action bar items. 

z	 Folder name change from "Databases" to "Applications". 

z	 Multi-level "Undo" operations, including more operations that can be undone. 

z	 Additional "Undo" operations for tables. 

z	 Usability improvements in the Application Open dialog. 

z	 Enhanced Attachments dialog allows access to Windows-based places, for example, My Documents, 
Desktop, or My Computer (Windows only). 

z	 Property infobox has better contextual graying. 

z	 Names and text fields have been enhanced to show ellipsis (. . . .) instead of allowing multiple lines in 
a field. 

z	 An enhancement to support URL lengths greater than 250 characters. 

z	 Improved options for Network Failover/Network Awareness.  This includes, for example, saving a 
document in another server replica during a failover. 

z	 Viewer support for Open Office-formatted documents. 

z	 Support for feed reader; see "Feed reader functionality in Notes 8 client" in these release notes for 
additional information. 
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z	 Support for multiple monitors (Windows only). 

z	 An Eclipse-based Help system that allows you to display context-sensitive help in a side panel while 
you work. In addition to help for Lotus Notes, this Help includes sections on Sametime Connect, 
Activities, the Composite Application Editor, and the IBM Word Processing, Spreadsheet, and 
Presentation tools, all of which you can choose to install as part of the client install.  Note: The content 
of the beta Help is not final. 

Installation 

z	 Eclipse install handler manages aspects of of the download and installation process, such as: New 
Install, Upgrade, Uninstall, and Administrator control over installation parameters. 

z	 Support for Administrator override during Notes installation. 

z	 Support for launching the Notes client via command line. 

Contacts 

The former Notes and Domino Personal Address Book is now called Contacts; functionality that was

previously included in your Personal Address Book is now included in your Contacts.  New features

available with Contacts include:


z	 Improvements to the Contact and Group forms, and to the Preferences UI. 

z	 Ability to include a photograph of the contact in the record. 

z	 Ability to add up to 10 phone numbers. 

z	 An additional street address set. 

Calendar and Scheduling 

z	 Unaccepted calendar entries display as "ghosted" entries in the Calendar view for new meeting and 
reschedule notices. This feature is turned off by default; users must enable this feature in the 
Calendar Preferences. This feature requires a Domino 8 Beta server. 

z	 Cancelled meetings can be displayed automatically in the calendar or removed outright.  This feature 
is turned off by default; users must enable this feature in the Calendar Preferences. 

z	 Entries with short durations, for example 1 minute, display in timeslot views with a duration of 15 
mins, to allow the user to see more information about the appointment.  This feature is turned on by 
default. 

z	 All Day events now display in the full day rather then just in the top area. 

z	 Calendar Form UI Improvements, including Day-At-A-Glance 

z	 Users can locate free time for a subset of their Invitee list. 
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Mail 

z	 An improved mail form, with easier-to-access menu bar choices, requiring fewer 'clicks' to perform 
desired actions. 

z	 Simplified Mail preferences. 

z	 Updated and additional Letterhead choices. 

z	 User settings to display additional information when composing or opening mail (From, Sent By, BCC, 
Additional Options). 

z	 Improved, simplified Action Bar buttons. 

z	 Within the Inbox, the ability to see all related messages in a thread. There are two different options: 
one that collapses all messages under the most recent response, and another that provides the mail 
thread on-demand from the Inbox. 

z	 The ability to perform operations for an entire mail thread, such as deleting a thread, or moving a 
thread to a folder. 

z	 Improved Out-of-Office dialog, with new features such as specifying hours. 

z	 Message Recall capability. 

z	 HTML rendering has been improved for Read, Edit, and Print functions in the embedded browser. 

z	 Remote images no longer download automatically when viewing an e-mail from the internet; this 
prevents spammers from knowing an e-mail has been successfully delivered.  Instead, the "Show 
Images" action is available in the e-mail header, in the View menu, and by right-clicking. 

IBM Lotus Productivity Tools 

z	 Support for the OASIS Open Document Format (ODF), an international standard for sharing and 
editing editable documents.  These open standards-based applications give users and organizations 
a choice of file formats and frees them from proprietary vendor formats. 

z	 Users can open, edit, and save documents in certain Microsoft Office formats. 

z	 SmartSuite formats can be imported to the Lotus Productivity Tools through an included filter. 

Sametime Connect (optional) 

z	 Save Chat Transcript in Mail File feature. 

z	 For more features, see "Lotus Sametime servers and available features" in the Installation -> 
Software Requirements section of these Release Notes 

Composite Applications 

Composite applications combine components from multiple applications into a single, role-based work

environment. Composite applications can be composed of any combination of Notes applications and

Eclipse-based components.


z	 Support for integrating Notes applications into composite applications. 
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Activities (limited availability in this beta release ) 

The Activities function lets teams of users achieve project objectives by participating in different activities. 
Activity-centric computing organizes tasks and projects by associating multiple types of communications 
and resources into a cohesive grouping. 

z	 Menu support for activities, and support for dragging-and-dropping from a Notes view to create an 
activity. 

Print 

z	 Print tab labels when printing a tabbed table. 

z	 Print each tab of tabbed tables independently. 

z	 Enhanced support for printing Contacts. 

z	 Print Preview starts on current page. 

Reliability and Serviceability 

z	 Integrated logging of Notes client error and warning dialogs. 

z	 Usability improvements made to many previously problematic error messages. 

z	 Added information about error causes, solutions available via a new "Get Information" button. 

z	 Support for logging of Instant Messaging transactions. 

z	 Automatic updating of references to server applications that have been deleted or moved. 

z	 New user interface to enable/disable console logging. 

Search 

z	 Improved Search syntax allows for web-style queries of NSF content. 

z	 New Search Center UI for queries and results (Domain Search, Find People and Find Application, 
Web / Intranet Searches). 

z	 If installed, Google Desktop Search can be launched by right-clicking Live names, and is also 
available in the Search Center. 

z	 Help has a new Search that searches across all "books" in a help system. 

Spell Check 

z	 In-line spell checking support. 

z	 Support for German Re-Reform. 

z	 Support for additional languages (Kazakh, Maltese, Welsh). 

Template 

z	 A new blog template, allowing users to easily create blogs in Notes; see "Web log (blog) database 
template" in these release notes for additional information. 

z	 Support for RSS feed-enabling of Notes databases; see "Feed reader functionality in Notes 8 client" 
in these release notes for additional information 
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Domino Designer 

z	 Support for Composite Applications, including the following: 

z	 Property Broker Editor to create Properties design element (WSDL file) for composite applications 

z	 Property broker support for using Personal Information Management (PIM) applications in

composite applications


z	 Support for using PIM components standalone in composite applications 

z	 Built-in view filtering 

z	 Ability to open views without a frameset 

z	 Portlet generation feature in the Composite Application Editor (CAE) 

z	 Pre-configured component views in CAE palette 

z	 Ability to import/export component views in CAE Component palette 

z	 Ability to add the component view of a current application to the CAE palette 

z	 NSF component picker in CAE 

z	 Support of cross page wiring in CAE 

z	 Ability to copy as link with composite applications 

z	 Ability to add composite application bookmark to Launcher 

z	 Improved property broker debugging 

z	 NSF-based update site support 

z	 Predefined/hardcoded Replica IDs for Mail, Contacts and current databases 

z	 Support for Mail Threads. 

z	 Infobox property to show partial response hierarchies. 

z	 Support for pictures in Contacts. 

z	 Support for display of ellipsis (. . .) instead of multiple lines in Names field type. 

z	 Support for view column property that displays number format in KB, MB, or GB. 

z	 Support for Out-of-Office changes. 

z	 @Function to compute folder membership for a document. 

z	 "Display as split button" property. 

z	 "Build index on first use" property. 

z	 View column property to extend column to window width. 

z	 Outline entry property displays a separate line above the entry. 

z	 Advanced database property to allow compressed design elements. 

z	 Infobox property to hide view column header. 

z	 Infobox property that allows Administrators to prevent application searches when the application is 
very large. 

z	 Web Services Consumer script library support. 
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Domino Web Access 

z	 Domino Administrators can enable Domino Web Access security settings via policies using a Security 
Policy Settings document. For additional information, see the release note "Using Security Policy 
Settings" 

z	 Domino Web Access will have a new look and feel. Also, the color scheme will best fit in portal, when 
the URL includes the &client=wps argument 

z	 Added support and integration of LanguageWare libraries and dictionaries, which provides spell 
check dictionary support for German Reform language, along with a multi-threaded server spell check 
engine for Domino Web Access. 

z	 New integrated Instant Contact List Manger interface and refresh of awareness icons 

z	 More feature parity with Notes mail client -- Feature interoperability enhancements including support 
for Preview Pane, Calendar View filters, Preferred Rooms and Resources, and Managed Mail and 
Calendar 

z	 Support for RSS feed-enabling of Notes databases; see "Enable RSS feeds for mail Inbox" in these 
release notes for additional information 

Domino Server, Domino for System i, Domino for System z 

New features in IBM Lotus Domino  8 Beta

The following list represents an overview of the new features that are available in IBM Lotus Domino 8 

Beta. These features apply only to the Beta release of Domino 8, and may not accurately represent the

features available in the final release.  Features are subject to change.  For more comprehensive

information about new features, please refer to the Documentation Updates chapter of these release

notes.


Notes Client support 

z	 Improved user registration 

z	 Better single log-on integration 

z	 Mail thread support 

z	 Recall message support 

z	 Support for administration of Windows navigation and management themes 

z	 Notes client version view in the Domino Directory 

Messaging 

z	 SMTP Sender Authentication 

z	 Reverse-path setting for forwarded messages 

z	 Error limit before a connection is terminated - Specify the number of protocol errors that can be 
returned for a session before the session connection is terminated 

z	 Reject ambiguous names that are retuned during directory lookups 

z	 Deny mail to group names returned during directory lookups 

z	 Router group expansion 

z	 Transfer and Delivery Delay reports 
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z	 Convert TNEF file attachments to Notes file attachments 

z	 Support Mail Threads when sending/receiving internet mail 

z	 Enable SMTP outbound authentication to relay hosts 

1
Domino and DB2

z	 Enhanced management of Domino Master DB2 Account (Domino server user account) 

z	 Move Container feature in UI 

z	 SQL updates/inserts/deletes are transactional 

z	 DB2 Query view setting row limits is supported 

z	 DAV/QV design elements supported in a non-DB2 environment 

z	 Domino and DB2 enabled on Linux platform 

z	 HTTP access for QueryView 

z	 New DB2 Group server commands 

z	 Recreate links to DB2 enabled Notes databases tool 

z	 Compacting DB2 groups 

Domino Web Access support 

z	 Domino administrators can enable Domino Web Access security settings via policies using a Security 
Policy Settings document. For additional information, see the release note "Using Security Policy 
Settings" 

z	 Domino Web Access will have a new look and feel when viewed in a portal, when the URL includes 
the &client=wps argument. 

Administration 

z	 Improved throughput of critical administration process requests 

z	 Domino Portal Integration Wizard for Domino Extended Product Portlets 

z	 Integrated Administration Frame in Domino Administration Client for embedding External 
Administration Interfaces (such as portal) 

z	 DDM improvements (modular correction actions, event clearing, etc.) 

z	 DDM probe for monitoring LDAP requests 

z	 DDM WebSphere Services probe 

z	 DDM Administration probe type and Automatic Report Closing probe subtype 

z	 DDM Common Actions button on Events document 

z	 A new "updatesite.ntf" template which implements a complete, bona-fide Eclipse Update Site 
1 

z	 Integration with Tivoli Enterprise console

z	 Performance and other improvements to server task monitoring 

z	 New options in Administration Preferences UI 

z	 Web enablement improvements to Domino Directory and Administration Process databases 

z	 Policies -- How to apply setting 

z	 Policies - Activities policy settings document 
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z	 Policies - IBM Lotus Productivity Tools settings document 

z	 Policies -  Window Naviigation settings in desktop policy settings document 

z	 Policies - Policy managment of Inbox cleanup on desktop policy settings document 

z	 Server command - Tell adminp process restart 

z	 Option to synchronize unread marks when creating replicas 
1 

z	 Allow diagnostic data to be sent to IBM

Java 

z	 Java console enhancements, for example, auto-connecting multiple, recently connected servers at 
startup 

z	 Support Same Java Runtime 

Replication 

z	 Streaming cluster replication 

Security 

z	 AES cipher support for SSL.  Domino 8 introduces the ability to configure the Domino server to use 
the TLS_RSA_WITH_AES_128_CBC_SHA and TLS_RSA_WITH_AES_256_CBC_SHA ciphers for 
SSL, as defined in RFC 3268. 

z	 Use of xACLS to protect Internet password fields in the Domino directory 

Web Server 

z	 User-defined attributes can now be added to the <HTML> tag generated by the web engine. If the 
field $$HTMLFrontMatter is present on a form, its contents will be placed in the generated HTML, 
ahead of the <html> tag, and the web server will not generate anything there automatically.  The 
expected use of this feature is to supply a custom <!DOCTYPE> declaration for the generated HTML. 

Note that as with other of these special fields, it is the application designer's responsibility to insure 
that the field is not visible on the form and that it does not allow POSTing of that field. 

The content of the field is not used by the web server in any other way - it has no other effect on the 
generated HTML other than as described above.  For example, suppling a doctype of HTML 4.01 
STRICT will not cause the web engine to generate strict HTML.  The content of the field is not 
validated in any way. 

Limitation of thecurrent implementation: the special field is not recognized in custom response forms.. 

z	 Users can now specify a custom <!DOCTYPE> declaration on a per form basis.  If the field 
$$HTMLTagAttributes is present on a form, its contents is placed in the attribute list of the <HTML> 
tag. Note that as with other of these special fields, it is the application designer's responsibility to 
insure that the field is not visible on the form and that it does not allow POSTing of that field. 

The content of the field is not used by the web server in any other way - it has no other effect on the 
generated HTML other than as described above.  The content of the field is not validated in any way. 

Limitation of current implementation: the special field is not recognized in custom response forms. 

Footnotes

  These features are not available for the System i platform in the current beta release.
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Lotus Notes 

Activities preview 
The Activities sidebar panel provides an entryway into the new collaborative world of activity-centric 
computing. Using Activities, you can collect and organize all of the content related to a particular project in 
a single place, including Notes documents and mail messages, chat transcripts, Web pages, To Do 
entries, and so forth. 

The following list summarizes a few of the Activities features supported by the Notes client: 

z	 From the Activities panel in the Notes sidebar, you can perform the following tasks: 

- View a list of your activities 

- Create a new activity 

- Assign a priority to an activity and sort activities by priority 

- Display entries in an activity as a hierarchical outline or as a list. 

- Add members to an activity 

- Add e-mail messages and other Notes documents to an activity 

- Add to an activity conversation by replying to an existing entry in context. 

- Search for activities by member, tag, or title 

- Click an activity or activity entry to display a preview of it. 

- Drag a file from the desktop to an activity. 

- Launch the Activity Dashboard in your default browser.

z	 Click a button in a Sametime chat window to add a chat transcript to an activity. 

z	 Search for related activities for a Sametime contact. Related activities are the activities that you have 
in common with another person. 

An Activities server is required to use the preceding features. Features are subject to change.  For more 

comprehensive information about Activities, open the Activities book in the Notes Help.


Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), 
Domino for System i, Domino for System z 

Notes.ini documentation on Lotus developerWorks 
The Notes.ini variable documentation can now be found only on the IBM Lotus developerWorks Web site 
(http://www-128.ibm.com/developerworks/lotus/documentation/notes-ini/), where it can be updated on a 
regular and more frequent basis. 

The Domino Administrator Help still includes information about how to use the Notes.ini file and how to set 
Notes.ini variables through policies. The documentation also includes information on the Notes.ini 
variables that are found in the Configuration document for the Domino server. 
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Backward compatibility 

Lotus Notes, Domino Server 

Domino 8 Billing feature 
The Billing feature is included in IBM Lotus Domino 8 for legacy support.  No bug fixes or feature 
enhancements are planned for the Billing feature, and you are encouraged to migrate to Activity Logging 
for the equivalent functionality. 

Domino Server 

Using a subform multiple times on the same form on the web 
The Domino Designer and Notes Client do not allow a subform to be used on a form more than once.  
The web server was allowing this, which could lead to incorrect forms and possible crashes if the subform 
were included recursively. With 7.0.3, this problem has been corrected, and an error page will be 
generated if a form refers to a subform more than one time (whether recursively or iteratively). 

It is likely that the only way an application can get into this situation is to use a computed subform, as the 
Domino Designer will not allow a subform to be placed on the form if it is already on the form. 

Product compatibility 

Lotus Notes, Domino Server 

Domino 8 defaults to ODS 43 
IBM Lotus Domino 8 supports file format, on-disk structure (ODS) 43. 

Upgrading from ODS 43 to ODS 48 
To upgrade from an ODS 43 to an ODS 48 format database in Domino 8, set the NOTES.INI file 
parameter Create_R8_Databases=1 in the NOTES.INI file on the Domino server or the Notes client. 
When you set Create_R8_Databases=1, new databases are created using ODS 48.  Use copy style 
compacting to upgrade existing ODS databases to ODS 48.  Use this command to run copy-style 
compacting: 

compact -c <database name> 

Note In-place compacting has been changed. When a pre-ODS 48 database is detected, Domino does 
not automatically convert to copy-style compact to upgrade your databases. 

ODS 48 provides potential improvement for I/O and folder optimization. The following Domino 8 features 
require ODS 48: 

z Enhanced Database User Activity 

z NSF support to optimize renames and deletes using the Administration Process 

z Enhanced Modified Notes Log for threaded views in IBM Lotus Notes 8 

z Design note compression 

z Defer index creation (IBM Lotus Domino 8 Designer) 
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Reverting back one ODS level 

To revert back one ODS level, use the compact -r command as shown here: 

compact -r <database name> 

Lotus Notes 

Forward Event to Tivoli Enterprise Console 
Forward Event to Tivoli Enterprise Console is only working on Win32 and AIX machines. 

Domino Server 

Using Notes/Domino 8 with BlackBerry servers 
Research In Motion (RIM) does not officially support Notes and Domino 8, as it is not officially released 
yet. Note that, in general, synching your Notes 8 Beta 2 client with your Blackberry device is not 
supported.  The Blackberry Server may not function properly when used against a Notes 8 template, for 
example, mail8.ntf or pubnames.ntf.  If, however, you want to attempt, in an unsupported fashion, to use a 
Blackberry against Notes and Domino 8, make sure you are at least on BlackBerry Server version 4.1 
Service Pack 3. 

TM
The BlackBerry Enterprise Server  (BES) extends Domino messaging and collaboration applications to 
mobile professionals using BlackBerry® handheld devices. 

BlackBerry servers may crash unexpectedly when the server Name and Address Book (NAB) is upgraded 
to the new Notes/Domino 8 design or when users switch to the mail8 template.  On your server console, 
you may see an error similar to the following: 

Process E:\domino\nBES.EXE (4172/0x104C) has terminated abnormally 

In addition, NSD may or may not activate.  In either case, the BES task is not functioning, and BlackBerry 
users will be unable to receive mail. 

Workaround 
Administrators should upgrade to the latest BES release that has Domino 8 support.  

BlackBerry service packs are available on the web at: 

http://www.blackberry.com/support/downloads/index.shtml 
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Installation, migration, upgrade, and configuration 
information 

Hardware requirements 

Lotus Notes, Domino Designer, Domino Server, Domino for System i, Domino for System z 

Notes 8 and Domino 8 Beta hardware requirements 
For a list of the Lotus Notes 8 Beta and Lotus Domino 8 Beta hardware requirements for each supported 
platform, please see the release note titled "Notes 8 and Domino 8 Beta platforms and system 
requirements" in the 'Software requirements' section of this chapter. 

Domino for System i 

System i: Server hardware requirements 
System i (formerly i5/OS) requirements 

z IBM iSeries model 270 or 8xx servers; or eServer i5 model 520 and above 

The following models are recommended: 
z iSeries 270, 810, 820, 825, 800-2464 and above 
z eServer i5 520-0901 and above 

The following models are not supported:  
z iSeries 800-2463 
z eServer i5 520-0900 

Note: Although a Domino server can run on any POWER model, the iSeries server models are 
optimized for client/server applications such as Domino.  iSeries 270, 800-2464, 810-2465, and 
eServer i5 520-0901 are recommended for Notes-based mail or light applications only.  Partial 
processor models may not be suitable for compute-intensive applications;  IBM eServer i5 
520-0902 or higher recommended for CPU-intensive workloads. 

Memory requirements 

z 512 MB or more minimum 

z 512 MB or more per Domino server 

Disk requirements 

z 2GB of free space minimum. 
z 4 or more drives recommended 
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Use these values as general guidelines for minimum memory and disk space. The requirements for your 
environment may be different. For more information about sizing an iSeries or i5/OS server for Domino, 
use the IBM eServer Workload Estimator.  The Estimator is available at the following Web site: 

http://www.ibm.com/eserver/iseries/support/estimator 

See the System i Performance Capabilities Reference  for more details on specific models. 

http://publib.boulder.ibm.com/infocenter/iseries/v5r4/topic/books/sc410607.pdf 

Lotus Notes, Domino Server 

Tested Smartcard Packages 
Smartcard functionality has only been tested under Win32-based operating systems. The following 
smartcard packages have been tested with this beta release of Notes/Domino, and indicated packages (*) 
have caveats listed below. Untested smartcards that include PKCS #11 libraries may work with this beta 
release of Notes/Domino. Entries left blank indicate functionality that has not been tested with this beta 
release. 

Smartcard Package Lock ID with 
password 

Lock ID 
With Key 

Removing 
token will 

Use 
pre-loaded 

Sign with 
RSA keys on 

Decrypt with 
RSA keys on 

equivalent on 
token 

on 
Smartcard 

generate 
'F5'-style 

keys and 
X.509 

token the token 

logout certificates 
ActivClient 5.4 yes yes yes n/a yes yes 
ActivClient 5.4 with 
CAC tokens 

no (R/O 
token) 

yes yes yes yes yes 

Aladdin eToken RTE 
3.65 

yes yes yes n/a yes 

A-Trust a-sign Client 
v1.2.2.1 (*) 

yes yes (7.02+) yes yes yes (1536 
bits) 

n/a 

Belgian eID v2.5.9 
(*) 

no (R/O 
token) 

yes yes yes yes no 

Datakey CIP 4.07 (*) yes yes yes n/a yes 
Estonian eID (*) no (R/O 

token) 
no (*) no yes yes yes 

Eutron CryptoIdentity 
Cryptokit 3.7.1 

yes yes yes n/a yes yes 

GemSafe Libraries 
4.2.0 SP3 (*) 

yes no yes yes yes n/a 

IBM Embedded n/a n/a no no 
Security System 
with Client Security 
Software 
v6.01.0037.00 
Rainbow iKey 2032 
SDK v4.7.0 
Rainbow CryptoSwift yes yes n/a n/a yes yes 
eCommerce Server 
Accelerator PCI 
CS400 model 2.2.6a 
(*) 
Secude v5.6 (*) no yes yes yes yes yes 

20 



IBM Lotus Notes, Domino, Domino Designer 8	 Release Notes 

Smartcard Package Caveats : 

z	 The technique introduced in 7.0 to "Lock ID With Key on Smartcard" will be used with all tokens 
that support C_Sign for CKM_RSA_PKCS with input lengths up to k-11 bytes, in accordance with 
the PKCS#11 specification.  New techniques for locking the ID file using a private RSA key on the 
smartcard were added in later releases for some tokens that do not support the full range of input 
lengths, and those tokens are marked with (version+) in the relevant columns of the above table.  
ID files locked with these new techniques can not be used by older versions of Notes/Domino; 
attempts to do so will result in an "Unsupported ID file version" error. 

z	 Aladdin eToken RTE 3.65 has been tested with this beta release using eToken PRO USB 64k 
tokens and eToken NG-FLASH USB tokens. 

z	 The Belgian eID was tested with run-time version 2.5.9, and we highly recommend that 
customers upgrade to the most recent version of the Belgian eID Run-time software. Users will 
receive redundant PIN prompts from the PKCS#11 library as well as Notes due to the token 
failing to set the CKF_PROTECTED_AUTHENTICATION_PATH token flag, but setting 
"allow_sso = false" in the  Belgian eID configuration file beidbase.conf will eliminate the duplicate 
prompts. However, setting that variable and rebooting with the token in the reader may result in 
the PKCS#11 library hanging when first attempting to use the smartcard. This problem does not 
appear to occur when the ID file is locked with a key on the smartcard. 

z	 The DataKey CIP 4.07 software installs multiple PKCS#11 libraries. dkck201.dll uses PKCS#11 
v2.01 and has been tested successfully with Notes; dkck232.dll uses PKCS#11 v2.00 and does 
not work with Notes. 

z	 The Estonian eID was tested with the PKCS#11 library from id-card-installer-0.7.exe (2/14/2006)  
Using this version of the library, the pre-loaded certificates could be imported into the ID file and 
used for S/MIME signing and decryption, but smartcard login was nonfunctional. It is possible that 
a newer version of the smartcard drivers will fix the token limitation that prevented the "Lock ID 
With Key on Smartcard" action from succeeding. 

z	 The GemSafe Libraries 4.2 SP3 returns CKR_DEVICE_ERROR instead of 
CKR_TOKEN_NOT_PRESENT from C_GetTokenInfo when no token is in the reader. If Notes 
fails to automatically activate a workaround for this token bug, it may be necessary to manually 
set PKCS11_TOKEN_BUGS=128 in the notes.ini file.  Due to the occasional failure of this token 
to report slot events, it may also be necessary to hit F5 and log out of Notes in order to force a 
PIN prompt when using keys on a smartcard when the ID file is not secured with that same 
smartcard. 

z	 The Rainbow CryptoSwift eCommerce Server Accelerator fails to report that RSA cryptographic 
operations are performed in hardware.  If you are having difficulty performing cryptographic 
operations (including importing X.509 certificates or exporting RSA keys) with this device, setting 
PKCS11_NO_HWCHECK=1 or PKCS11_TOKEN_BUGS=2 in the NOTES.INI file will activate a 
workaround in Notes/Domino for this problem. 

z	 The Secude token cannot perform cryptographic operations with a number of smart card readers 
due to the high power demands of that token. Please confirm that your token readers are 
supported by Secude before deploying this package. If you are having difficulty signing S/MIME 
messages with a key on these smartcards and are using a supported token reader, setting 
PKCS11_TOKEN_BUGS=1 in the NOTES.INI file will activate a workaround in Notes that may fix 
this problem. and upgrading your Secude software may fix this problem. 
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Caveats and Warnings : 

z	 An entry of "n/a" in the "Use pre-loaded keys and X.509 certificates" column does not necessarily 
indicate any incompatibility with the smartcard package, but simply means that we did not have a 
sample pre-loaded token to test against. 

z	 Current versions of the Entrust CA create non-compliant PKCS#11 attributes for certificates and 
keys. Support for these keys and certs is limited; see "Problems using Entrust certificates on 
smartcards" in these release notes for more details. 

z	 Read-only tokens, such as many national identity "eID" cards and Common Access Cards, can 
only be used to lock the ID file through the "Lock ID with Key on Smartcard" action, which was 
introduced in ND7. The "Enable Smartcard Login" action that was introduced in ND6 requires 
write access to the token. 

z	 The "Lock ID with Key on Smartcard" action will search all slots for the key needed to unlock the 
Notes ID file.  Therefore, if a token is lost or locked out, a new token can be used with the old ID 
file, as long as the new token contains the exact same certificates and keys with the same key 
identifier (CKA_ID) attributes.    However, if an ID file is smartcard-enabled using the "Enable 
Smartcard Login" option, then ID File Recovery must be used if the token is lost or locked out in 
order to revert the ID to a conventional password. 

z	 The only way to revert a smartcard-protected ID file to a conventional password is through ID File 
Recovery.  ID File Recovery should be configured for an ID file before the ID file is 
smartcard-enabled. Recovering a  smartcard-protected ID file will revert the ID file to use a 
password and will restore any keys that were pushed onto the smartcard from the ID file, as long 
as the recovery information was not changed after the key was pushed down to the smartcard.  

z	 Password expiration should be disabled in a user's person record before they smartcard-enable 
their ID file. 

z	 Password checking will result in only a single smartcard being usable with a given ID file, even 
across multiple computers or platforms.  In this scenario, one copy of the ID file should be 
smartcard-enabled, and then that version of the ID file should be copied to all of the other 
respective computers.  That single smartcard will now be required for all of the copies of the ID 
file. 

z	 Server setup will not function with a smartcard-protected server ID.  In order to use a 
smartcard-protected ID with a server, finish server setup with a password-protected version of the 
ID file, then add the path to the PKCS #11 library in the server's NOTES.INI 
(PKCS11_Library=<path to library>), and finally smartcard-enable the server's ID file on a client 
or using the SECManipulateSC C-API function. 

z	 Single Logon, which synchronizes the Notes and Windows passwords, cannot be used with a 
smartcard-protected ID file. You must restart Notes after disabling Single Logon before 
smartcard-enabling an ID file. 

z	 Notes uses version 2.01 of the PKCS #11 API to communicate with smartcards and other 
PKCS#11 devices. PKCS #11 libraries that only implement version 2.0 will not result in an 
"F5"-style logout when the card is removed from the reader.  Updated libraries may be available 
from the smartcard vendors. 

Sample PKCS #11 Library Install Paths : 

z	 c:\WINNT\system32\acpkcs211.dll (ActivClient 5.4) 
z	 c:\WINNT\system32\eTpkcs11.dll (Aladdin eToken RTE 3.65) 
z	 c:\WINNT\system32\asignp11.dll (A-Trust v1.2.2.1) 
z	 c:\WINNT\system32\Belgium Identity Card PKCS11.dll (Belgian eID) 
z	 c:\WINNT\system32\dkck201.dll (Datakey CIP 4.07) 
z	 c:\WINNT\system32\opensc-pkcs11.dll (Estonian eID) 
z	 c:\WINNT\system32\sadaptor.dll (Eutron CryptoIdentity CryptoKit 3.7.1) 
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z	 c:\Program Files\Gemplus\GemSafe Libraries Admin\BIN\gclib.dll (GemSafe Libraries 4.x) 
z	 c:\Program Files\IBM ThinkVantage\Client Security Solution\csspkcs11.dll (IBM Client Security 

Software v6.01) 
z	 c:\WINNT\system32\dkck201.dll (Rainbow iKey 2032) 
z	 c:\WINNT\system32\Cryptoki22.dll (Rainbow CryptoSwift eCommerce Sever Accelerator) 
z	 c:\Program Files\Common Files\SECUDE\itsecp11.dll (Secude v5.6) 

Software requirements 

Lotus Notes, Domino Designer, Domino Server, Domino for System i, Domino for System z 

Notes 8 and Domino 8 platforms and system requirements 
The platforms and operating systems listed in the table below are applicable to the Lotus Notes 8 and 
Lotus Domino 8 release, and may not necessarily pertain to other Notes and Domino releases. 

For Domino Web Access system requirements, please refer to the release note titled "Domino Web 
Access system requirements". 

For web browsers supported, including Web Mail and the Domino Web Administrator, please refer to the 
release note titled "Web browsers supported". 

Operating system patches, service packs, and other updates are not specified in the tables that follow.  
Note that operating system vendors frequently release updates. For the most recent information 
regarding updates, see the Lotus Knowledge Base online at http://www-3.ibm.com/software/lotus/support/ 
or contact your local Lotus Support representative. 

TM
Lotus Notes compatibility with Microsof t® Windows Vista
For Notes 8, the Microsoft Windows Vista operating system was tested according to the following 
configuration: 

1.	 Turn User Account Control (UAC) off 

- Launch MSCONFIG from the Run menu. 
- Click on the 'Tools' tab.  Scroll down and click "Disable UAP" (Note: "UAP" will be changed to 
"UAC" in a later beta build). 
- Press the "Launch" button. 
- A command window will open. When the command is finished running, you can close the 
window. 
- Close MSCONFIG; reboot the computer for changes to apply. 

Note: You can re-enable UAC by selecting the "Enable UAP" line from the 'Tools' tab, and then 
clicking on the "Launch" button. 

2.	 Install as Adminstrator (using Vista default policy settings) to the default path C:\Program
Files\IBM\Lotus\Notes. 

3.	 Run as a Standard User (using Vista default policy settings).  If you do not get desktop launch 
icons for User, create them by dragging the Notes Mail shortcut from the Start menu. 
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Notes Client 

Platform Microsoft Windows Linux (Notes client only) 

Supported operating 
system versions 

Microsoft Windows XP Professional 
Microsoft Windows Vista Ultimate with 
Aero 

(see the "Windows system requirements " 
Release Note for Service Pack information ) 

Novell SUSE Linux Enterprise Desktop 
(SLED) 10 XGL 

(see the "Linux system requirements " Release 
Note for Service Pack information ) 

Processors Intel Pentium or higher and Intel Pentium or higher and 
supported compatibles compatibles 

RAM Windows XP - 512 MB minimum; 1 
GB or more recommended 

512 MB minimum; 1 GB or more 
recommended 

Windows Vista - 1 GB minimum; 1.5 
GB or more recommended 

Disk space 900 MB or more recommended 1.5 GB minimum 
1.5 GB or more recommended 

(The minimum amounts 
are the disk space 
required for installing 
default files. More disk 
space is required if 
databases are 
replicated locally or 
copied locally) 

Video Hardware support for OpenGL 128 MB video RAM (with 
XGL-compatible video driver from 
hardware OEM for SLED 10) 

Monitors supported Color monitor required Color monitor required 

Protocols 
supported 

NetBIOS over No No 
NetBEUI 

NetBIOS over IP
(1) Yes No 

NetBIOS over IPX
(2) Yes No 

SPX No No 

SPX II No No 

TCP/IP Yes, IPV4 and IPV6 Yes 

X.PC Yes No 
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Domino Administrator Client , Domino Designer 

Platform Microsoft Windows 

Supported operating system versions Microsoft Windows XP Professional; 
Microsoft Windows Vista Ultimate with Aero 

(see the "Windows system requirements " Release Note for 
Service Pack information ) 

Processors supported Intel Pentium or higher and compatibles 

RAM Windows XP - 512 MB minimum; 1 GB or more 
recommended 

Windows Vista - 1 GB minimum; 1.5 GB or more 
recommended 

Disk space 960 MB minimum 

(The minimum amounts are the disk space required 
for installing default files. More disk space is 
required if databases are replicated locally or copied 
locally) 

Monitors supported Color monitor required 

Protocols 
supported 

NetBIOS over NetBEUI No 

NetBIOS over IP
(1) Yes 

NetBIOS over IPX
(2) Yes 

SPX No 

SPX II No 

TCP/IP Yes, IPV4 and IPV6 

X.PC Yes 

Footnotes 
1 

Only Microsoft TCP/IP is supported. 
2 

Both Novell NetBIOS and Microsoft NetBIOS over IPX are supported. 
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1
Domino Server  - Table 1 

Platform Microsoft Windows 2003 

Supported operating 
system versions 

Microsoft Windows 2003 
Server Standard Edition; 
Microsoft Windows 2003 
Server Enterprise Edition; 
Microsoft Windows 2003 
Server x64 Edition 

(see the "Windows system 
requirements" Release Note for 
Service Pack information ) 

Processors supported Intel Pentium or higher and 
compatibles (32-bit  and 
64-bit chips as appropriate) 

RAM 512 MB minimum 
512 MB or more 
recommended per CPU 

Disk space 1.5 GB minimum per partition 

Disk swap space 2 times the physical RAM 
installed 

Monitors supported Color monitor required 

Protocols 
supported 

NetBIOS over No 
NETBEUI 

NetBIOS over IP
(2) Yes; No (64-bit) 

NetBIOS over IPX Yes; No (64-bit) 

SPX No 

SPX II No 

TCP/IP Yes 

TCP/IP IPV6 Yes 

X.PC Yes 
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Domino Server - Table 2 

Platform IBM AIX Linux Sun Solaris 

Supported operating 
system versions 

IBM AIX 5.3
(4)

 (64-bit 
kernel) 

Novell SUSE Linux 
Enterprise Server (SLES) 
10 x86 (32-bit); 

Sun Solaris 10
(4)

 (64-bit 
kernel) 

(see the "AIX system 
requirements" Release Note 
for Service Pack information ) 

Novell SUSE Linux 
Enterprise Server (SLES) 
10 x86_64 (64-bit); 

(see the "Solaris system 
requirements" Release Note 
for Service Pack information ) 

Red Hat Enterprise Linux 
(RHEL) 5 (32-bit); 
Red Hat Enterprise Linux 
(RHEL) 5 (64-bit) 

(see the "Linux system 
requirements" Release Note for 
Service Pack information ) 

Processors supported PowerPC Intel Pentium or higher 
and compatibles (32-bit 
and 64-bit chips as 

UltraSPARC III and 
higher 

appropriate) 

RAM 512 MB minimum; 512 MB minimum; 512 MB minimum 
512 MB or more 512 MB or more 512 MB or more 
recommended per 
CPU 

recommended per CPU recommended per CPU 

Disk space 1.5 GB minimum 1.5 GB minimum 1.5 GB minimum 
1.5 GB or more 1.5 GB or more 1.5 GB or more 
recommended recommended recommended 

Disk swap space Same amount as 
Physical memory 

2 times the physical RAM 
installed recommended 

3 times the physical 
RAM recommended 

required; recommend 2 
times the physical RAM 
installed 

Monitors supported Any standard display Any standard display Any standard display 
(local or remote) (local or remote) (local or remote) 

Protocols supported 

NetBIOS No No No 

NetBIOS over IP
(2) No No No 

NetBIOS over IPX No No No 

SPX
(3) No No No 

SPX II No No No 

TCP/IP Yes Yes Yes 

TCP/IP IPV6 Yes  Yes Yes 

X.PC Yes Yes Yes 
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Domino Server - Table 3 

Platform IBM System i 
5 IBM System z Linux on System z 

Supported 
operating system 
versions 

IBM i5/OS, V5R4 

(see the "System i: Software 
requirements" Release Note for 
additional information ) 

IBM z/OS Version 1, 
Release 7 or later; 
IBM z/OSe Version 1, 
Release 7 or later 

Novell SUSE Linux 
Enterprise Server (SLES) 10 
on System z (64-bit); 
Red Hat Enterprise Linux 
(RHEL) 5 on System z 
(64-bit) 

(see the "Linux system 
requirements" Release Note for 
service pack information ) 

Processors 
supported 

iSeries 270, 810, 820, 
825, 800-2464 and 
above, 520-0901 and 
above 

Any that supports your 
release level of System z 

Any that supports your 
release level of Linux on 
zSeries 

iSeries 270, 800-2464, 
810-2465, and eServer i5 
520-0901 recommended 
for Notes-based mail or 
light applications only 

Partial processor models 
may not be suitable for 
compute-intensive 
applications; models with 
3100 CPW or higher are 
recommended. 

Note: iSeries 800-2463 
and eServer i5 520-0900 
are not supported for 
Domino 8 

RAM 512 MB minimum; 1 GB minimum; 1 GB minimum 
512 MB or more per 2 GB or more 2 GB or more recommended 
Domino server recommended 

Disk space 2 GB minimum 3 3390-3 volumes 2.5 GB minimum 
4 or more drives minimum 2.5 GB or more 
recommended recommended 

Disk swap space N/A N/A N/A 

Monitors supported Any standard display Any standard display (local Any standard display (local 
(local or remote) or remote) or remote) 
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Platform IBM System i 
5 IBM System z Linux on System z 

Protocols 
supported 

NetBIOS No No No 

NetBIOS over IP
(2) No No No 

NetBIOS over IPX No No No 

SPX
(3) No No No 

SPX II No No No 

TCP/IP Yes Yes Yes

 TCP/IP IPV6 Yes Yes Yes 

X.PC No No No 

Footnotes 
1 

If you are running with DB2 as the Domino datastore then you must add additional DB2 install requirements. DB2 9.1 
is supported in the current release.  NSFDB2 support is not available using Domino for System i. For additional install 
requirements, please see "Setting up and using Domino and DB2" in the Domino Administrator Help. 
2 

Only Microsoft TCP/IP is supported. 
3 

Domino clusters and partitioned server configurations do not support the IPX/SPX protocol. At this time, IBM does 
not plan to provide IPX/SPX network support for future releases of these features. 
4
  The 64-bit kernel must be installed and in use on these systems, even though the OS is 32-bit.  The use of the 32-bit 

kernel is no longer supported on these platforms.  Please see the OS vendor documentation for questions on 
enabling/using the 64-bit kernel.  (On Solaris, the 64-bit kernel is used by default on supported hardware; this is not 
the case for AIX). 
5
 For more details on specific models, see "System i Performance Capabilities Reference" at 

http://publib.boulder.ibm.com/infocenter/iseries/v5r4/topic/books/sc410607.pdf. 

Domino Server 

Domino and DB2: Platforms and required hardware and software 
Supported platforms and hardware and software requirements 
IBM Lotus Domino can use Query Views, as well as some Designer features for DB2 Access Views. Any 
version of the IBM Lotus Notes C-API program that can access the DB2 enabled Domino server can also 
access IBM Lotus Notes databases stored in DB2. 

Supported platforms 

Domino 8.0, 32-bit application is supported on the following platforms: 

z MS Windows 32-bit and MS Windows 64-bit 

z IBM AIX 5.3, 64-bit 

z Linux (SLES 10) 64-bit 
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DB2 9.1, 32-bit is certified on MS Windows; DB2 9.1, 64-bit is certified on IBM AIX and Linux. DB2 9.1 
can be installed on the following platforms: 

z	 MS Windows 32-bit and MS Windows 64-bit 

z	 IBM AIX 5.3, 64-bit 

z	 Linux (SLES10) 64-bit 

Note  Shared mail is not supported for a DB2 server. The recommended method of installation is to create 
a new DB2-enabled Domino server and replicate to DB2. If an existing server is upgraded to a 
DB2-enabled Domino server, the shared mail linked mail files need be unlinked prior to the upgrade. 

Prerequisites for IBM AIX 

z	 64-bit kernel 

z POWER4 or more recent hardware 

Software requirements 

z	 IBM Lotus Domino server 8.0 

z	 IBM Lotus Domino Administrator 8.0 

z	 DB2 UDB Enterprise Server Edition version 9.1. 

Note  If your configuration includes DB2 on the Domino server and DB2 on a DB2 server, both 
servers must be running DB2 9.1. 

z	 DB2® Run-Time Client is required for remote configurations 

Caution Do not confuse the DB2 Run-Time Client with the DB2 Run Time Client Lite (RTCL). We 
do NOT support the DB2 Run Time Client Lite. 

z	 IBM DB2 Access for Lotus Domino 8.0 

z IBM Lotus Notes Client 8.0 

Memory requirements for a DB 2 enabled Domino server , Microsoft Windows or IBM AIX and Linux 

Microsoft Windows platform 

z	 Computers require a minimum 1 GB RAM,  2GHz Processor. 

z	 On a local configuration, that is, the Domino server and the DB2 server are installed and running on 
the same Microsoft Windows computer, the computer should be dedicated to Domino and have no 
more than one DB2 instance and one DB2 database for the Domino server. 

z	 On a remote configuration, that is, the Domino server and the DB2 server are installed on and are 

running on separate computers, the DB2 server must have one DB2 instance and one DB2 

database for the Domino server.


IBM AIX and Linux platform 

z	 The DB2 Server can be configured with multiple DB2 instances but can only have one DB2 instance 
and one DB2 database per Domino Server. 

z	 A minimum of 1GB memory per DB2 instance 

z	 The Input Output Completion Protocol (IOCP) must be installed on AIX systems on which the DB2 
Access server is installed. If Domino has not been installed on the computer where the DB2 Access 
server is to be installed, you must manually verify that IOCP is installed and enabled prior to 
installing the DB2 Access server. 
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Other requirements 

z	 Transaction logging must be enabled to run the DB2 Domino server. When you enable transaction 
logging on the Server document, set the log file size to at least 192 MB. 

z	 UTF-8 is supported for Domino and DB2. New databases are created as UTF-8 databases. No 

other database encoding is supported.


What's not supported in this release of Domino and DB 2? 

Domino and DB2 does not support the use of the following: 

z	 IMAP4 

z	 ODS version 41 

z	 Domino's extended ACLs are not supported with DB2 enabled Notes databases. 

z	 SCOS (shared mail) 

z	 System databases are not supported as DB2 enabled Notes databases (NAMES.NSF, 
LOG.NSF, etc.) 

For more information about which databases are not supported as DB2 enabled Notes databases, see 
the topic "Databases created with Domino". 

Memory and hardware requirements 

z	 2 GHz processor 

z	 1 GB RAM 

Lotus Notes, Domino Server 

Notes features that require a Domino  8 server 
Although several Notes 8 Beta features can be run against an earlier Domino server, the following Notes 
features require a Domino 8 Beta server: 

z	 Unprocessed calendar entries (also known as "calendar ghosting") requires a Domino 8 router. 

z	 The display of mail threads at the view level works for local replicas, but requires a Domino 8 
server for server-based replicas. 

z	 Message Recall - This feature requires a Domino 8 server as the recipient's mail server, but the 
person recalling messages does not require a Domino 8 mail server. 

z	 New Out of Office behavior - This includes immediate responses, partial days, and so on. 
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Lotus Notes 

Lotus Sametime servers and available features 
You must have a Sametime server to use the Sametime features in IBM Lotus Notes 8. 

If you have a version 7.5.1 Sametime server, you must turn on the policy, "Allow all Sametime Connect 
features to be used with integrated clients" to make all Sametime features available. The default for this 
policy is "Off". 

If this policy is off, only the text chat, rich text editor, emoticon, and availability (online) status features 
are available. The following features are NOT available: 

- file transfer
- screen capture
- voice chat
- video chat 
- telephony 
- multiple community
- Sametime Gateway
- Instant Meeting
- Alert me when
- Privacy - When I am online & Selective DND 
- Location awareness

If this policy is turned on, all Sametime features are available. 

Domino for System i 

System i: Software requirements 
Operating System Software 

The following System i software is required for the Lotus Domino 8 Beta release: 
TM

z	 IBM i5/OS  V5R4 

MANDATORY PTF 5722SS1 SI24683 OSP-THREADS-PERFM FASTER THREAD LOCAL 
STORAGE ACCESS METHOD must be applied. Without the PTF applied the product will install, 
but virtually all Domino-related functions (WRKDOMSVR, CFGDOMSVR, UPDDOMSVR, and 
anything that performs a NotesInit API call) will fail with messages that may refer to a missing 
export from service program QLEAWI.   

z	 i5/OS - Host servers, 5722SS1 (option 12) 

z	 TCP/IP Connectivity Utilities for i5/OS, 5722TC1 

z	 IBM Developer Kit for Java, 5722JV1 (*BASE option) 

z	 J2SE 5.0 32 bit, 5722JV1 (option 8, the default JDK used by Domino 8)   

z	 Java Developer Kit 5.0, 5722JV1 (option 7) may also be used if a Notes.ini variable is 
specified to override the default.     

Note 1: Domino 8 defaults to use J2SE 5.0 32 bit (option 8).  This is an upgrade from the version 
used in prior Domino releases. 

Note 2:  While the 5722JV1 option 8 JDK is recommended and the default for Domino 8,  you can 
choose to use 5722JV1 option 7 by specifying JavaUseClassicJVM=1 in the server's Notes.INI 
file.  
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Note 3:  If Option 8 is not installed and JavaUseClassicJVM=1 is not specified in the Notes.ini file, 
then a JVM load failure will occur when the HTTP task starts.    

z	 i5/OS - Qshell, 5722SS1 (option 30) 

If you plan to use Web services, you must also install the following software:  

z	 5722DG1 IBM HTTP Server for i5/OS  

If you plan to manage your Domino environment using iSeries Navigator, the graphical user interface for 
managing an i5 server, you must install the following additional software: 

z	 IBM iSeries Access Base, 5722XW1 
z	 IBM iSeries Access for Windows, 5722XE1 
z	 Latest iSeries Navigator service pack available (


http://www.ibm.com/servers/eserver/iseries/access/casp.html)


Refer to the release note Domino administration using iSeries Navigator tasks on the Web  for additional 
software requirements and informaion on managing Domino servers from the Web. 

Make sure you have the latest PTF levels applied on your system.  Refer to the Preventive Service 
Planning (PSP) Web site for the latest cumulative, group and individual PTFs available for the release: 

http://www-912.ibm.com/s_dir/sline003.nsf/sline003home 

Domino software 

z	 Lotus Domino 8 Beta for System i (5733LD8) and options: 

z	 5733LD8 *BASE - This is the base option of Domino 8 Beta; this option is required. 

z	 5733LD8 option 1 - This contains the C API and related files.  Installation of the C API is 
optional.  If you want to run any application that uses the C API interfaces, you must install this 
software. 

Note:  The C API option is not multi-version capable. 

z 5733LD8 option 10 - This is the server option for Domino 8 Beta;  this option is required. 

After installing the *BASE option and options 1 and 10, the following will be displayed on the 
DSPSFWRSC panel: 

Resource 
ID Option Feature Description 

5733LD8  
5733LD8  
5733LD8  

*BASE 
*BASE 
1 

5050 
2924 
5050 

Lotus Domino 8 (5724E62)     
Lotus Domino 8 (5724E62)     
Lotus Domino 8: C API 

5733LD8 10 5050 Lotus Domino 8: Release 8.0.0     
5733LD8 10 2924 Lotus Domino 8: Release 8.0.0 

The Resource ID "5733LD8" is the i5/OS installed licensed program (LICPGM) value and the text 
"(5724E62)" that follows the Description is the IBM Lotus Passport Advantage product ID.  While both 
values may be used to refer to the Lotus Domino 8 product, the 5733LD8 LICPGM value is specific to 
System i and i5/OS.    

Limitations 
Refer to the release note Features not available with Domino  8 for System i for details regarding features 
that are not available with Domino 8 Beta on System i. 
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C and C++ Application Requirements 

ATTENTION: 

Any applications that use the Domino C or C++ API on i5/OS need to be reviewed to make sure they are 
properly enabled for use with Domino on i5/OS.  

There are two important considerations: 

1.	 Bind to QNOTES/LIBNOTES 
Some applications incorrectly specify a library of *LIBL when binding to the LIBNOTES service 
program.  This can result in incorrect operation in a multi-versioned Domino environment.  
Applications must specify library QNOTES when binding to the LIBNOTES service program in order 
to function correctly in a multi-versioned environment.  

2.	 Enable for Teraspace 
When 64-bit support for Domino becomes available, Domino for i5/OS will also change to use the 
i5/OS 64-bit pointer and teraspace support.   To ensure proper operation, applications using the 
Domino C or C++ API must be teraspace-enabled.  This can be accomplished by recompiling the 
application with the teraspace compiler option specified.  This is expected to provide significant 
improvement in Domino i5/OS performance when 64-bit support is introduced.   

For more details, see the following documents: 

Considerations when developing Domino C and C ++ API applications for i 5/OS: 

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21238494

 Domino 7 for i5/OS Application Development Guide  (Chapter 2 - Application Development 
Considerations) 

http://www.lotus.com/ldd/doc/uafiles.nsf/docs/i5osdom7/$File/apdev400.pdf 

For information on Domino 64-bit plans, see this document: 

http://www-1.ibm.com/support/docview.wss?rs=463&context=SSKTMJ&dc=DB520&uid=swg212 
33872&loc=en_US&cs=UTF-8&lang=en&rss=ct463lotus 

Domino for System i 

System i: IBM HTTP Server plug-in for Domino 
This section lists the software and PTFs required to use the IBM HTTP Server plug-in with Domino 8 and 
i5/OS V5R4. 

Required software 
The following are the software requirements for the IBM HTTP Server plug-in for Domino: 

z IBM i5/OS V5R4, 5722SS1, with latest PTFs applied 
z IBM HTTP Server, 5722DG1 

Group PTF 
The following group PTF is required. 

z SI199114 - IBM HTTP SERVER FOR I5/OS 
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Individual PTFs 
The individual PTFs correspond to the version of Apache. 

The following IBM HTTP Server individual PTF is required.  If you order the HTTP Server Group PTF, you 
will obtain the most recent version of Apache and plug-in PTFs that match that version.   PTF SI19429 is 
included in the group PTF SF99114. 

z SI19429 - Domino plug-in for HTTP server (powered by Apache) 

To check the HTTP Server PTF level, enter the following on an i5/OS command line: 

DSPPTF 5722DG1 

Note There may be additional updates to these PTF requirements. For the latest information, see the Web 
page: 

http://www-03.ibm.com/servers/eserver/iseries/domino/apachedom/apachev5r4.html 

For more information about using the HTTP Server (powered by Apache) to forward HTTP traffic to 
Domino servers, refer to Chapter 16 Using IBM HTTP Server with Domino in the "Domino 7 for i5/OS Help 
(Installing and Managing Guide)" at: 

http://www.lotus.com/ldd/doc/AS400/7.0/i400help.nsf 

Domino for System i 

System i and IBM Tivoli License Compliance Manager  2.2 
The IBM Tivoli License Compliance Manager, version 2.2 fixpack 2.2.0-TIV-TLCM-FP0001 and PTF 
22F0001 provides license management support for i5/OS V5R4.   Complete details can be found at the 
following Web site: 

http://www-1.ibm.com/support/docview.wss?uid=swg24012719 

Domino Server, Domino for System z 

Linux for System z: 64-bit DB2 requirements 
If using LS:DO, LC LSX, or DECS with Domino on Red Hat Enterprise Linux (RHEL) 5 on System z 
(64-bit), the following two packages need to be installed: 

z compat-libstdc++-33-3.2.3-61.s390x.rpm 

z libXp-1.0.0-8.s390x.rpm 

Domino for System z 

Linux for System z: GNU debugger needed 
Whn using RedHat Enterprise Linux (RHEL) 5 on System z (64-bit), in order to collect stack information, 
the GNU debugger (gdb) needs to be installed. It should be installed under the directory /usr/bin.  Ensure 
the Domino server ID has permission to execute /usr/bin/gdb. 

The GNU debugger can be found at the following Web pages:  http://sources.redhat.com/gdb/download/ 
and http://ftp.gnu.org/gnu/gdb/ 
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Domino Server, Domino Web Access 

Domino Web Access system requirements 
Client Hardware Requirements 

z	 Recommended for better performance : 
z	 Windows -- Pentium IV  1 GHz with 512 MB of memory 
z	 Linux -- Pentium IV  1 GHz with 512 MB of memory 
z	 Macintosh -- G4 1.25 GHz with 512 MB of memory 

z	 Minimum requirements : 
z	 Windows -- Pentium III 400 MHz with 128 MB of memory 
z	 Linux -- Pentium III 500 MHz with 192 MB of memory 
z	 Macintosh -- G4 1 GHz 256 MB of memory 

Client Operating Systems and Supported Browsers 
Domino Web Access runs on the following client operating systems: 

Windows XP and Vista using the following browsers: 
z	 Internet Explorer 6 and 7 
z	 Mozilla Firefox 2.0 or later 

Novell Linux Desktop (NLD) 10 using  the following browsers: 
z	 Mozilla Firefox  2.0 or later 

Linux RedHat RHEL 5.0 using the following browsers: 
z	 Mozilla Firefox  2.0 or later 

Macintosh OS 10.4.x, using the following browsers: 
z	 Mozilla Firefox  2.0 or later -- Note: Does not support Domino Off-Line Services (DOLS), local 

archiving, and Lotus Sametime awareness 

Browser Support Notes 

z	 Mozilla Firefox is supported by the DWA7 and DWA8 mail templates only, it is not supported by 
iNotes6 templates. 

z	 Attempting to access Domino Web Access through unsupported browsers results in the display 
of an unsupported browser notice. Netscape 4.x users may see hangs and/or crashes when 
encountering the Domino Web Access unsupported browser page. If you are a Netscape 4.x 
user and you encounter these problems, you should open your mail file using the WebMail UI 
directly through the &ui=webmail switch. This is documented in the topic "Switching to WebMail" 
in the Domino Web Access help. 

z	 Domino Web Access will not work if JavaScript is disabled or if session cookies are disabled. 

Server Requirements 
See "Notes 8 and Domino 8 Beta platforms and system requirements" in these Release Notes for a 
complete list of server operating systems and requirements. 

Certified Proxy Servers 
z	 SunOne Portal Server 6.2 
z	 IBM WebSphere Edge Server 2.0.2 efix 49 
z	 Tivoli Access Manager 5.1 

Adobe Acrobat 
Adobe Acrobat Reader, Version 4.0 or higher to print calendars. 
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Domino Access for Outlook 

Domino Access for Microsoft Outlook requirements

IBM Lotus Domino Access for Microsoft Outlook allows Microsoft Outlook 2002 (XP) or 2003 users  to 

connect to an IBM Lotus Domino Server running Domino 8 Beta.


System and Outlook requirements 
z Windows OS -- Windows XP Professional Service pack 2, Windows 2000 
z Microsoft Outlook XP with SP3, or Outlook 2003 with SP2 
z Domino Server running 6.5.1 or higher 
z	 Mail databases created using a Mail8.NTF, Mail8ex.NTF or DWA8.NTF template

Note The following mail templates are also supported: Mail6.ntf and Mail7.ntf; Mail6ex.ntf and 

Mail7ex.ntf; iNotes6.ntf and DWA7.ntf.


Client System Memory 
z 128 MB RAM required; 256 MB or more recommended 

Client Disk Space 
z Windows OS: 275 MB disk space 

Lotus Notes, Domino Designer, Domino Server, Domino for System i, Domino for System z 

DECS - supported data drivers list

Supported IBM Lotus Connector data driver versions for DECS (and LEI) are listed below. 


DECS/LEI with 32-bit Domino server

DECS and LEI are supported with 32-bit versions of Domino on the following platforms:


z Windows 2003 32-bit 
z Windows 2003 64-bit 
z AIX 5.3 64 bit 
z Solaris 10 
z RedHat Linux Enterprise Server 5.0 32-bit 
z RedHat Linux Enterprise Server 5.0 64-bit 
z SUSE Linux Enterprise Server 10 (SLES10) 32-bit 
z SUSE Linux Enterprise Server 10 (SLES10) 64-bit 

DECS/LEI with 64-bit Domino server 
DECS and LEI may be supported with 64-bit versions of Domino on the following platforms. Note that the 
64-bit platform support is new and not available for Notes/Domino 8 Beta. 

z Windows 2003 64-bit 
z AIX 5.3 64-bit 

DECS only 

z z/OS 1.7 
z Linux for System z - RedHat Enterprise Server 5.0 64-bit 
z Linux for System z - SUSE zLinux Enterprise Server 10 (SLES10) 64-bit 

i5/OS V5R4 is supported.  Supported Lotus Connector data driver versions relative to the above bit

specifications, are listed below.


Note: DataDirect ODBC drivers can be used with the Lotus Connector for ODBC.  These include the Data 
Direct Sybase, Oracle, Informix, DB2, and SQL Server ODBC wire protocols. LEI and DECS support the 
supplied Lotus-branded DataDirect ODBC driver. LEI and DECS recommend using the Lotus-branded 
DataDirect ODBC Wire Protocol drivers. 
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Windows 2003 Server and Server Enterprise Edition 
z	 Oracle 9i and 10g 
z	 DB2 v8.2.2, 9.1 and DB2 Universal Database for iSeries (System i) 
z	 Sybase 15 
z	 MS SQL Server 2000 and 2005 
z	 Data Direct ODBC 5.2 

AIX 5.3 
z	 Oracle 9i and 10g 
z	 DB2 v8.2.2, 9.1 (must be aix power 4 or higher for DB2 9.1) and DB2 Universal Database for iSeries 

(System i) 
z	 Sybase  15 
z	 Data Direct ODBC 5.2 

Solaris 10 
z	 Oracle 9i and 10g 
z	 DB2 v8.2.2, 9.1and DB2 Universal Database for iSeries (System i) 
z	 Sybase  15 
z	 Data Direct ODBC 5.2 

Redhat Linux Enterprise Server  5.0 
z	 Oracle 9i and 10g 
z	 DB2 v8.2.2, 9.1 and DB2 Universal Database for iSeries (System i) 
z	 Data Direct ODBC 5.2 

Novell SuSE Linux Enterprise Server  (SLES) 10 
z	 Oracle 9i and 10g 
z	 DB2 v8.2.2, 9.1 and DB2 Universal Database for iSeries (System i) 
z	 Data Direct ODBC 5.2 

System i, i5/OS V5R4

Data Direct ODBC 5.2 (32-bit version)

DB2 Universal Database for iSeries (System i)


z/OS 1.7

DB2 8 and DB2 9.1


Linux for System z - Novell SUSE Linux Enterprise Server  (SLES) 10 64-bit

DB2 8, DB2 9.1 and DB2 Universal Database for iSeries (System i)


Linux for System z - RedHat Enterprise Server  5.0 64-bit

DB2 8, DB2 9.1 and DB2 Universal Database for iSeries (System i)


Domino Server 

AIX system requirements 
The following AIX patch levels are required for Domino 8 Beta: 

AIX 5.3 

ML05 or higher

xlC.rte 8.0.0.5 or higher
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Lotus Notes, Domino Server 

Linux system requirements 
Notes client 
Before installing Notes 8 Beta on a Linux client, you must install a Mozilla GTK2 Web browser.  The client 
requires a Mozilla 1.8 -based application (Firefox/XULRunner/Seamonkey) and will not support the earlier 
Beta requirement of Mozilla 1.7.12. 

For Notes 8 Beta, it is recommended that the latest updates for SLED 10 are installed.  At a minimum, the 
latest versions of the following subsystems are required: 

metacity

compiz

xgl


Domino server 
If you are unsure of the versions available, please check with the Domino 8 Beta forum for updated 
information. 

Domino Server 

Solaris system requirements 
The following Solaris patch level is required for Domino 8 Beta: 

Solaris 10 

March 2006 patch cluster or higher 

Lotus Notes, Domino Designer, Domino Server 

Windows system requirements

Lotus Notes 8 Beta and Lotus Domino 8 Beta are initially supported on Windows platforms with the

application of the Service Packs listed below.  Although individual operating system patches and Service

Packs are not certified, IBM/Lotus realizes that there are later service packs that may become publicly

available after testing, and acknowledges that these more recent updates may fix additional problems. 

You may wish to apply these newer service packs as they become available.


You can obtain and install the following patches from Microsoft Corporation or download them from

Microsoft's Web site:

http://www.microsoft.com/downloads


Notes Client, Domino Designer, and Domino Administrator Clients :


z Windows XP Professional: Service Pack 2 

Domino Server 

z Windows 2003 Server Standard Edition; Windows 2003 Server Enterprise Edition: Service Pack 1 
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Lotus Notes, Domino Server 

Web browsers supported 
The following are the Web browsers supported, by application: 

Application Browsers supported

Notes Client
1 

z 

z 

z 

z 

Microsoft Internet Explorer 6.x, 7.x (Windows platforms only) 

Mozilla 1.5.x, 2.0 on Windows XP Professional 

Mozilla 1.5.x, 2.0 on RHEL 5 Desktop 

Mozilla 1.8 on SLED 10 XGL
2 

Web Mail and 
Web-enabled templates 

z 

z 

Microsoft Internet Explorer 6.x, 7.x (Windows platforms only) 

Mozilla 1.5.x, 2.0 (All supported platforms) 

Domino Web 
Administrator 

z 

z 

Microsoft Internet Explorer 6.x, 7.x (Windows platforms only) 

Mozilla 1.4.x , 1.5.x, 2.0 (All supported platforms) 

Domino Web Access z 

z 

Microsoft Internet Explorer 6.x, 7.x (Windows platforms only) 

Mozilla 1.5.x, 2.0 (All supported platforms) 

1 
Not applicable to Domino Designer. 

2 
See "Linux system requirements" in these release notes for more information. 

Lotus Notes, Domino Server, Domino for System i, Domino for System z 

Autonomy KeyView filter formats supported

The Domino 8 server and Notes 8 client have been upgraded with version 9.2.4 of Autonomy KeyView

filters and viewers, which support bidirectional reading order. Autonomy, Inc. is a leading provider of

viewing, search and retrieval applications for the enterprise and the Internet. Autonomy's KeyView 

technology enables Domino to access, index, and view document attachments of many file types and

forms such as image and word-processing formats. 


The Autonomy KeyView filtering and viewing package enables developers to extract text from a wide

variety of word processing, spreadsheet, and presentation formats through a set of APIs. The APIs 

additionally support summary information extraction and automatic detection of document types. The 

Autonomy Filter SDK API supports both file-based and stream-based input and output operations. The 

Autonomy Viewing SDK allows developers to incorporate universal viewing into proprietary document

management, groupware, email, fax server and information portal applications. 


Domino 6 will stay with the Autonomy (formerly Verity) 7.0a KeyView release now and throughout the

maintenance cycle. Domino 7.0 will stay with Autonomy (formerly Verity) KeyView 7.4.0.2. 


This is a binary upgrade of the Autonomy KeyView Filters.  Features gained by this upgrade include: 

z	 The ability to filter container files which consist of a main file and sub-files embedded in the main file.  
Compressed files, such as zipped files and e-mail message files, with attachments such as Outlook 
Express, are examples of container files.  The following formats are supported using the container 
functions: Microsoft Outlook Express (.eml), Microsoft Outlook (.msg), Microsoft Outlook Personal 
Folder (.pst), and zipped (.zip) files.  Note: .zip files are not supported by Notes and Domino. 

z	 The ability to filter Microsoft Outlook Personal Folders (.pst) and to extract Outlook items (messages, 
appointments, contacts, tasks, notes, and journal entries) from a .pst file to either a single output file 
or to the original Outlook folder structure. 
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z	 The filtering of PDF files by using either the file’s internal unstructured paragraph flow, or by applying 
a structure to the paragraphs to reproduce the logical reading order of the visual page.  Logical 
reading order enables the filtered output of PDF files containing languages that read from right-to-left, 
in the correct reading direction.  A default unstructured text stream for PDF files is available to 
facilitate filtering of PDF paragraphs extracted in the order in which they are stored in the file, not the 
order in which they appear on the visual page.  This form of output does not represent a logical 
reading order, but accurately reflects the internal structure of the PDF file.  A configurable option 
produces a structured text stream that flows in a specified direction. This means PDF paragraphs are 
extracted in the order (logical reading order) and direction (left-to-right or right-to-left) in which they 
appear on the page. 

The following file formats are supported by Notes/Domino 8 for filtering as indicated in the table below: 

Word Processing Formats: 

Attachment Type Version Test results 
ANSI (TXT) Filtered 
ASCII (TXT) Filtered 
HTML (HTM) Filtered.  By default, Notes uses 

an internal HTML filter 
IBM DCA/RFT  (Revisable Form Text ) SC23-0758-1 Untested 
DC 
Rich Text Format / Wordpad (RTF) 1 through 1.6 Untested 
Unicode (TXT) 3,4, .UNI and .TXT Untested 
Adobe Maker Interchange Format 5, 5.5, 6, 7 Untested 
(MIF) 
Applix Words (AW) 3.11, 4, 4.1, 4.2, 4.3, 4.4 Untested 
Display Write (IP) 4 Untested 
Folio Flat File (FFF) 3.1 Untested 
Fujitsu Oasys (OA2) 7 Untested 
JustSystems Ichitaro (JTD) 8, 9, 10, 12 Filtered 8, 9, 10, 11, 12 
Lotus AMI Pro (SAM) 2, 3 Filtered 
Lotus Word Pro 96, 97, Millennium Edition R9 Untested 

(Windows Only) 
Microsoft Word for PC (DOC) 4, 5, 5.5, 6 Filtered 5, 5.5, 6. Other versions 

untested 
Microsoft Word for Windows (DOC) 1 through 2002 Filtered 6. Other versions 

untested 
Microsoft Word for Macintosh (DOC) 4, 5, 6, 98 Filtered 4, 5. Other versions 

untested 
Microsoft Works  (WPS) 1 through 2000 Filtered 3, 4, 6. Other versions 

untested 
Microsoft Windows Write (WRI) 1, 2, 3 Untested 
WordPerfect for Windows V5 (WO) 5, 5.1 Filtered 5.1. Other versions 

untested 
Word Perfect for Windows V6 or 6, 7, 8, 10, 2000 Filterd 6, 7. Other versions 
Higher (WPD) untested 
Word Perfect for Macintosh 1.02, 2, 2.1, 2.2, 3, 3.1 Filtered V35, V30, V21. Other 

versions untested 
Word Perfect for Linux 6 Untested 
XyWrite (XY4) 4.12 Untested 
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Spreadsheet Formats: 

Attachment Type Version Test results 
Applix Spreadsheets 4.2, 4.3, 4.4 Untested 
Comma Separated Values (CSV) No specific version Untested 
Corel Quattro Pro (QPW, WB3) 5, 6, 7, 8 Untested 
Lotus 123 for Smartsuite  (123) 96, 97, Millennium Edition R9 Filtered 
Lotus 1-2-3 (WK4) 2, 3 , 4 , 5 Filtered 3, 4. Other versions 

untested 
Lotus 1-2-3 Charts (123) 2, 3 , 4 , 5 Untested 
Microsoft Excel for Windows (XLS) 2.2 , 3 , 4 , 5 , 96, 97, 2000, Filtered 2.2 , 5, 95, 97, 2000. 

2002 Other versions untested 
Microsoft Excel for Macintosh (XLS) 98 Untested 
Microsoft Excel Charts (XLS) 2, 3 ,4, 5 , 6, 7 Untested 
Microsoft Works Spread Sheet (S30, 1, 2 , 3 , 4 Untested 
S40) 

Presentation Formats: 

Attachment type Version Test results 
Applix Presents (AG) 4.0, 4.2, 4.3, 4.4 Untested 
Corel Presentations (SHW) 7, 9, 10, 11, 2000 Untested 
Lotus Freelance Graphics for 2, 96, 97, 98, Millenium Edition Filtered 2, 96. Other versions 
Windows (PRE) R9 untested 
Lotus Freelance Graphics 2 (PRE) 2 Filtered 
Microsoft Power Point for Windows 95, 97, 2000, 2002 Filtered 97, 2000. Other versions 
(PPT) untested 
Microsoft Power Point for PC (PPT) 4 Filtered 
Microsoft Power Point for Macintosh 98 Untested 
(PPT) 
Microsoft Project (MPP)  (Extracts 98, 2000, 2002 Untested 
metadata only) 

Display Formats: 

Attachment type Version Test results 
Adobe Portable Document Format 1.1 (Acrobat 2.0) to 1.4 (Acrobat Filtered 
(PDF) 5.0) 

Graphics Formats (Filter SDK): 

Attachment type Version Test results 
AutoCAD Drawing Format (DWG) 
(Standalone: Does not extract 
metadata) 

R13, R14 and R2000 Untested 

AutoCAD Drawing Format (DXF) 
(Standalone: Does not extract 
metadata) 

R13, R14 and R2000 Not filtered. Autonomy error 
returned 

Computer Graphics Metafile (CGM) 
(Embedded) 

No specific version Not filtered. Autonomy error 
returned 

Enhanced Metafile (EMF) (Embedded 
and Standalone) 

No specific version Filtered 

Lotus Pic (Pic) (Standalone) No specific version Filtered 
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Graphics Formats (Filter SDK) (cont'd): 
Attachment type Version Test results 

Microsoft Visio (Extracts metadata 
only) 

6 Not filtered. Autonomy error 
returned 

Tagged Image File (TIFF) 
(Standalone: Extracts metadata only) 

5 Not filtered. Autonomy error 
returned 

Windows Meta File (WMF) 
(Embedded and Standalone) 

3 Filtered 

Multimedia Formats: 

Attachment type Version Test results 
MPEG - 1 Audio Layer 3 (MP3) ID3 Versions 1 and 2 Hard coded in V70 to ignore .mp3 
(Extracts Meta Data : Summary 
Information Only) 

Container Formats: 

Attachment type Version Test results 
DynaZIP No specific version Not supported 
PKZIP PKWARE versions through Not supported 

2.04g 
WinZIP No specific version Not supported 
Microsoft Outlook (MSG) 97, 2000, 2002 Filtered 
Microsoft Outlook Express (EML) (Not No specific version Not filtered. Autonomy error 
supported in Export SDK) returned 
MIME (EML) No specific version Not filtered. Autonomy error 

returned 

Binary Formats:


Nothing Supported in the Filter SDK.


43 



IBM Lotus Notes, Domino, Domino Designer 8	 Release Notes 

Installation notes 

Lotus Notes, Domino Designer, Domino Server 

READ ME FIRST -- Products to install and order of installation 
Before you begin installing this Beta release, you should read and comply with all Lotus Notes 8 Beta 
requirements listed in these release notes. The following information lists the servers and products you 
need to install to use IBM(R) Lotus(R) Notes(R). 

Note: For related Lotus Notes 8 setup information see the"Notes 8 Beta pre-installation checklist" and " 
Notes 8 Beta installation documentation roadmap" and the Lotus Notes client installation release notes. 

Servers to install 

1.	 IBM Lotus Domino server. 

2.	 (Optional) IBM DB2 running with a Domino 8 server. Required if you want to create and use DB2 
enabled Lotus Notes databases. 

3.	 (Optional) IBM Lotus Sametime server. Required if you want awareness and chat in the Lotus Notes 
client.  

4.	 (Optional) Activities server. Required if you want to use Activities from within the Lotus Notes client. 
For information, see the Lotus Connections documentation. 

5.	 (Optional) IBM WebSphere Portal server. Required if you want to use composite applications that 
contain portlets. 

(Optional configuration) To use the Portal administrative user interface on the Portal server to 
administer both Domino and WebSphere Portal, configure Domino and Portal server federated 
administration. For information, see the topics "Running the Domino-Portal integration wizard" and 
"Configuring Domino and Portal Server federated administration". 

6.	 (Optional) WebSphere Portal composite application support for Lotus Notes (install on the WebSphere 
Portal server). Required if you want to work with composite applications that contain portlets or edit 
portlets using the Composite Application Editor. 

Clients to install 

1.	 Lotus Notes 8. This provides Mail, Calendar, Contacts, and options including IBM Lotus Productivity 
Tools, Composite Application Editor, and Activities. 

Note: For Windows users, if Lotus Notes version 6.5.x or 7.x is detected on the client, the installation 
program will upgrade it to Lotus Notes 8 Beta. 

Note: For Linux users, upgrade from Lotus Notes version 7.x is not supported. Linux users should 
uninstall their existing Lotus Notes version and then install Lotus Notes 8 Beta. 

For Windows multi-user installation, the Lotus Notes client-only is available in the Notes.msi.w32 
installation media kit. 

For Windows single user installation, the Lotus Notes, Domino Administrator and Domino Designer 
clients are available in the AllClient.msi.w32 installation media kit. 

For Linux, the Lotus Notes client-only is available in the Notes.ismp.linux installation media kit. 

2.	 (Optional) Domino Administrator and Domino Designer. 

For Windows single user installation, the Domino Administrator client and Domino Designer client are 
available, along with the Lotus Notes client, in the AllClient.msi.w32 installation media kit. 
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Lotus Notes, Domino Designer, Domino Server 

Notes 8 Beta pre-installation checklist 
This IBM Lotus Notes release includes both new and familiar functionality for mail, calendar, and contacts, 
with a new user interface capable of operating within a combination IBM Lotus Domino server and IBM 
WebSphere Portal server deployment. It also includes features such as the Composite Applications 
Editor, IBM Lotus Productivity Tools, and Activities. 

This checklist lists the main steps you need to complete, or at least consider, before installing or 
upgrading to this Lotus Notes release. 

1. Check the recommended software and hardware specifications for the systems on which you or your
users will be installing. See the hardware and software requirements section of the release notes for 
details. 

2. Read "Products to install and order of installation" in the release notes or Domino 8 Administrator help. 

3. Read "Considerations before installing Notes on Windows" or "Considerations before installing Notes 
on Linux" in the release notes or Domino 8 Administrator help. 

4. Determine how you want to install. For example, will users install the client themselves using an 
installation kit or a Smart Upgrade procedure, will you install a multi-user or single user environment, 
and if installing on Windows, will you use the Notes-only installer or the Allclient (Lotus Notes, Domino 
Administrator and Domino Designer clients) installer. 

5. Familiarize yourself with installation and upgrade basics as presented in the "Notes client installation 
and Smart Upgrade" section of Domino 8 Administrator help. 

6. Install or upgrade your Lotus Domino server.

7. (Optional) If you are installing DB2, see the release notes "Domino and DB2 supported platforms and 
hardware and software requirements," "Installing Domino and DB2 on Microsoft Windows platforms" 
and "Installing Domino and DB2 on IBM AIX and Linux platforms." 

8. Set Domino administrator policy and settings for your users. 

9. (Optional) Install or upgrade your Activities server if you will be enabling users to create, edit, or view 
activity documents from Lotus Notes. For Activities server setup, see the Lotus Connections 
documentation. 

10. (Optional) Install or upgrade your IBM WebSphere Portal server if you will be enabling users to create, 
edit, or view composite applications that contain portlets. See the WebSphere Portal information 
center http://publib.boulder.ibm.com/infocenter/wpdoc/v6r0/index.jsp. 

11. (Optional) Create a Home Portal account for your Lotus Notes users that specifies information such as 
their default WebSphere Portal server name, port, and authentication information. 

For information, see "Specifying the home portal account using policy" and "Specifying the home 
portal account using preferences" in the release notes or Domino 8 Administrator help. 

12. (Optional) Install the Lotus Notes server client installer on the WebSphere Portal server if you will be 
enabling users to create, edit, or view composite applications that contain portlets. 

For information, see"Installing the Notes server client installer" in the release notes or Domino 8 

Administrator help.


13. (Optional) Use policy settings, NOTES.INI file settings, and the Lotus Notes tuner to specify available 
user settings. 

For information, see "Customizing client installations using the tuner " in the Domino 8 Administrator 
help. 
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14. (Optional) Modify the Lotus Notes install media kit's install manifest, update site, and site.xml to 
specify which Lotus Notes features users can install and optionally how and if the features will appear 
on the Lotus Notes feature installation panel. 

For information, see "Customizing Notes  installation using the install manifest"  in the Domino 8 
Administrator help. 

15. (Optional) If you have custom or third-party Eclipse components to install with Lotus Notes, modify the 
Lotus Notes install media kit's install manifest, update site , and site.xml to add these features to the 
install kit. 

For information, see "Customizing Notes installation using the install manifest"  in the Domino 8 
Administrator help. 

16. Determine how you will make HTTP (Eclipse, non-Domino) and NRPC (Domino server-based) 

component and application updates available to Lotus Notes client systems. 


For information, see "Configuring component update for composite applications" in the release notes 
and Domino 8 Administrator help. 

17. Place the Lotus Notes 8 installation media kit in an accessible location. 

18. Uninstall all existing instances of Notes 8 Beta from the systems on which you will install this Lotus

Notes 8 Beta release.


For information, see  "Uninstalling Notes 8 Beta on Windows" or "Uninstalling Notes 8 Beta on Linux" 
in the release notes or "Uninstalling Notes" in the Domino 8 Administrator help. 

19. If installing on Windows, shut down all applications before installing or upgrading to this release of

Lotus Notes. 


20. Install Lotus Notes on the user client systems or communicate to users how they are to install (or 

upgrade) Lotus Notes. 


For information, see "Installing Lotus Notes 8 Beta on Windows - single user", "Installing Lotus Notes 8 
Beta on Windows - multi-user", or "Installing Lotus Notes 8 Beta on Linux" in the release notes or see 
"Installing Notes in a single user environment", "Installing Notes in a multi-user environment" and 
"Automating client installation" in the Domino 8 Administrator help. 

The Lotus Notes 8 installation media kits are as below: 

z	 For Windows, the Lotus Notes client-only is available in the Notes.msi.w32 installation media kit. 

z	 For Linux, the Lotus Notes client-only is available in the Notes.ismp.linux installation media kit. 

z	 For Windows, the Domino Administrator client and Domino Designer client are available, along 
with the Lotus Notes client, in the AllClient.msi.w32 installation media kit. 

Lotus Notes, Domino Server 

Notes 8 Beta installation documentation roadmap

You can find information and instructions for IBM Lotus Notes 8 Beta administration, installation, and 

configuration using the following pointers.


z	 For suggested hardware and software requirements, see the self-titled sections of these release 
notes. 

z	 For IBM Lotus Domino server installation and setup, see the Domino Administrator help at 
http://www.lotus.com/doc. 

Note Domino and DB2 installation and setup information is in the Domino Administrator help. The 
Domino Administrator documentation contains extensive information regarding setting up and using 
Domino and DB2. Information about the DB2 server is located in the DB2 Information Center at 
http://publib.boulder.ibm.com/infocenter/db2help/index.jsp. 
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z	 For IBM Lotus Domino Designer and LotusScript requirements, especially relative to composite 
applications, see the Lotus Domino Designer 8 Beta Help. In addition, see the following information 
on developing application components on supported platforms: 

z	 Lotus Notes component and application development  -- See the "Application Design" section of 
the Domino Designer help. 

z	 Eclipse component and application development -- See the Eclipse Integrated Developer 
Environment (IDE) help system as well as documentation supplied with IBM WebSphere Portal and 
the Lotus Expeditor Toolkit. 

z	 Composite applications developed and used with WebSphere Portal -- See the "Composite 

applications" section of  the documentation supplied with IBM WebSphere Portal.


z	 Composite applications developed with IBM Lotus Component Designer -- See the "Composite 
applications" section in the Lotus Component Designer User Guide, available in the product help. 

z	 Composite Application Editor -- See the help supplied with the Composite Application Editor. The 
Composite Applications Editor can be installed during Lotus Notes 8 installation. 

z	 Portal Application Template Editor -- See the documentation supplied with WebSphere Portal. 

z	 Wiring Properties Editor -- This composite applications WSDL editor is installed with Domino 
Designer and is documented in the Domino Designer help. It is also available in Lotus Component 
Designer. 

z	 For information about the IBM Lotus Expeditor runtime environment, as well as feature install and 
upgrade, see the Lotus Expeditor information center at 
http://publib.boulder.ibm.com/infocenter/ledoc/v6r1/topic/com.ibm.help.ic.doc/wed_welcome_ic.html. 
Look for updates to this content as the Expeditor 6.1.1 information center becomes available. 

z	 For IBM WebSphere Portal server and IBM WebSphere Application server installation and setup, see 
the information center at 
http://publib.boulder.ibm.com/infocenter/wpdoc/v6r0/topic/com.ibm.wp.ent.doc/wpf/welcome.html. 

z	 For Sametime server setup, see the Sametime Server Installation documentation. 

z	 For information about installing the Lotus Notes server client installer in support of composite 
application that contain portlets, and other Portal-based elements, see the release note, "Installing the 
Notes server client installer" in the installation notes section of these release notes. Also see the 
"Specifying the home portal account using policy" and "Specifying the home portal account using 
preferences" release notes. 

z	 For general information about upgrading Notes clients, see the "Notes client installation and Smart 
Upgrade" section of the Lotus Domino Administrator 8 Help supplied with the product. 

z	 For information about installing or upgrading to Lotus Notes 8, see "Installing Notes 8 Beta on 
Windows" and "Installing Notes 8 Beta on Linux" and related topics in the installation notes section of 
these release notes. 

z	 For information about uninstalling Lotus Notes 8 Beta, see the "Uninstalling Notes 8 Beta on 
Windows" and "Uninstalling Notes 8 Beta on Linux" release notes. 

z	 For deployment information relative to HTTP and NRPC provisioning of Eclipse components and 
composite applications, see topics in the configuration notes section of these release notes. 
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Lotus Notes, Domino Designer 

Installing Lotus Notes 8 Beta on Windows - single user 
This release note contains the IBM Lotus Notes 8 Beta installation instructions for the Web client 
download for Windows, available at the Lotus Notes 8 Beta Downloads Web page. 

Mail, calendar, and contact features are installed with Lotus Notes 8 Beta, including traditional Lotus 
Notes basic functionality. Additional features such as the IBM Lotus Productivity Tools, Activities, and the 
Composite Application Editor can also be installed. 

Lotus Notes 8 is available as an install media kit. Lotus Notes 8 can be installed in graphical mode or 
silent mode. 

You can install using the Notes-only kit or the Allclient kit. The Allclient kit includes IBM Lotus Domino 
Designer and IBM Lotus Domino Administrator.  The install media kit consists of the following items: 

z	 installation program executable file (setup.exe) 
z	 zipped updateSite directory (contains Eclipse features folder, plugins folder and site.xml) 
z	 deploy directory (contains the Eclipse install manifest install.xml and plugin_customization.ini) 
z	 setup.ini 
z	 Lotus Notes 8.0.msi 

If a Lotus Notes release 6.5.x or 7.x is detected on the client, the installation program will upgrade it to the 
current Lotus Notes release. If you are running a version of Lotus Notes that was released prior to Notes 
6.5, upgrade to at least Lotus Notes 6.5 before installing and upgrading to this Lotus Notes release. 

If an existing version of IBM Lotus Domino Designer or IBM Lotus Domino Administrator is resident, you 
can choose to upgrade them using the Allclient installation media kit. 

Note that multi-user does not support the Allclient installation program. 

Considerations before installing  -- Read this first 

The following information is useful when installing or upgrading Lotus Notes 8 on a Microsoft Windows 
client. 

Note: See the requirements section of the release notes for the latest information on supported hardware 
and software. 

z	 When installing Lotus Notes 8 for single user, you must be logged in as an administrative user or 
as a non-administrative user with elevated privileges. 

z	 Lotus Notes 8 installation on Windows supports Windows XP, and Vista Aero. 

z	 You can install Lotus Notes 8 on Windows in a single user or multi-user environment. 

z	 When installing Lotus Notes 8 using the Windows Allclient kit, feature panel installation options 
are available for installing or upgrading the Domino Designer and Domino Administrator clients. 

z	 While a minimum of 512MB of memory is required, 1GB or more of memory is recommended. 
See the "Software requirements" section of the release notes for details.  

z	 A summary panel displays the disk space footprint for what is being installed. Install also needs 
additional temporary disk space. The temporary disk space required is almost as large as the 
footprint. If you do not have enough space for the footprint and temporary space, the installer will 
stop you from continuing. 

z	 Shut down all applications before installing Lotus Notes 8. 

z	 If you have installed a previous Beta version of Lotus Notes 8, uninstall it before installing Lotus 
Notes 8. Upgrade from a Beta version of this release is not supported. 

z	 Smart Upgrade is not supported in Lotus Notes 8 Beta. 

z	 Shared network install is not supported in Lotus Notes 8. Shared network install of Lotus Notes 8 
basic configuration remains available. 
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z	 Roaming user is not supported in Lotus Notes 8. Roaming user in Lotus Notes 8 basic 

configuration remains available.


z	 Lotus Notes 8 supports the English US OS locale only. 

z	 The IBM productivity tools support the English US OS locale only. 

z	 The installation path cannot contain special characters such as # or $. 

z	 Only one instance of Lotus Notes 8 should be installed on a client workstation at any given time. 

z	 If installation does not complete successfully, uninstall the program using the instructions in the 
"Uninstalling Notes on Windows" release note and reference the information in the "Cleaning a 
previous Notes installation from your client" release note. 

Procedure -- Installing Lotus Notes  8 Beta for Windows 
Read the considerations section above before starting Lotus Notes 8 installation. 

Installation of Lotus Notes 8 on Windows is supported for single user or multi-user. For Windows, the 
Lotus Notes client-only is available in the Notes.msi.w32 installation media kit. The Lotus Notes, Domino 
Administrator and Domino Designer clients are available in the AllClient.msi.w32 installation media kit. 
When installing Notes in a single user environment using the Windows Allclient kit, you can install or 
upgrade the Domino Designer and Domino Administrator clients. 

1. Shut down all applications. 

2. If you have installed a previous Beta version of this Lotus Notes release, uninstall it before continuing. 

See the "Uninstalling Notes on Windows" release note for details. 


3. Obtain the Lotus Notes installation media kit. 

For example, obtain the installation media kit CD or open a browser and navigate to the Lotus

Notes/Domino Web site at which the installation media kit resides.


4. Save the installation media kit to a local folder, for example to your C:\temp folder. 

5. Navigate to the folder in which you saved the installation media kit. 

6. Locate and run the setup.exe installation executable. 

Note: If a user has the environment variables USERPROFILE, HOMEDRIVE, or HOMEPATH set to a 
network share, you must use special command line parameters to ensure that all data directories are 
installed locally, thus eliminating issues with network shares. You can check for these environment 
variables by typing "SET" at a command prompt. If HOMEDRIVE is not set to C:, you must review this 
instruction carefully. For example, if HOMEDRIVE=H: (where "H" may be a mapped network drive). 

7. Read the Welcome screen and click Next.

8. Read and accept the license agreement terms and click Next.

9. Enter your user name and organization, choose the "Single-user Install" setting, and click Next. 

10. Accept the default install directory or specify a different installation directory and click Next. 

The default installation directories for a new single user install are as below: 

z	 Install directory -- C:\Program Files\IBM\Lotus\Notes 
z	 Expeditor directory -- C:\Program Files\IBM\Lotus\Notes\framework 
z	 Notes data directory -- C:\Program Files\IBM\Lotus\Notes\data 
z	 Workspace directory -- C:\Program Files\IBM\Lotus\Notes\data\workspace 
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If a Lotus Notes version is currently installed, the default path is the current Lotus Notes installation 
path. When you install Lotus Notes single user on a system on which Lotus Notes 6.5 or 7.x is already 
installed, the traditional Lotus Notes portion of the product is upgraded and installed to the same 
directory in which the existing Lotus Notes install binaries currently reside, for example C:\lotus\notes. 
The Lotus Notes data directory is assumed to be the directory where the existing Lotus Notes install 
data files exist, for example C:\lotus\notes\data. Additional Lotus(R) Expeditor framework files are 
installed to a \framework subdirectory, for example C:\lotus\notes\framework. 

11. Select the features and sub-features to install and click Next. 

These options include the following: 

z	 Notes client -- The Lotus Notes client is installed automatically but you can control which individual 
sub-features to install. 

z	 Domino Administrator -- Select this to install or upgrade the Domino Administrator client and

specify which subfeatures to install. 


z	 Domino Designer -- Select this to install or upgrade the Domino Designer client and specify which 
subfeatures to install. Note that the Property Broker Editor (WSDL editor) is installed automatically 
with Domino Designer. 

z	 Activities -- Select this to install the Activities feature and specify which subfeatures to install. An 
activities server is required to use this feature. 

z	 Composite Applications Editor -- Select this to install the Composite Applications Editor for use 
with composite applications. 

z	 IBM Lotus Productivity Tools -- Select this to install IBM Lotus Documents, IBM Lotus 

Presentations, and IBM Lotus Spreadsheets.


z	 Sametime (integrated) -- This option is not available for selection. Basic Sametime capabilities 
such as chat and livenames are automatically installed. A Sametime server is required to use this 
feature. 

12. Optionally specify Notes as your default email program and click Install. 

13. Read the preview screen and click Install to continue or Back to revise your feature selections. 

Note: If errors occur and you are installing the current Lotus Notes release on a system on which an 
existing version of the current Lotus Notes release, such as a Beta version, may not have been 
properly uninstalled, see the "Uninstalling Notes on Windows" and the "Cleaning a previous Notes 8 
Beta installation from your client" release notes for details. 

14. When installation is complete, read the summary screen and click Finish to exit the installation wizard. 

The installation program creates new shortcut icons on your desktop, including those for the Lotus 
Notes client itself and the productivity tools, Domino administrator client, and Domino Designer client, 
if you chose to install those features. 

15. Use the new desktop icon to start Lotus Notes or click Start - Lotus Applications - Lotus Notes 8. 

If this is a new install, respond to configuration wizard prompts. Your administrator can supply the 
Domino server and configuration information to you. 

16. If this is the first time that you have installed or upgraded to this Lotus Notes release, you should 
update your Lotus Notes mail template and contacts list now. Replace the design of your Mail and 
Contacts templates and make sure that your location document points correctly. For mail, use the Mail 
(R8) (mail8.ntf) template. For contacts, use the Personal Address Book (pernames.ntf) template. 

a.Click Open - Mail or the Mail tab. 

b.Click File - Application - Replace Design. 

c. Select the Mail (R8) (mail8.ntf) template from the list. 

d.Disable the Inherit future design option. 

e.Click Replace and then click OK or Yes in response to any prompts. 
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f. Close the Mail tab. The new design will appear when you open Mail after client restart. 

g.Click Open - Contacts or the Contacts tab. 

h.Click File - Application - Replace Design. 

i. Select the Personal Address Book (pernames.ntf) template from the list. 

j. Disable the Inherit future design option. 

k. Click Replace and then click OK or Yes in response to any prompts. 

l. Close the Contacts tab. The new design will appear when you open Contacts after client restart. 

17. Close and then restart Lotus Notes.

You must restart Lotus Notes after replacing the mail and contacts template designs. 

Administrators should install any needed servers, such as IBM WebSphere Portal server, the Activities 
server application on WebSphere Application Server (to support Activities) and the Notes server client 
installer on the WebSphere Portal server (to support composite applications that contain portlets). 

Lotus Notes 

Installing Lotus Notes 8 Beta on Windows - multi-user 
This release note contains the IBM Lotus Notes 8 Beta installation instructions for the Web client 
download for Windows, available at the Lotus Notes 8 Beta Downloads Web page. 

Mail, calendar, and contact features are installed with Lotus Notes 8 Beta, including traditional Lotus 
Notes basic functionality. Additional features such as the IBM Lotus Productivity Tools, Activities, and the 
Composite Application Editor can also be installed. 

Lotus Notes 8 is available as an install media kit. Lotus Notes 8 can be installed in graphical or silent 
mode. 

For Windows, the Lotus Notes client-only is available in the Notes.msi.w32 installation media kit. The 
Allclient kit is not available for multi-user installation. The install media kit consists of the following items: 

z installation program executable file (setup.exe) 
z zipped updateSite directory (contains Eclipse features folder, plugins folder and site.xml) 
z deploy directory (contains the Eclipse install manifest install.xml and plugin_customization.ini) 
z setup.ini 
z Lotus Notes 8.0.msi 

If a Lotus Notes release 6.5.x or 7.x is detected on the client, the installation program will upgrade it to the 
current Lotus Notes release. If you are running a version of Lotus Notes that was released prior to Notes 
6.5, upgrade to at least Lotus Notes 6.5 before installing and upgrading to this Lotus Notes release. 

If an existing version of IBM Lotus Domino Designer or IBM Lotus Domino Administrator is resident, you 
can choose to upgrade them using the Allclient installation media kit. Note that multi-user does not 
support the Allclient installation program. 
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Considerations before installing  -- Read this first

The following information is useful when installing or upgrading Lotus Notes 8 on a Microsoft Windows 

client.


Note: See the requirements section of the release notes for the latest information on supported hardware 
and software. 

z	 When installing for multi-user, you must be logged in as an administrative user. Once installed, users 
can open and use Lotus Notes 8. 

z	 Lotus Notes 8 installation on Windows supports Windows XP, and Vista Aero. 

z	 You can install Lotus Notes 8 on Windows in a single or multi-user environment. 

z	 While a minimum of 512MB of memory is required, 1GB or more of memory is recommended. See the 
"Software requirements" section of the release notes for details.  

z	 A summary panel displays the disk space footprint for what is being installed. Install also needs 
additional temporary disk space. The temporary disk space required is almost as large as the 
footprint. If you do not have enough space for the footprint and temporary space, the installer will stop 
you from continuing. 

z	 Shut down all applications before installing Lotus Notes 8. 

z	 If you have installed a previous Beta version of Lotus Notes 8, uninstall it before installing Lotus Notes 
8. Upgrade from a Beta version of this release is not supported. 

z	 Smart Upgrade is not supported in Lotus Notes 8 Beta. 

z	 Shared network install is not supported in Lotus Notes 8. Shared network install of Lotus Notes 8 
basic configuration remains available. 

z	 Roaming user is not supported in Lotus Notes 8. Roaming user in Lotus Notes 8 basic configuration 
remains available. 

z	 Lotus Notes 8 supports the English US OS locale only. 

z	 The IBM productivity tools support the English US OS locale only. 

z	 The installation path cannot contain special characters such as # or $. 

z	 Only one instance of Lotus Notes 8 should be installed on a client workstation at any given time. 

z	 If installation does not complete successfully, uninstall the program using the instructions in the 
"Uninstalling Notes on Windows" release note and reference the information in the "Cleaning a 
previous Notes installation from your client" release note. 

Procedure -- Installing Lotus Notes  8 Beta for Windows 
Read the considerations section above before starting Lotus Notes 8 installation. 

Installation of Lotus Notes 8 on Windows is supported for single user or multi-user. For Windows, the 

Lotus Notes client-only is available in the Notes.msi.w32 installation media kit. The Allclient kit is not

available for multi-user installation.


1. Shut down all applications. 

2. If you have installed a previous Beta version of this Lotus Notes release, uninstall it before continuing. 

See the "Uninstalling Notes on Windows" release note for details. 


3. Obtain the Lotus Notes installation media kit. 

4. Save the installation media kit to a local folder, for example to your C:\temp folder. 

5. Navigate to the folder in which you saved the installation media kit. 
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6. Locate and run the setup.exe installation executable. 

Note: If a user has the environment variables USERPROFILE, HOMEDRIVE, or HOMEPATH set to a 
network share, you must use special command line parameters to ensure that all data directories are 
installed locally, thus eliminating issues with network shares. You can check for these environment 
variables by typing "SET" at a command prompt. If HOMEDRIVE is not set to C:, you must review this 
instruction carefully. For example, if HOMEDRIVE=H: (where "H" may be a mapped network drive). 

7. Read the Welcome screen and click Next.

8. Read and accept the license agreement terms and click Next.

9. Enter your user name and organization, choose the "Multi-user Install" setting, and click Next. 

10. Accept the default install directory or specify a different directory installation directory and click Next. 

Note: You must install to a directory that is readable but not writeable by all users. 
11. Select the features and subfeatures to install and click Next. 

These options include the following: 

z	 Activities -- Select this to install the Activities feature. An activities server is required to use this 
feature. 

z	 Sametime (integrated) -- This option is not available for selection. Basic Sametime capabilities 
such as chat and live names are automatically installed. A Sametime server is required to use this 
feature. 

z	 IBM Lotus Productivity Tools -- Select this to install IBM Lotus Documents, IBM Lotus 

Presentations, and IBM Lotus Spreadsheets.


z	 Composite Applications Editor -- Select this to install the Composite Applications Editor for use 
with composite applications. 

12. Optionally specify Notes as your default email program and click Install. 

13. Read the preview screen and click Install to continue or Back to revise your feature selections. 

Note: The installation process takes several minutes. 

Note: A security acceptance screen from any firewalls you have installed may appear asking for 
confirmation. 

Note: If errors occur and you are installing the current Lotus Notes release on a system on which an 
existing version of the current Lotus Notes release, such as a Beta version, may not have been 
properly uninstalled, see the "Uninstalling Notes on Windows" and the "Cleaning a previous Notes 8 
Beta installation from your client" release notes for details. 

14. When installation is complete, read the summary screen and click Finish to exit the installation wizard. 

Note: If installation is unsuccessful, this screen points you to the install log file. 

You can see application icons on the desktop and by clicking Start - All Programs - Lotus 

Applications. Applications are resident in  C:\Documents and Settings\All Users\Start 

Menu\Programs\Lotus Applications. 


If you installed the IBM Lotus productivity Tools, you can see application icons on the desktop and by 
clicking Start - All Programs. Applications are resident in: C:\Documents and Settings\All Users\Start 
Menu\Programs. 
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Understanding what was installed 
z	 After install, the Lotus Notes icon is visible by clicking Start - All Programs - Lotus Applications. 

z	 After install, the IBM Lotus Productivity Tool icons, if installed, are visible by clicking Start - All 
Programs. 

z	 Desktop shortcuts are created for all users in C:\Documents and Settings\All Users\Desktop. 

z	 A shared data directory is created in the following location: 

C:\Documents and Settings\All Users\Local Settings\Application Data\Lotus\Notes\Data 

z	 A data directory and workspace directory is created for each user in the following location: 

C:\Documents and Settings\<user>\Local Settings\Application Data\Lotus\Notes\Data 

C:\Documents and Settings\<user>\Local Settings\Application Data\Lotus\Notes\Data\workspace 

C:\users\<user>\appdata\local\lotus\notes\data\workspace 

Each user workspace directory resides under the Notes data directory. 

z	 Notes classic files are installed in <install_dir>. 

z	 Core Expeditor files are installed to <install_dir>\framework\rcp. 

z	 Core Eclipse files are installed to <install_dir>\framework\eclipse. 

Running the Notes client on Windows as a user after administrative install

Once the administrator has installed the Notes client, users can log in and run Notes. 


1. Log in as a non-administrative user. 

2. Start Lotus Notes using the new desktop shortcut or click Start - Lotus Applications - Lotus Notes 8. 

3. Respond to Notes setup prompts as they appear. 

4. If this is the first time that you have installed or updated to this Lotus Notes release, you should update 
your Lotus Notes mail template and contacts list now. This step is only necessary when you first 
update to this Lotus Notes release. If you uninstall and reinstall Lotus Notes you will not need to repeat 
this step. Replace the design of your Mail and Contacts templates and make sure that your location 
document points correctly. For mail, use the Mail (R8) (mail8.ntf) template. For contacts, use the 
Personal Address Book (pernames.ntf) template. 

a.Click Open - Mail or the Mail tab. 

b.Click File - Application - Replace Design. 

c. Select the Mail (R8) (mail8.ntf) template from the list. 


d.Disable the Inherit future design option.


e.Click Replace and then click OK or Yes in response to any prompts.


f. Close the Mail tab. The new design will appear when you open Mail after client restart.


g.Click Open - Contacts or the Contacts tab. 


h.Click File - Application - Replace Design. 


i. Select the Personal Address Book (pernames.ntf) template from the list. 

j. Disable the Inherit future design option. 

k. Click Replace and then click OK or Yes in response to any prompts. 

l. Close the Contacts tab. The new design will appear when you open Contacts after client restart. 

5. Close and then restart Lotus Notes.

You must restart Lotus Notes after replacing the mail and contacts template designs. 
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Lotus Notes 

Installing Lotus Notes 8 Beta on Linux

This release note contains the IBM Lotus Notes 8 Beta installation instructions for the Web client

download for Windows, available at the Lotus Notes 8 Beta Downloads Web page. 


Mail, calendar, and contact features are installed with Lotus Notes 8 Beta, including traditional Lotus 
Notes basic functionality. Additional features such as the IBM Lotus Productivity Tools, Activities, and the 
Composite Application Editor can also be installed. 

Upgrading an existing Lotus Notes 7.x installation Lotus Notes 8 is not supported for Linux. Instead, 

uninstall the existing Lotus Notes version prior to installing Lotus Notes 8.


Lotus Notes is available as an install media kit. Lotus Notes can be installed in graphical or silent mode. 

For Linux, the Lotus Notes 8 client-only is available in the Notes.ismp.linux installation media kit. The 

install media kit consists of the following items:


z	 installation program executable file (setup.sh and setup.bin) 
z	 deploy directory (contains the Eclipse install manifest install.xml and plugin_customization.ini) 
z	 zipped updateSite directory (contains Eclipse features folder, plugins folder and site.xml) 
z	 media.inf file 

Considerations before installing  -- Read this first 

The following information is helpful when installing Lotus Notes 8 on a Linux client: 

Note: See the requirements section of the release notes for the latest information on supported hardware 
and software. 

z	 Lotus Notes 8 installation on Linux supports SLED 10 (XGL enabled or disabled). 

z	 Before installing Lotus Notes 8 on a Linux client, you must have Mozilla Firefox, version 1.5+ GTK2 
build, Mozilla Seamonkey, or the Mozilla Runtime Environment, version 1.8+ GTK2 build, installed on 
your system.  The client will not support the earlier Beta requirement of Mozilla 1.7.12. See the "Linux 
system requirements" release note for details. 

z	 You can install Lotus Notes 8 on Linux in a multi-user environment. Single user install is not 
supported. 

z	 While a minimum of 512MB of memory is required, 1GB or more of memory is recommended. See the 
"Software requirements" section of the release notes for details. 

z	 A summary panel displays the disk space footprint for what is being installed. Install also needs 
additional temporary disk space. The temporary disk space required is almost as large as the 
footprint. If you do not have enough space for the footprint and temporary space, the installer will stop 
you from continuing. 

z	 You must be logged in as a root user or switch user to root before installing Lotus Notes. Once 
installed, non-root users can open and use Lotus Notes. 

z	 If you have installed a previous Beta version of Lotus Notes 8, uninstall it before installing Lotus Notes 
8. Upgrade from a Beta version of this release is not supported. 

z	 Smart Upgrade is not supported in Lotus Notes 8 Beta. 

z	 Shared network install is not supported in Lotus Notes 8. Shared network install of Lotus Notes 8 
basic configuration remains available. 

z	 Roaming user is not supported in Lotus Notes 8. Roaming user in Lotus Notes 8 basic configuration 
remains available. 

z	 Lotus Notes 8 supports the English US OS locale only. 

z	 The IBM productivity tools support the English US OS locale only. 
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z	 The installation path cannot contain special characters such as # or $. 

z	 Only one instance of Lotus Notes 8 should be installed on a client workstation at any given time. 

z	 If installation does not complete successfully, uninstall the program using the instructions in 
Uninstalling Notes on Linux release note and reference the information in Cleaning a previous Notes 
installation from your client release note. 

Procedure -- Installing Lotus Notes  8 Beta for Linux 

Read the considerations section above before starting Lotus Notes 8 installation. 

1. Shut down all applications. 

Exit out of any existing versions of Workplace Managed Client, Sametime, and Notes. Make sure that 
all processes are killed, including eclipse/javaw, eclipse/notes2w, sametime, notes, taskldr, and 

nsdexec.


From a command prompt, change to the to Notes/data directory and type the following command:


 /opt/ibm/lotus/notes/nsd.sh -kill 

2. If you have installed a previous Beta version of this Lotus Notes release, uninstall it before continuing. 

For information about uninstall, see the "Uninstalling Notes on Linux" release note.


3. As the root user, open a new terminal window or File Browser. 

4. If you are obtaining the installation kit from a Web downloads page, open your Mozilla GTK2 browser

and navigate to the Web page from which to obtain the download. 


For current information about browser requirements, see the release notes. 

5. Locate the Lotus Notes installation media kit and save it to a local folder, for example to your /root 

folder. The supplied media kit name is Notes.ismp.linux.


For example, obtain the installation media kit CD or open a browser and navigate to the Lotus

Notes/Domino Web site at which the installation media kit resides.


6. Navigate to the folder in which you saved the installation kit and unpack the tar file. 

7. Change to the directory that contains the unpacked setup.sh installation executable. 

Note: Verify that the directory also contains the deploy directory, setup.bin, and updateSite.zip. These 
contain the needed install manifest and feature and plug-in JAR files. 

8. Run the setup.sh installation executable by double-clicking on setup.sh or by running ./setup.sh in a

shell.


Note: You must switch user to root or be logged in as a root user to install. 

9. Read the Welcome screen and click Next.

10. Read and accept the license agreement terms and click Next.

11. Accept the default install directory (/opt/ibm/lotus/notes) or choose a different install directory. 

You must install to a directory that is readable, but not writeable, by all users. 

Note: Upgrade from a Notes 7.x installation is not supported; install to a different directory or uninstall 
Notes before installing. 
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12. Select the features to install and click Next. 

These options include the following: 

z	 Activities -- Select this to install the Activities feature. An activities server is required to use this 
feature. 

z	 Sametime (integrated) --  This option is not available for selection. Basic Sametime capabilities 
such as chat and livenames are automatically installed. A Sametime server is required to use this 
feature. 

z	 IBM Lotus Productivity Tools -- Select this to install IBM Lotus Documents, IBM Lotus 

Presentations, and IBM Lotus Spreadsheets.


z	 Composite Applications Editor -- Select this to install the Composite Applications Editor for use 
with composite applications. 

13. Read the preview screen for installation directory, features, and size and click Install. 

This process may take several minutes. 

A security acceptance screen from any firewalls you have installed may appear asking for

confirmation, even if the installation is being done locally.


A progress bar displays while the installer copies files to the install directory and provisions the

installed features.


Note: If errors occur and you are installing Lotus Notes on a system on which an existing version of 
this Lotus Notes release, such as a Beta version, may not have been properly uninstalled, see the 
instructions in the "Uninstalling Notes on Linux" release note and reference the information in the 
"Cleaning a previous Notes installation from your client" release note. 

14. Read the installation summary screen and click Finish to exit the installation wizard. 

Note: If installation is unsuccessful, you can open the install log file at <install_dir>/

framework/rcp/installer_logs/framework_install.log. 


Understanding what was installed 

The following information describes what was installed. 

z	 After install, application icons should be visible for all users by clicking Computer - More 

Application - Office and reside in  /usr/share/applications. 


z	 The Notes installer does not create desktop shortcut icons. 

z	 A new data directory is created for this user in /root/lotus/notes/data. 

z	 A new workspace is created for this user in /root/lotus/notes/data/workspace. 

z	 The Notes classic binaries are installed to <install_dir>. 

z	 A shared data directory is created in /etc/lotus/notes/data. 

Running the Notes client on Linux as a user after root user install 

Once the administrator has installed the Notes client, users can log in and run Notes. 

1.	 Log in as a non-root user. 

2.	 Start Lotus Notes by clicking the Computer option - More Applications... - New Applications - Lotus 
Notes 8. 

3.	 Respond to Notes setup prompts as they appear. 

You should update your mail template for this release. Your contacts should be automatically updated. 
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Lotus Notes 

Installing the Notes server client installer 
An administrator can install the Lotus Notes server client installer on an IBM WebSphere Portal server. 
This is required for Notes 8 Beta users who will be using composite applications that contain portlet 
elements. It is available as a Web download at the Beta Downloads site. 

The Notes server client installer is required to install portlets onto the server and for Notes 8 Beta client 
communication with the WebSphere Portal server. For example, if you want to users to be able to edit a 
portal-based composite application using the Composite Application Editor, you must first run the Notes 
server client installer. The  Notes server client installer program installs the .war files that are required by 
the Composite Applications Editor when it works with the WebSphere Portal server. 

Note: If your users create composite applications that include portlets, you must install the WebSphere 
Portal server. To use some of the functions enabled by WebSphere Portal in Lotus Notes 8 Beta, you 
must also install the Notes server client installer on the WebSphere Portal server. 

Note: The administrator must also create a Home Portal Account for Notes 8 Beta users in order for them 
to create, edit, and view composite applications that contain portlets. Users can obtain help on modifying 
a Home Portal Account using the preferences panel in their Notes online Help system.  

Perform the following steps to install the Notes server client installer on your WebSphere Portal server. 

1.	 Download the Notes server client installer from the Beta Web Downloads page and place it in a 
temporary folder such as /temp. 

2.	 Navigate to and unzip the download. 

3.	 Open the unzipped folder and note its contents, which include the setup installation executable and a 
portal folder in which various portlets and scripts reside. 

4.	 Run the setup executable. 

5.	 If a language selection panel appears, make your selection and click OK. 

6.	 Read the Welcome screen. Click Information Center if you want to read related information. Click 
Next to continue. 

7.	 Read and accept the license agreement terms. Click Next to continue. 

8.	 Accept the default installation directory or specify a new one. Click Next to continue. 

9.	 Accept the default WebSphere Portal server or specify a new one. Enter your WebSphere user name 
and password. Click Next to continue. 

Note: For details about specifying the WebSphere Portal server value, see the WebSphere Portal 
Information Center. 

10. Read the preview screen for installation directory path and size and click Install. 

Note: The installation process will take several minutes. 

11. Read the installation summary screen and click Finish to exit the installation wizard. 

Additional step if Web server or Portal server use Secure Sockets Layer  (SSL) 
If you have configured your Web server or Portal server to use Secure Sockets Layer (SSL) and are using 
a self-signed test certificate, you must perform additional steps before running the Notes server client 
installer to ensure that SSL communications occur properly between the WebSphere Portal composite 
application support for Lotus Notes program and the Web server or Portal server. These instructions are 
detailed in the "Installing the Network Client Installer when using SSL with a self-signed test certificate" in 
IBM Expeditor help at:  http://publib.boulder.ibm.com/infocenter/ledoc/ 
v6r1/index.jsp?topic=/com.ibm.rcp.tools.doc.admin/networkclientinstallSSL.html.  See the Expeditor 
release 6.1.1 Information Center as it becomes available. You do not need to additionally install the 
Expeditor network client installer. 
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Installing the WebSphere Portal composite application support for Lotus Notes  using command line 
parameters 
You can also install the Notes server client installer on the portal server using the silent or console install 
methods. 

Silent mode 
Use the following command line to install the Notes server client installer in silent mode: 

setup.exe -silent -V licenseAccepted=true -P installLocation="c:\hannover" 

-silent 

Runs the installer in silent mode 

-V LicenseAccepted=true 

Sets the variable to accept the license agreement panel 

-P installLocation="<install location >" 

Sets the Product bean in the installer to install the client in the entered location 

If you have configured your Web server or Portal server to use Secure Sockets Layer (SSL) and are using 
a self-signed test certificate, see "Additional step if Web server or Portal server use Secure Sockets Layer 
(SSL)" above. 

Console mode 
Use the following command line to install the Notes server client installer in console mode and mask the 
user interface panels: 

setup.exe -console 

The following flags are available: 

-P <product bean>.<property>="<value>" 

Sets a product bean's value 

-W <wizard bean>.<property>="<value>" 

Sets a wizard bean's value 

-G <property>=<value> 

Sets a global wizard variable 

-V <property>=<value> 

Sets a control variable, such as  a panel's radio button 

-log #!<filepath/name> @ALL 

Logs all events to a log file, for example setup.exe -log !C:\log.txt @ALL. 

The # flag is optional and is used to echo the logged events to standard output. 

If you have configured your Web server or Portal server to use Secure Sockets Layer (SSL) and are using 
a self-signed test certificate, see "Additional step if Web server or Portal server use Secure Sockets Layer 
(SSL)" above. 
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Domino Server 

Running the Domino-Portal Integration Wizard 
Use the Domino-Portal Integration (DPI) Wizard to configure a WebSphere Portal server to work with your 
Domino-based infrastructure. You can use the DPI Wizard with the Domino 7.0 server, or more recent 
servers. The DPI Wizard eliminates many of the manual Domino and WebSphere Portal configuration 
steps required to run the Domino and Extended Products Portlets, Common Mail and Common Calendar. 

Note For this Domino 8 beta release, the DPI Wizard is supported on Microsoft Windows platforms. 

Prerequisites 

The DPI Wizard requires that both the Domino server and WebSphere Portal server be installed and set

up.


z	 WebSphere Portal server 6.0 with security enabled, configured with Domino LDAP, not clustered, 
and with no support for IBM Tivoli Access Manager or Computer Associates eTrust(R) 
SiteMinder(R). 

z	 Domino LDAP server, configured as the LDAP server for WebSphere Portal 6.0, running Domino 
release 7.0 or more recent, with the LDAP and  HTTP/HTTPS services enabled. The wizard 
communicates over HTTP, but specifying an HTTPS port as well allows for a secure transmission 
of the DTPA token that the wizard copies. 

z	 If security is enabled manually on the WebSphere Portal server 6.0, instead of enabling security 
with the Advanced Configuration Wizard on the WebSphere Portal server, you will need to restart 
the WebSphere Portal Administration server before you run the DPI Wizard. To prevent having to 
manually restart the WebSphere Portal Administration server, be sure to enable security in the 
Advanced Configuration Wizard prior to running the DPI Wizard. 

z	 All servers must be behind the same Internet security firewall, in the same Internet domain, and if 
they are Domino servers, in the same Domino domain. 

z	 To run the DPI Wizard, you must be listed as an Administrator in the Server document in the 
Domino Directory (NAMES.NSF) on the Lotus Domino LDAP server. 

Caution If you already have a Web SSO configuration on your Domino servers, be sure to read the 
"Consideration for existing SSO environments" section prior to running the wizard. 

Considerations for existing Web SSO environments

The wizard creates a fresh Web SSO environment for all of the IBM Lotus Domino servers in your

Domino domain that you choose to configure.

If your installation of Lotus Domino is new, or if your existing Lotus Domino and Lotus Sametime servers

have no Web SSO documents in their Domino Directory applications (NAMES.NSF files), no further 

action is needed and you are ready to run the wizard.


If you do have one or more existing Web SSO documents, refer to the following checklist to evaluate

whether your site is ready to run the wizard. There is a technote available on the IBM Support Web site

providing instructions for dealing with the existing documents. The technote is:


Title: Domino-Portal Integration Wizard unable to create a working Web Single Sign-On environment 

Doc #:1256149

URL: http://www.ibm.com/support/docview.wss?uid=swg21256149


z	 If you have an existing Web SSO document in your Domino Directory (NAMES.NSF), check to see 
whether it has the name LtpaToken. If all Web SSO documents in your domain have other names, no 
further action is needed and you are ready to run the wizard. The wizard creates a document with this 
exact name and will not affect your existing documents with other names. 
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z	 If the document is called LtpaToken, check to see whether there are any copies of it on other Lotus 
Domino servers in your Lotus Domino domain that have different content (for example, with different 
servers listed in the document). The Web SSO document should always be created by replication so 
that its content is identical on all Lotus Domino servers. If you have documents with differing content, 
you need to correct the configuration before you can run the wizard. For instructions, see the 
technote. 

z	 If the document is called LtpaToken and has the same content on all servers, check to see whether it 
was created by the Lotus Sametime server. A document created by the Sametime server before Web 
SSO is configured in Lotus Domino cannot be used with the wizard. You need to correct this 
configuration. For instructions, see the technote. 

z	 If the document is called LtpaToken, has the same content on all servers, and was not created by 
Lotus Sametime, check to see whether it was created by a Lotus Domino administrator other than the 
one who will run the wizard. You need to correct this configuration; for instructions, see the technote. 

z	 If the document meets all the conditions above, but you do not plan to configure all of the Lotus 
Domino servers currently listed in it, you need to correct this configuration to list only the servers you 
plan to use with the wizard. For instructions, see the technote. 

z	 Otherwise, your environment is probably ready to run the wizard, but see the technote if you have 
concerns. 

Running the Domino-Portal Integration Wizard

Complete these steps to run the Domino-Portal Integration Wizard.


1.	 Move the following files from the Domino Directory to the WebSphere Portal server, directory path 
<PortalServerHome>/config/wizard: 

z	 DPIWizard.jar 

z	 dpiwiz.bat for Microsoft Windows platforms 

2.	 From the WebSphere Portal server, enter this command: 

z	 For Microsoft Windows platforms, enter 

You can review the log file dpitasks.log  generated during the configuration. Dpitasks.log contains 
the history of the wizard run.  If the DPI Wizard fails, use the View Log button to review the content of the 
log file. Log files are stored on the Portal server at <PortalServerHome>/log. 

When the wizard completes, the log files are zipped into a file with this naming convention: 

DPIDebug_yyyymmdd_hhmm.zip, which can be found at <PortalServerHome>/config/wizard. 

You can review this file if necessary.


Lotus Notes 

Installing Lotus Notes 8 Beta using silent installation

You can install IBM Lotus Notes using silent installation. If you are installing for multi-user, you must be 

logged in as an administrative or root user.


Notes silent install uses a tuner program to create a transform based on options that you specify when

you run the tuner. When you run the silent install, the options are applied. You can also specify features 

from the Notes install manifest (install.xml file) as command line arguments. All features in the install

manifest that have their "required" attribute set to "true" are automatically installed.
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Perform the following steps to run a silent installation.


Notes silent installation on Windows


You can specify command line options during silent Notes install on Windows.


1. Open a command window.

2. Change to the directory in which the IBM Lotus Notes install kit's setup.exe is resident.


3. Type the silent installation command.


Example commands are provided below. 


Note that these examples do not illustrate use of a transform file. 


• Use this format to run the install in silent mode, using default values, without a progress bar:

setup.exe /s /v"/qn"


Note: For example, this command installs Notes to the single user default C:\Program 

Files\IBM\Lotus\Notes directory and Notes data folders and files to the C:\Program 

Files\IBM\Lotus\Notes\data directory.


When installation is complete, the shortcut icon(s) appears on the desktop. 

• Use this format to display a message when the installation is complete or it has failed. Use the + 
parameter as follows: 

setup.exe /s /v"/qn+" 

• Use this format to display a progress bar during the installation, in addition to displaying the 
message indicating that the installation is complete or it has failed:


setup.exe /s /v"/qb+"


• Use this format to specify named install manifest features to install using the command line. Obtain 
the "installfeature" ID syntax from the Notes install manifest (install.xml).  To install any of these 
features, include the feature ID value in the “SELECTINSTALLFEATURES” property on the command 
line a shown below. Specify comma-separated features names in quotes as follows. Note the 
placement of the quote, equals sign, and space characters. 

setup /s /v"SELECTINSTALLFEATURES=Activities,Sametime,Editors,CAE /qn" 

Note: The Sametime feature will be installed; it is not optional. All features in the supplied install 
manifest whose "required' attribute is set to "true" will be installed. 
To pass a parameter that contains intervening spaces, such as a directory path, quote the parameter 
using a backslash quote sequence as follows: 

setup /s /V"SELECTINSTALLFEATURES=Activities,Editors PROGDIR=\"C:\Program 

Files\Lotus\Notes\" DATADIR=\"C:\Program Files\Lotus\Notes\Data\" /qn"


Notes silent installation on Linux 
You can specify these command line options when running a Lotus Notes silent install on Linux.  

1. Open a command window or shell. 

2. Change to the directory in which the Lotus Notes install kit's setup.bin is resident. 

3. Type the silent installation command.


Example syntax and an example command are provided below.


- silent

This specifies that the command will run in silent mode.


-V licenseAccepted="true|false"


This sets the variable to accept the license agreement panel.
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-P installLocation="<location>" 

This sets the install location for Notes client.  The value must not contain an ending slash symbol 
(\). 

-V selectInstallFeatures="<list of comma separated install feature ids>" 

This sets the list of optional install features that can be installed. 

This argument overrides all install feature "default" attributes in the install manifest. If you use this 
argument, only the install features listed in the argument and the "required" install features are 
installed/selected. 

-V removeInstallFeatures="<list of comma separated install feature ids>" 

This sets the list of optional install features that can be removed on upgrade. 

This argument is only supported for Domino Administrator and Domino Designer install features 
when you are updating Notes. If Notes is already installed, and the Administrator client and/or 
Designer client are also already installed, and you are upgrading Notes with the current installer, 
you can use this argument to remove/deselect the Administrator client and/or Designer client from 
the upgrade. 

In this example, the Lotus Notes installer is run silently such that all features in the install manifest whose 
required attribute is set to true are installed and the license agreement is accepted without prompting. You 
must minimally use these command line parameters to run Notes silent install on Linux. 

setup.exe -silent -V licenseAccepted="true" 

Lotus Notes 

Shared network install not supported 
Shared network install is not supported in Lotus Notes 8. Shared network install of Lotus Notes 8 basic 
configuration remains available. 

Lotus Notes 

Roaming user not supported 
Roaming user is not supported in Lotus Notes 8. Roaming user in Lotus Notes 8 basic configuration 
remains available. 

Lotus Notes 

Smart Upgrade not supported 
Smart Upgrade is not supported in Lotus Notes 8 Beta. 
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Lotus Notes 

Installing and subscribing to preset feeds 
The deploy\extras folder in the Lotus Notes 8 install media kit contains a presetfeeds.opml XML file in 
which the following preset feed subscriptions are supplied.  Note that the default subscriptions may have 
been updated since this writing; check the install media kit's presetfeeds.opml file for the latest preset 
feed subscriptions. 

z Notes 8: Domino Blog 
z Notes 8: Domino Hints and Tips 
z Notes 8: Collaboration and Travel 
z Notes 8: The Road to Hannover 
z Notes 8: Designing Lotus Notes 

Controlling preset feeds prior to Notes install 
To control which preset feeds are available to Notes users, you can modify the 
deploy\extras\presetfeeds.opml file prior to installing Lotus Notes. You can also export feeds from an 
existing feed reader into presetfeeds.opml. 

Adding preset feeds 
You can add preset feeds to the presetfeeds.opml file by either exporting from another reader to an .opml 
file and copying that content into presetfeeds.opml or by simply editing presetfeeds.opml using a text or 
XML editor. Alternatively you can overwrite presetfeeds.opml content with the output .opml file from 
another reader. 

Removing preset feeds

You can remove or comment out any supplied preset feeds from the presetfeeds.opm file.

If you do not want any preset feeds, you can remove or rename the presetfeeds.opml file.


Subscribing to preset feeds after Notes install 
The "Subscribe to preset feeds icon" is available in Notes from the Feeds user interface. After 
subscribing, or after toggling the icon off using the File > Preferences user interface sequence, you can 
redisplay the "Subscribe to preset feeds" icon using the following procedure. 

1. Click File -> Preferences. 

2. Click Feeds. 

3. Enable  Show "Subscribe to preset feeds" button on the toolbar and click OK. 

4. Click the Feeds icon in the Notes side shelf to open the Feeds user interface. The "Subscribe to preset 
feeds" icon contains the round feeds graphic. 

5. Click the  "Subscribe to preset feeds" icon to subscribe to the preset feeds obtained from the Notes 
installer's deploy\extras\presetfeeds.opml file. 

The "Subscribe to preset feeds" icon is removed upon completion of the  "Subscribe to preset feeds" 
process. 

If a feed cannot be read, a log file entry is created during the "Subscribe to preset feeds" process. 

Changing feed subscription after subscribing to preset feeds :

You can subscribe to new, or unsubscribe from existing, feeds using the Feeds user interface as 

described in Lotus Notes Help.
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Lotus Notes 

Uninstall Notes 8 Beta before reinstalling

If you have installed an earlier, or the same, version of Lotus Notes 8 Beta, you must uninstall that Beta

version before installing this Beta version.  Attempting to install over an existing Beta version can leave

the client in an unsupported state. See the uninstall release notes for details.


Lotus Notes 

Keeping a pre-Notes 8 version on Windows 
On Windows, you can make a copy of your IBM Lotus Notes 6.5.x or 7.x installation and then install Lotus 
Notes 8. 

These instructions apply to single user installations only. 

You must have local administrator privileges to complete this procedure. 

1. Shut down the Notes client and all Notes-related tools, utilities and add-ins running on your computer.  

2. Make a backup copy of your notes.id and notes.ini file. 

3. Rename the Notes 6.5.x or 7.x install directory. For example, rename the directory notes7. 

4. Rename the entire Notes registry key HKEY_LOCAL_MACHINE\Software\Lotus\Notes. For example, 

rename it HKEY_LOCAL_MACHINE\Software\Lotus\Notes7.


5. Rename the entire Installer registry key HKEY_CURRENT_USER\Software\Lotus\Notes\Installer. For 

example, rename it HKEY_CURRENT_USER\Software\Lotus\Notes\Installer7.


6. Create a new desktop shortcut to run the Notes 6.5.x or 7.x version. Create a copy of your existing 

Notes desktop shortcut icon, then right click on it, click Properties and change the following settings:


a.Change the Shortcut tab - Target value to \notes7x\notes.exe =\notes\notes.ini. 

b.Change the Start in value to \notes7x. 

c. Change the Title (General tab) to Notes 7. 

d.Click OK to close the properties dialog. 

7. Install Lotus Notes 8. 

8. When installation is complete, rename the 6.5.x or 7.x install directory back to its original name. 

Lotus Notes 

Creating a verbose log file during Notes  8 install 
If reporting Notes 8 Beta issues against the Windows version Notes 8 installation program, you should 
include a verbose log file with your problem report. To create a verbose log file, do either of the following: 

z	 Run the setup executable from the command line in the verbose mode and specify a log file name. 
For example, start the installer using the following command line:


setup /v"/lv* c:\temp\install.log"


z	 Set a registry value to always generate an MSI log file for each Notes 8 install and uninstall. To do so, 
create a registry entry HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Installer 
with String Value Logging=voicewarmup. This will create an MSI log file in your <temp> directory with 
the file extension ".log" for all MSI installations. 
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Domino Server 

Do not attempt to install Domino data path under drive disk name

Do not attempt to install the Domino data path under only a drive disk name, on the Windows platform.  

For example, do not specify an installation data path of "D:/" or "C:/".


Lotus Notes 

Ending the Notes 8 installation process before completion 
Once you click "Install" on the Lotus Notes 8 installation panel, allow the installation to complete.  Ending 
the installation process prematurely can leave files in an unstable state, and may also leave empty 
folders. Ending the installation process after the pre-installation screen can leave miscellaneous files on 
your system. 

Lotus Notes 

Google Desktop search plug-in install download 
After installing Lotus Notes 8 Beta, users can optionally install the Google desktop search plug-in. 
Administrators can forward the download URL to their users, and users can install the application onto 
their client.  A description of the plug-in is available at the download site. 

Lotus Notes 

Installation path cannot contain certain characters 
The Lotus Notes 8 installation path cannot contain special characters such as # or $.  Additionally, on 
Linux, the installation path cannot contain a space character.  The uninstall utility will not run if the 
installation path contains one or more spaces. 

Domino Server 

Installing Domino and DB2 on IBM AIX and Linux platforms 
Note  After you install the Domino 8 server and Domino 8 Administrator client (Step 1 below), open the 
Domino 8 Administrator online help to see the detailed instructions for completing the steps in the 
procedure below. 

Setting up the Domino server environment

 1. (Domino administrator) Install and set up the Domino 8 server and Domino 8 Administrator. 

Installing and setting up the DB 2 server

 1. (AIX or Linux Admin) Create the DB2 installation user account.

 2. (DB2 or IBM AIX or Linux admin logged on using installation user account) Install DB2 on IBM AIX. 

Setting up the DB2 server environment

 1. Create a DB2 administrator account.

 2. (AIX or Linux Admin) From AIX or Linux OS or from the AIX or Linux administrator tool, create three 
primary groups.

 3. (DB2 administrator) Determine whether your DB2 configuration already has a SYSCTRL_GROUP. 

4. On the DB2 server, log in using the Instance owner user account name and password. In a remote 
configuration, the IBM Lotus Domino user account can be the same ID as the Instance owner's user 
ID. 
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5. Add the Domino server user account to the DB2DOM group or to whatever group you have 
designated as the SYSCTRL_GROUP.

 6. (Instance owner)Update the DB2 configuration by entering these commands from the CLP window: 

DB2STOP 

DB2START

 7. From AIX or Linux OS or from the AIX or Linux administrator tool, create three user accounts and 
add them to groups you created in step 2.

 8. (DB2 Administrator) If your configuration includes a DB2 Run-Time Client, install the DB2 Run-Time 
Client on the computer on which you installed the Domino server. 

9. Restart the Domino server.

 10. DB2 administrator) Install IOCP on the same server on which you will install the DB2 Access server.

 11. (Domino administrator) Restart the Domino server and the administrator client. 

Enabling the Domino server to communicate with the DB 2 server

 1.	 (Domino administrator)From the Domino Administrator, run the DB2 Server Enablement Tool to 

enable the Domino server to communicate with DB2.


 2.	 Grant the SETSESSIONUSER privilege to the Domino server user 

(Optional) Installing the DB2 Access server 

Installing the DB2 Access server is optional. Determine whether you need to install it. The DB2 Access 
server is required for SQL access to Domino data which includes Query Views of Domino data, as well as 
any DB2-based application access to Domino data. Query Views of non-Domino data do NOT require the 
DB2 Access server.

 1.	 (Domino administrator)Create a server ID for the DB2 Access server . 

2.	 (Domino administrator)Install the DB2 Access server on the server running DB2

 3.	 (Domino administrator) Enable the DB2 Access server. 

4.	 (Domino administrator) To verify that the DB2 Access server is installed and configured properly, 

use the Test DB2 Access feature from the Domino Administrator client.


 5. (DB2 administrator) Map the DB2 user name to a Notes user name 

Verify your installation 

Complete the AIX or Linux post-installation validation procedure. 

Domino Server 

Installing Domino and DB2 on Microsoft Windows platforms 
Installing Domino and DB 2 on Microsoft Windows platforms 
Complete this procedure to set up a new IBM Lotus Domino and DB2 environment on Microsoft 
Windows. This is not a procedure for upgrading an existing Domino and DB2 configuration. 

After you install the Domino 8 server and Domino 8 Administrator client (Step 1 below), open the Domino 
8 Administrator online help to see the detailed instructions for completing the steps in the procedure 
below. 

Setting up the Domino server environment for use with DB 2

 1.	 (Domino administrator)  Install and set up the Domino server and the Domino Administrator. 
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Installing and Setting up DB 2

 1.	 (MS Windows administrator)  Create an installation user account.  

2.	 (DB2 Administrator logged on with Installation user account) Install DB2 on Microsoft Windows.

 3. Restart the Domino server. 

Setting up the DB2 server environment

 1.	 (MS Windows administrator)  Create a DB2 administrator account.

 2.	 Determine whether you have a SYSCTRL group 

3.	 If your DB2 configuration has a SYSCTRL_GROUP, you can omit this step. If your DB2 does not 

have a SYSCTRL_GROUP, designate the DB2DOM group a system control group and add the

Domino super user to the system control group


Enabling the Domino server to communicate with the DB 2 server

 1.	 (Domino administrator) Enable the Domino server to communicate with the DB2 server.

 2.	 Grant the SETSESSIONUSER privilege to the Domino server user. 

(Optional) Setting up the DB 2 Access server 

Installing the DB2 Access server is optional. Determine whether you need to install it. The DB2 Access 
server is required for SQL access to Domino data which includes Query Views of Domino data, as well as 
any DB2-based application access to Domino data. Query Views of non-Domino data do NOT require the 
DB2 Access server.

 1.	 Create a server ID for the DB2 Access server. 

2.	 (Domino administrator) Install the DB2 Access server on the server running DB2.

 3.	 (Domino administrator)Enable the DB2 Access server.

 4.	 (Domino administrator)To verify that the DB2 Access server is installed and configured properly, 

use the Test DB2 Access feature from the Domino Administrator client.


 5.	 (Domino administrator) Restart the Domino server and the Domino Administrator.

 6.	 (Domino administrator)Map the DB2 user name to a Notes user name. 

Lotus Notes 

Installing Notes 8 using "su root" on Linux 
To install Lotus Notes in graphical mode, you may need to log into the Desktop as root, rather than run 
the install by switching to the root user using "su root".  The procedure to use "su root" and then install 
Lotus Notes 8 is as below: 

1. Launch a terminal window as a non-root user. 
2. Type xhost +. 
3. Open a terminal window. 
4. Type su root. 
5. Enter the root password. 
6. Execute the Lotus Notes 8 install instructions. 

If you are installing Notes 8 on the SLED 10 platform, you cannot use "su root" to change user privileges 
but rather must log in to the Desktop as root. 
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Lotus Notes 

Linux: Browse button does not appear in Directory panel 
The Directory panel's Browse button does not fully display during Lotus Notes 8 Beta installation on Linux. 
However, the area where it should display is functional. To install to a non-default directory, click near 
where the Browse button should display to invoke the Browse function. 

Domino Web Access 

New mail file template for Domino Web Access 
The mail template for Domino Web Access is MAIL8.NTF (Mail (R8). When registering users, choose the 
Domino Web Access mail system, and the MAIL8.NTF mail template. This template contains mail 
template support for the IBM Lotus Domino Web Access client and the Lotus Notes client. 

Previous beta releases included a DWA8.NTF template. This template is no longer shipped with Domino. 

Lotus Notes 

Notes 8 Beta installation directories 
On a Windows system in which no existing Lotus Notes 6.5.x or 7.x installation is detected, default 
installation directories are as follows: 

z	 C:\Program Files\IBM\Lotus\Notes -- Lotus Notes 8 product and binary files installation 
directory 

z	 Single user install data and and workspace directories: 

z	 C:\Program Files\IBM\Lotus\Notes\data -- Lotus Notes 8 single user data files 
installation directory 

z	 C:\Program Files\IBM\Lotus\Notes\data\workspace -- Lotus Notes 8 single user 
workspace directory 

z	 Multi-user install data and and workspace directories: 

z	 C:\Documents and Settings\<user>\Local Settings\Application Data\Lotus\Notes\Data 
-- Lotus Notes 8 multi-user data files installation directory for each user 

z	 C:\Documents and Settings\<user>\Local Settings\Application 
Data\Lotus\Notes\Data\workspace -- Lotus Notes 8 multi-user workspace directory 
for each user 

z	 C:\Program Files\IBM\Lotus\Notes\framework -- Lotus Notes 8 Java code installation 
directory 

On a Windows system in which an existing version 6.5.x or 7.x Notes installation is detected, default 
installation directories are as follows: 

z	 Notes 8 product and binary files installation directory -- Directory where the existing Lotus 
Notes 8 install binaries exist, for example C:\Lotus\Notes 

z	 Notes 8 data files installation directory -- Directory where the existing Lotus Notes 8 data files 
exist, for example C:\Lotus\Notes\data 

z	 Lotus Notes 8 Java code installation directory -- Subdirectory \framework of the Lotus Notes 8 
installation directory, for example C:\Lotus\Notes\framework 
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On a Linux system, default installation directories are as follows: 

z /opt/ibm/lotus/notes -- Lotus Notes 8 product and binary files installation directory 

z /{$HOME}/lotus/notes/data -- Lotus Notes 8 data files installation directory 

z /{$HOME}/lotus/notes/data/workspace -- Lotus Notes 8 workspace directory 

z  /opt/ibm/lotus/notes/framework -- Lotus Notes 8 Java code installation directory 

Lotus Notes 

Notes 8 does not support Notes downgrade 
Notes downgrade is not supported in Lotus Notes 8. The term downgrade refers to installing an older 
version when a newer version is currently installed. Lotus Notes downgrade is a consideration when 
installing beta releases of Lotus Notes 8 and will also be a consideration when future releases of Lotus 
Notes 8.x are made available. 

Lotus Notes, Domino Designer 

Notes 8 install customization 
The addToKit tool and the installation media kit compression script referenced in the Domino 
Administrator 8 help topic, "Customizing Notes installation using the install manifest" are not available in 
this Lotus Notes 8 Beta release. The remainder of that topic, which describes how to customize Lotus 
Notes 8 installation, remains true and valid for this Lotus Notes 8 Beta release. 

Also, when installing Lotus Notes 8 using the single user Allclient installation kit on Windows, Domino 
Designer and Domino Administrator follow the settings in the Notes 8 MSI file. The settings in the MSI file 
(which affect the Feature installation panel) override the settings in the Notes 8 install manifest file. To 
install Domino Designer and/or Domino Administrator, you must either select them for install using the 
Feature installation or specify them for silent install using the tuner. Tuner usage is described in the 
Domino Administrator 8 help topic, "Customizing client installations using the tuner". 

Lotus Notes 

Notes 8 installation panel may close unexpectedly on SLED  10 
When installing or uninstalling Lotus Notes 8 on a SLED 10 Linux client, an error message may appear 
during or at the end of the installation or uninstallation process as below: 

The application "Gnome-main-menu" has quit unexpectedly. You can inform ... 
or you can restart the application right now. 

If this error appears, click the Close option on the error message panel and you will be prompted to 
choose either Reload or Don't Reload from a second panel.  If you click "Reload" the main menu will be 
redisplayed. If you click"Don't Reload" the main Menu will not be redisplayed. 

Lotus Notes 

Notes 8 processes left open if Configuration wizard is cancelled 
If you cancel out of the Lotus Notes 8 client configuration wizard, some Notes processes may not close 
properly. To ensure that all Notes processes terminate, open a command window and change to the 
Notes program directory (default is Program Files\IBM\Lotus\Notes), and type the following: 

nsd -kill 
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Lotus Notes, Domino Designer 

Notes 8 .css overrides some Domino Designer mail properties

Lotus Notes 8 mail users can customize views and columns using Domino Designer to edit view and

column properties. However, some of these properties are controlled by the .css file (theme), thus some 

view and column property customization is overridden by .css.  Changing the following view and column

properties with Domino Designer will not affect their appearance in Lotus Notes 8 mail.


View Style property

Body - Rows

Body - Alternate rows

Body - Image

Body - Repeat

Grid - Style

Grid - Color

Header - Style

Header - Color

Header - Height

Rows - Spacing

Rows - Don't show empty categories

Rows - Colorize view icons

Rows - Unread color

Rows - Unread bold

Rows - Unread Transparent

Rows - Column total text

Other - Show selection margin

Other - Hide selection margin border

Margin - Top/Left/Bottom/Right

Margin - Below header

Margin - Color


View - Advanced property

Unread marks - Standard


Column - Font property

Font..

Size...

Style...

Text color...

Justification...

Reading direction...


Column - Title property

Reading direction


Lotus Notes 

Restart Notes 8 after replacing Mail template design 
You must restart Lotus Notes 8 Beta after replacing the Mail and Contacts template designs, which is one 
of the final steps required when initially installing Lotus Notes 8 Beta.  See the installation instructions for 
the specific steps used in replacing the Mail and Contacts templates. 
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Domino Server 

Running Domino 8 server installations on UNIX platforms 
Running the silent server script install on Linux 
To create a response file for automating the Domino installation, complete these steps: 

1.	 Create a local copy of the UNIX template unix_response.dat. 

2.	 Modify the copy so that it contains your server's specific program and data directory paths, user and 
group names and any other applicable install options. 

3.	 Use the following command to apply the modified response file and run the silent install: 

./install -silent -options file.dat 

Running a server install on Linux 

Enter this command 

./install 

./install -console 

Type of install 

Runs the server install on UNIX and displays a 
user interface during the install. 

Runs the server install on UNIX without a user 
interface. This install runs on a console. 

Domino Server 

Running the Domino server installer on RedHat platforms

To successfully install the Domino server in graphical mode on supported RedHat platforms,  install the

following RPM:

libXp-1.0.0-8.i386.rpm (or later)


(For example, rpm -ivh 

http://tortugas.notesdev.ibm.com/Kickstart/RHEL5_SERVER/disc2/Server/libXp-1.0.0-8.i386.rpm)


If you are using the 64-bit version of RedHat, also install :

libXp-1.0.0-8.x86_64.rpm (or later)


(For example, rpm -ivh 
http://tortugas.notesdev.ibm.com/Kickstart/RHEL5_SERVER_64/disc3/Server/libXp-1.0.0-8.x86_64.rpm) 

64-bit version of RedHat only 
You must install the following 32-bit library on your 64-bit RedHat server to run the Domino server installer 
in graphical mode: 
z libXmu 

To check the rpms you have installed ,  run: 
/bin/rpm -q -a


Lotus Notes 

Sametime option in Notes 8 install 
When installing Lotus Notes 8 Beta, the Sametime (integrated) option is not available for selection. Basic 
Sametime capabilities such as chat and livenames are automatically installed.  
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Lotus Notes 

Shared Node cannot install Multi -User through a transform 
Installing a Shared installation, and selecting a Multiple User Installation through a transform, is not 
supported.  This is also documented in the Install documentation. 

Lotus Notes 

Some messages do not appear in the Linux install log file 
Some messages do not appear in the install log file when running Lotus Notes 8 installation or 
uninstallation on a Linux client.  However, if you run Lotus Notes 8 in console mode, these messages are 
displayed. The types of messages being referred to are those described at the following Web address: 
http://support.installshield.com/kb/view.asp?articleid=Q111480 

These types of messages are shown only when Lotus Notes 8 installation or uninstallation is run in 
console mode. 

Domino for System i 

System i: Installing Domino 8 Beta 
In addition to the READ1ST.TXT file supplied with the Domino 8 beta Web kit, you can also refer to the 
Domino 7 for i5/OS HELP (Installing and Managing Guide) at the following URL for more detailed 
information on Domino installation and administration on i5/OS.  

http://www.ibm.com/developerworks/lotus/documentation/domino/  

Before installing the Domino 8 beta software, verify the following: 

z	 MANDATORY PTF 5722SS1 SI24683 OSP-THREADS-PERFM FASTER THREAD LOCAL 
STORAGE ACCESS METHOD must be applied. Without the PTF applied the product will install, but 
virtually all Domino-related functions (WRKDOMSVR, CFGDOMSVR, UPDDOMSVR, and anything 
that performs a NotesInit API call) will fail with messages that may refer to a missing export from 
service program QLEAWI.   

z	 You have a user profile with the required authorities to install and configure Domino. For more 

information about required authorities, see "i5/OS authorities required to install and configure

Domino" in the Domino 7 for i5/OS HELP. 


z	 You have installed the required hardware and software. For more information, see the Release Note 
System i software requirements . 

z	 Your operating system is IBM i5/OS V5R4.  If your operating system is not at the V5R4 level, you 

must upgrade it before installing Domino 8 beta.


z	 Any previous beta or pre-release versions of Domino 8 servers have been removed using

CFGDOMSVR SERVER(server-name) OPTION(*REMOVE) and the software has been removed

using DLTLICPGM LICPGM(5733LD8).


z	 TCP/IP is set up and active on your system. For more information about setting up TCP/IP, see the 
IBM eServer iSeries Information Center at the following Web address: 

http://www.ibm.com/eserver/iseries/infocenter 
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Domino for System i 

System i: Japanese system values required for install 
IBM recommends setting the following system values before installing Lotus Domino for System i on a 
System i Japanese edition (Language Feature 2962). Specifically, please verify that the system value for 
QCCSID is 5035 (the default system value for QCCSID is 65535).  

System Value Description Recommended Value 
QCCSID Coded character set identifier 5035 
QCHRID Graphic character set and code page 1172 1027 
QCNTRYID Country or region identifier JP 
QCURSYM Currency symbol Yen Mark 
QDATFMT Date format YMD 
QDATSEP Date separator 1 (/) 
QKBDTYPE Keyboard language character set JKB 
QLANGID Language identifier JPN 
QTIMSEP Time separator 1 (:) 

Domino for System i 

System i: Remove any Beta versions before installing 
Before installing Domino 8 software, you must remove any beta or pre-release versions.  To remove the 
beta or pre-release version, make sure that all Domino servers are stopped and no users are running any 
Domino CL commands (i.e., WRKDOMSVR).  Enter the following command to remove any beta or 
pre-release version of Domino 8: 

DLTLICPGM LICPGM(5733LD8)


Upgrade notes 

Lotus Notes 

Archive menu options moved from  'Tools' to 'Actions'

The "Archive" menu options have been moved in Notes 8 from the top level 'Tools' menu to the 'Actions' 

menu.


Domino Server 

Domino 8 upgrade issue on partitioned server 
When you upgrade to Domino 8 Beta 1, on existing partitioned servers, Domino as a Windows service is 
not added. The workaround is comprised of these steps: 

1.	 Uninstall the partitioned server. 

2.	 Reinstall the Domino 8 Beta 1partition server to the same Domino Program path and Domino Data 
paths as you used in the previous install. 
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Lotus Notes 

Mail Letterheads and upgrading from previous releases of Notes 
In Lotus Notes 8 Beta, the Mail Memo (and Reply) forms have a new 'look and feel'.  There are also a 
number of new and redesigned letterheads. In the next release, there will be more redesigned 
letterheads and some new ones as well.  
There are a few caveats pertaining to letterheads: 

1. Your old letterhead graphic is still part of the template; it will still display in the redesigned forms.  The 
old letterhead design is wider than the new designs, however, and the picture may appear truncated in 
the Memo header. The only workaround at this time is to choose a different letterhead via Preferences. 

2. If you save Preferences for any reason and had previously chosen a letterhead that is not included on 
the redesigned list above, the letterhead image that displays in the Memo form will change to the 
"Envelope" image. You will not be able to use your previously-chosen letterhead until a future release, 
and then only if it is on the list of those to be redesigned. 

3. If you choose to use one of the new letterheads, if the recipient of your e-mail is still using a mail 
template from a previous release, the letterhead area will appear blank. 

Lotus Notes, Domino Designer, Domino Server 

Notes/Domino 8 upgrade to JDK (Java Development Kit) 1.5 
IMPORTANT: The JavaCompilerTarget=1.5 INI setting is required to take advantage of new language 
features in JDK 1.5, but may reduce the backwards compatibility of agents . 

Syntax:   JavaCompilerTarget=1.5 

Example: JavaCompilerTarget=1.5 

Description: 

This release note refers to the Notes/Domino 8 upgrade to JDK (Java Development Kit) 1.5.  This 
upgrade enhances the Java language with new features, described below.  (Note: In the following 
text, we refer to JDK 1.5, which is also known as JDK 1.5.0 and JDK 5.0.) 

By default, Notes/Domino 8 utilizes JDK 1.5 to compile and run agents, but it limits language features 
to maintain backwards compatibility through JDK 1.2. 

Developers who wish to use JDK 1.5-specific features within their agents must override the default 
behavior. To override the default behavior, developers must specify the JavaCompilerTarget=1.5 INI 
setting. It is important to note that enabling 1.5-specific language features via this setting prevents 
compiled agents from running on Notes/Domino installations prior to 8.0 (and, more generally, JVMs 
prior to 1.5), regardless of whether the new language features are actually used in the agent's code. 
Enabling the JDK 1.5 language features via this INI setting therefore introduces the possibility of 
having an agent recompiled, replicated to a non-JDK-1.5 server, and then fail to run.  Additionally, 
problems can arise editing and saving agents compiled with JavaCompilerTarget=1.5 in 
Notes/Domino installations without the INI. 
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It is suggested that organizations use a consistent setting across machines.   Developers who will not 
be using JDK 1.5-specific language features are encouraged to keep the default Notes/Domino 
behavior as it will maximize backward compatibility. 

INI Setting Effects on Notes /Domino Agents 
z Notes/Domino will compile agents using the following compiler flags: javac 

No INI Setting -source 1.3 -target 1.2 
(default) z Agents will run on JREs from 1.2.x onward 

z The user loses the ability to compile with JDK 5.0 functionality (cannot create or 
edit any Java agent that uses JDK 5.0 features) 

z The user keeps backward compatibility (any agent that is created or edited during 
the session can still be still run on Domino 6.0 or later) 

z Notes/Domino will compile agents using javac -source 1.5 -target 1.5 
z Compiled agents can only be run with JDK 5.0 (Notes/Domino 8.0 and later). 

JavaCompiler 
Target=1.5 

z The user gains JDK 5.0 functionality with any agent created or edited during that 
session (such agents will run with new JDK 5.0 features) 

z The user loses backward compatibility with any agent created or edited during that 
session (such agents will not run on a server with any earlier Domino version, 
even if they don't use any 5.0 features) 

JDK 1.5 Language Features that Require  "JavaCompilerTarget=1.5":


The following JDK 1.5 agents will require the JavaCompilerTarget=1.5 INI setting to compile and run:


New Java 5 Language Features 
Generics 

Allows a type or method to operate on objects of various types while providing compile-time type safety. z 

Enhanced for Loops 

Facilitates iterating over collections and arrays. z 

Autoboxing/Unboxing 

Facilitates conversion between primitive types (such as int) and wrapper types (such as Integer). z 

Typesafe Enums 

Allows creation of enumerated types with arbitrary methods and fields. z 

Varargs 

Simplifies invoking methods that accept variable-length argument lists. z 

Static Import 

Lets you avoid qualifying static members with class names. z 

Annotations (Metadata) 

Allows tools to generate boilerplate code from annotations in the source code. z 
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Additional References : 

New Language Features in JDK  1.5 
http://java.sun.com/j2se/1.5.0/docs/guide/language/index.html 
http://java.sun.com/j2se/1.5.0/docs/relnotes/features.html 

Compatibility Notes Between JDK  1.5 and JDK 1.42 
http://java.sun.com/javase/technologies/compatibility.jsp 

More information on the use of  -source and -target with JDKs 
http://java.sun.com/j2se/1.5.0/docs/tooldocs/windows/javac.html 

Applies to:  Notes/Domino 8.0 

Default:  JavaCompilerTarget= 

UI equivalent:  None 

Lotus Notes, Domino Server 

Personal Address Book needs new design upgrade 
If you are upgrading to Notes/Domino 8 from a previous version, you must replace the design of your 
Personal Address Book with the Domino 8 pernames.ntf template.  This allows a Notes/Domino 8 user 
to take full advantage of new features in this area, notably "Edit Locations". 

Domino Server 

Rebuild system views in the Domino Directory after upgrading 
There are several views in the Domino Directory (NAMES.NSF) which use the Unicode standard 
collation, and which must be rebuilt immediately after upgrading to Domino 8.  The IBM Lotus Domino 
server knows the collation versions, and automatically rebuilds the view indexes when the server needs to 
use them. 

When the Domino server starts, it needs to access two important views, $Users and $ServerAccess.  The 
server stops and waits for these views to rebuild. If the Domino Directory is a large file, rebuilding the two 
views requires a substantial amount of time.  After upgrading to Domino 8, during the first server restart 
the server may stop while waiting for the views to rebuild.  During this time, the server console will display 
initial information regarding the Domino server. 

This process has been tested using a Domino Directory containing 17,000 users.  Rebuilding (reindexing) 
the views required approximately 40 minutes during the initial server restart after upgrade.  This test was 
performed on the platforms listed below. Note that the time requirements varied slightly by platform. 

z Microsoft Windows 2003 server 
z IBM AIX 
z Linux 
z i5/OS 

If you upgrade to Domino 8 and your Domino Directory contains 10,000 users or more, plan ahead for 
view updating.  You can use the UPDALL program to update the index offline, and then place it on the 
server.  On Microsoft Windows platforms, enter this command 

nupdall -r names.nsf 

For more information about using the UPDALL program, see the Domino Administrator 8 documentation. 
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Domino Web Access, Domino for System i 

Sametime customization saved to STLINKS .SAV on upgrade 
The Domino server's data directory <data dir>/domino/html/sametime/stlinks was added in 
releases 6.0.5/6.5.4, and also exists in Domino 7.x and 8.x, but did not exist in 6.5.3 and prior releases.  
This directory contains files that enable Sametime integration with Domino Web Access (DWA), and files 
in this directory may be customized to support tunneling.    

When a Domino server is upgraded, any files in the existing <data 
dir>/domino/html/sametime/stlinks directory are copied to a backup directory called <data 
dir>/domino/html/sametime/stlinks/stlinks.sav in order to save any potentially customized 
settings. The server upgrade process occurs: 

- during install for servers that are not multi-version capable (Domino 6.0.2 and earlier)  
- after install when the UPDDOMSVR command is run for a multi-version capable server (Domino 
6.0.3/6.5.0 and later) 

Files will only be copied to the stlinks.sav subdirectory during upgrade if the stlinks.sav directory is 
empty or does not exist. That is, if an install/upgrade occurs more than once for the same server, the copy 
of the files to stlinks.sav will only occur during the first install/upgrade.   

If you make additional customizations to the files in stlinks, be sure to either copy the new 
customizations to stlinks.sav or remove all files from stlinks.sav so that a subsequent 
install/upgrade will copy the latest files to the backup directory. 

Domino Server, Domino for System i 

System i: Autonomy Keyview filter upgrade 
Domino 8 for System i has been upgraded with version 9.2.4 of Autonomy's Keyview filter.  System i does 
not support the viewer. Refer to the release note "File formats supported" for details on the type of 
documents supported with version 9.2.4 of Autonomy's Keyview Filter.  

These file types are not supported for System i: 

z Lotus Word Pro (LWP) 

Domino for System i 

System i: Obsolete SametimeApplets directory 
The directory and contents of <notes data>/domino/SametimeApplets is obsolete, and is no longer 
shipped with the Domino product. 

On System i, the SAMETIMEAPPLETS directory is not created in the server's data directory when a new 
server is configured.  However, the directory remains, and is not deleted during the upgrade process 
(UPDDOMSVR CL command).  Customers may elect to remove the obsolete directory SametimeApplets 
from their existing server's data directory (<notes data>/domino/SametimeApplets). 
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Domino Server 

Upgrade to Domino 8 sets 1K console logging limit 
Upgrading the Domino server to Domino 8 sets the console logging limit to 1K.  The new default setting of 
1K was introduced to improve product serviceability.  Console logging is enabled with a 1K limit without 
user intervention or notification.  This will not occur if you already have an entry in the NOTES.INI file to 
enable, disable or change the console logging size.  

To change the default console logging limit to a value other than 1K, use one of the commands listed

below:


z Use one of these Notes.ini settings 

console_log_enabled=n 

console_log_max_kbytes=desired size 

For information about the Notes.ini settings, see the topic "NOTES.INI Settings" in the Domino 8 
Administrator Help documentation.     

z After stopping the console log, issue this server command 

start consolelog 

Domino Server 

Upgrading a DB2-enabled Domino server

If you have enabled your Domino servers to communicate with DB2, and you have DB2 enabled Notes 

databases, you cannot upgrade directly from Domino 7.x to Domino 8. You must first convert your DB2 

enabled Notes databases to Notes NSF databases. If you do not convert your databases, you will be

unable to access your data. Complete these steps:


1.	 Create NSF database replicas of the DB2-enabled Notes databases. Use the Create Replica tool in

the Domino Administrator.  Be sure to create the replica on a Domino server configured with NSF as

the default datastore.


2.	 Disable the Domino 7.x server. 
3.	 Upgrade to Domino 8. 
4.	 Run the server enablement tool to allow the Domino and DB2 server to communicate. 
5.	 Convert the NSF database replicas back to DB2-enabled Notes databases. 

After a DB2-enabled Domino server has been upgraded from 7.x to 8.0, it cannot be downgraded back to 
a 7.x version. 
When upgrading a DB2-enabled Domino server from 7.x to 8.0, DB2 Universal Database must be 
upgraded to version 9.1.0. 
Mixed Domino and DB2 versions are not supported, for example, Domino 7.x and DB2 9.1.0 are not 
supported together. Domino 8.0 and DB2 8.2.2 are not supported together. 

Lotus Notes 

Upgrading to the current Notes  8 Beta

When you upgrade from one Lotus Notes 8 Beta version to the next, you must uninstall the old Beta

before installing the new Beta. See the uninstall and install sections of these release notes for details.


If you are upgrading from a Lotus Notes version 6.5.x or 7.x on a Windows client, see the installation

section of these release notes for details on how to upgrade to Lotus Notes 8 Beta using the installation

program.
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Domino Designer 

Valid DAV fails with DB2-SQL or product limit exceeded 
Attempting to create/populate a DB2 Access View (DAV) from an existing DB2 database can fail with the 
following error message, although if you open the DAV, it will validate: 
DB2-SQL or Product limit exceeded. 

Databases on DB2-enabled servers and the data stored in DB2 will have their schema upgraded 
automatically when you upgrade to Lotus Notes 8, with a 32K bufferpool named DOMINO_TMP32, and a 
temporary tablespace named DOMINO_STMP32.  If the server fails to recognize that a schema upgrade 
is needed, this error occurs when a DAV using the new schema tries to get information from a DB2 
database using the old schema. 

To fix this error, either use a new DB2 database created with Notes 8, or manually update the schema of 
an existing DB2 database by issuing the following: 

CREATE BUFFERPOOL DOMINO_TMP32 size 5 pagesize 32K 

CREATE TEMPORARY TABLESPACE DOMINO_STMP32 PAGESIZE 32K MANAGED BY 
SYSTEM USING ('DOMINO_STMP32') EXTENTSIZE 16 PREFETCHSIZE 16
BUFFERPOOL DOMINO_TMP32 

where DOMINO is the master schema. 

Configuration notes 

Domino Server 

Configuring Domino and Portal Server federated administration 
You can administer an IBM Lotus Domino 8.0 server and an IBM WebSphere Portal Server 6.0 or 6.0.0.1 
from the Portal Server administration user interface (UI) on the same Portal Server.  In this configuration, 
the Domino Web Administrator UI is embedded in the Portal administration UI. To administer both server 
types from one Portal administration user interface, link the Domino Web Administrator client UI to the 
Portal administration UI. The Domino Web Administrator UI then displays with other portal-specific user 
interfaces. 

To implement this configuration, you must complete these procedures: 

1.	 If you have not already done so, download the Portal 6 Update Installer (PUI) tool. 

2.	 Patch your Portal Server 6.0 or 6.0.0.1 with the iFix. Apply this patch only once. If you are using Portal 
Server 6.0.1, you do not need to do this. 

3.	 After patching the Portal Server 6.0 or 6.0.0.1, run the access scripts to add Domino servers to the 
Portal administration user interface. You must run one access script for each server. 

4.	 Be sure to complete the procedure "Enabling the Portal server for Federated Administration." 

5.	 Clear your browser's cache file. 

The iFix consists of a .ZIP file which includes a .jar file and a readme.txt file. The .ZIP file is contained 
within the database WEBADMIN.NSF. 
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There are two XML Access scripts. One XML Access script adds a Domino server into the Portal

administration UI; one XML Access script removes a Domino server from the Portal administration UI. 

Each XML Access script is a single XML-based configuration file used as input for the Portal XML

configuration interface tool.


Run the XML Access script once for each Domino Web administration server to be integrated into or

removed from the Portal administration UI. For example, if two servers (ServerA and ServerB) should be 

integrated into the Portal Administration UI, point the browser to each of the two servers, obtain the

addfederation.xml file from each server, and then run each file against the Portal Server. The Portal

Administrator UI would then be configured to include the two Domino servers.


Prerequisite 

z	 A successful SSO configuration must exist between the Portal 6.0 or 6.0.0.1 Server and the 
Domino 8 server. 

Preparing the portal server

You need to perform this procedure only one time for the Portal Server 6 or 6.0.0.1.


1.	 If you have not already done so, download the Portal 6 Update Installer (PUI) tool. You can download 
the PUI from

 http://www.ibm.com/software/genservers/portal/support


2.	 Download the file iFix.zip from any Domino 8 server by pointing to this URL which triggers the 
download

 http://<dominoserver>/webadmin.nsf/iFix.zip 

Save the file, iFix.ZIP, locally on the Portal server. 

3. Unzip the file, and then install it. For information about installing the file, see the Portal Information 
Center at 
http://publib.boulder.ibm.com/infocenter/wpdoc/v510/index.jsp?topic=/com.ibm.wp.ent.doc/wpf/portalupdat 
einstaller.html 

4. 	 Access the directory <PortalServerRootDirectory>\config\ subdirectory, and then run this command: 

WPSconfig.bat init deploy-transformation-federation 
-DPortalAdminId=<wpsadminid> -DPortalAdminPwd=<wpsadminpwd> 

On Unix systems, use WPSConfig.sh instead of WPSConfig.bat. 

Setting up Domino and Portal Server Federated Administration 

1. From the Portal Server, download the configuration script from this URL 

 http://<dominoserver>/webadmin.nsf/addfederation.xml 

2. 	   Save the file locally on the Portal server. 

.Access the directory <PortalServerRootDirectory>\bin subdirectory, and then run this command: 

xmlaccess.bat -in c:\addfederation.xml -user <wpsadminid> -password 
<wpsadminpwd> -url localhost:10038/wps/config 

Port 10038 is the default port. If you configured the portal server to use a different port, specify the port 
number that you used when you configured the Portal Server. 

Note On UNIX systems, use xmlaccess.sh instead of xmlaccess.bat. 

4. 	 Log out and then log in. 
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Enabling the Portal Server for Federated Administration 

Perform these steps from the WebSphere Administration console. 

1.	 Select Resources. 

2.	 Select Resource Environment Providers. 

3.	 Select WP ConfigServer from the list of available resource environment providers. 

4.	 Select Custom Properties, and then click New. 

5.	 In the Name field, specify federation enabled. 

6.	 In the value field, specify true. 

7.	 Click Apply, and then save the changes. 

8.	 Restart the Portal server. 

Removing Domino and Portal Server Federated Administration 

1. From the Portal Server, download the configuration script from the URL 

 http://<dominoserver>/webadmin.nsf/removefederation.xml 

2. Save the XML file locally on the Portal Server. 

3. Access the directory <PortalServerRootDirectory>\bin subdirectory, and then run the following 
command: 

xmlaccess.bat -in c:\removefederation.xml -user <wpsadminid> -password 
<wpsadminpwd> -url localhost:10038/wps/config 

Note Port 10038 is the default port. If you configured the portal server to use a different port, specify 
the port number that you used when you configured the Portal Server. 

Note On UNIX systems, use xmlaccess.sh instead of xmlaccess.bat. 

4. Log out and then log in to see the changes. 

The "My Domino Servers" tab is not removed by default. To remove the entire Domino integration, 

complete these steps:


1.	 Remove all added servers. 
2.	 Log on to Portal. 
3.	 In the Portal User Interface section, select Launch --  Administration -- Manage Pages. 
4.	 In the portlet, select Content Root -- Domino Integration, and then click the delete item beside "My 

Domino Servers." 

Lotus Notes 

Enabling Notes 8 single sign-on for Windows 
When you install Lotus Notes 8 Beta you can optionally choose the "Client Single Logon Feature" Notes 
option. After installation is complete, you must restart the client machine in order for single logon to take 
effect. After client machine restart, when you restart Notes, a Notes Single Logon Password 
Synchronization panel appears. Click Yes and, as prompted, enter your Notes password and click OK.  A 
Change Password panel then appears prompting you to enter the new password and re-enter the new 
password for confirmation. In both password entry fields, enter your Windows system password and then 
click OK. The single logon feature will now be fully operational. 

Note that if you want to disable the Notes single login feature, click File > Security > User Security and 

disable the "Login to Notes using your operating system login" setting in the "Your Login and Password 

Settings" area of the Security panel. After disabling single sign-on, use your Windows password to log in 

to Notes.


82 



IBM Lotus Notes, Domino, Domino Designer 8	 Release Notes 

Lotus Notes, Domino Designer, Domino Server 

Specifying the home portal account using policy 
To specify an IBM WebSphere Portal server as the home portal account server for Notes 8 Beta, you can 
set the following values using the Lotus Domino Administrator client.  These settings affect fields on the 
Notes 8 Home Portal Account preference page. 

Complete the following fields on the Portal Server Basics tab for users who need to access portlets, for 
example, those using composite applications that contain portlets: 

Home Portal Server -- Type the name of the portal server that host Notes user accounts. 

Authentication URL -- Type the URL that Notes users need to access in order to authenticate with the 
portal server. 

Authentication type -- Choose either J2EE-Form or HTTP for Web-based authentication. 

Home Portal URL -- Specify the WebSphere Portal server URL. 

See the Domino Administrator help topic "Creating a security settings document" for additional 
information. 

Lotus Notes, Domino Designer, Domino Server 

Specifying the home portal account using preferences 
To use Lotus Notes 8 features that require a WebSphere Portal server, such as composite applications 
that contain portlets, users need a Home Portal account. The Home Portal account is a unique account 
that specifies the WebSphere Portal server to connect to for composite applications that require a 
WebSphere Portal server. The Domino administrator can set up a Home Portal account for users, 
however Lotus Notes 8 users can create and edit some elements of the account using the following 
procedure. 

After users have installed Lotus Notes 8 and prior to using composite applications that contain portlets (or 
other features that require a WebSphere Portal server), users need a Home Portal account. 

Considerations: 

z	 The IBM Lotus Domino administrator uses a security policy document (Portal Server Basics) to 
control the following fields: 

Portal server name

Authentication URL

Authentication type

Home Portal account URL


z	 See the "Specifying the Home Portal account using policy" release note for related information. 
The policy settings would override the account settings on the client Preferences page, and 
create the account if it did not already exist. If no policy is defined, then whatever the user enters 
in the Preferences page would be used. The Home Portal account is used by composite 
applications that contain portlets, however it can be used by any client application that needs to 
connect to the same Portal server. 

z	 The Portal server can be checked periodically for updates. 

z	 Home Portal account information is stored in the Contacts database. 

z	 Administrators should note that there is a similar preference page available when working in the 
Lotus Expeditor client, described in the Expeditor help at the following Web address: 
http://publib.boulder.ibm.com/infocenter/ledoc/v6r1/index.jsp?topic=/com.ibm.pvc.runtime.doc.us 
er/tasks/user_specifyingahomeportalpage.html 
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z	 If the Home Portal server specified is not available, an error message will appear when the 
periodic server update check occurs. 

z	 The standard portal URL is http://host:port/wps/myportal, where /wps is a standard portal context 
and /myportal is a standard personalized Home. 

Procedure: 

1. Click File > Preferences. 

2. Click Home Portal Account.

3. In the Name field, note the preset Home Portal Account value. 

4. In the Description field, type a descriptor, for example Home Portal Account. 

5. In the server Type field, note the preset value. 

6. In the Server field, type the Web address of your WebSphere Portal server, for example 
http://abx8.ibm.com/wps. 

Include the Portal context, for example /wps, when specifying the server URL, as shown below: 

http://abx8.lotus.com:10038/wps is a valid server URL.


http://abx8.lotus.com:10038/ is not a valid server URL.


7. In the User name and Password fields, type your WebSphere Portal user name and password. 

8. In the Home Portal URL field, type the WebSphere Portal server URL, for example 
http://abx8.lotus.com:10038/wps/myportal. 

Note: By default, this field is based on the value specified in the Server field above. For example, if 
you specify a Server value of http://abx:10038/wps, the Home Portal URL field would automatically be 
set to http://abx8.lotus.com:10038/wps/myportal. If your WebSphere Portal server is installed with a 
personalized Home other than the default "myportal", you must override the default value in the Home 
Portal URL field, for example http://abx8.lotus.com:10038/wps/myPortalSrv1. In this case, the 
Personalized Home of your portal is myPortalSrv1. 

9. In the Authentication type field, choose a type, such as the recommended PORTAL_FORM type. 

10. In the Authentication URL field, type the authenticating server URL, for example 

http://abx8.ibm.com/wps/j_security_check.


Note: The format for the authentication value is protocol://host/WpsContextRoot /j_security_check. 

Note: The default authentication URL is 
http://abx8.ibm.com/wps/portal/cxml/04_SD9ePMtCP1I800I_KydQvyHFUBADPmuQy. If the default 
home of your port is different than "portal" you must modify the authentication URL accordingly, for 
example for default home "bos", the authentication URL would be 
http://abx8.ibm.com/red/bos/cxml/04_SD9ePMtCP1I800I_KydQvyHFUBADPmuQy. 

11. Click OK.

Lotus Notes, Domino Designer, Domino Server 

Configuring component update for composite applications

Composite application update, supported by IBM Lotus Domino and IBM WebSphere Portal, is available

in this Beta release. Composite applications and associated Expeditor/Eclipse-based features can be

automatically updated when a user opens an application or by client auto-update running on a periodic

schedule. Composite applications can update composite application definitions. Certain Eclipse features

can be updated by provisioning.


A composite application definition can reference one or more Eclipse features as application

requirements. Each requirement can specify a particular update site from which it will be provisioned.
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You can use composite applications to install or update custom or third party features in Notes, as 

described here. You can also use the Eclipse update manager, if exposed in Notes, to install or update

custom or third party features in Notes. 


When an end-user opens a composite application or when a composite application auto-update operation 
occurs, if the application definition has changed, an update operation is run to provision both newly 
specified features as well as existing features with newer versions available. 

The feature requirement update site setting can specify a Domino server (or local nsf replica) or a Portal

server (or any HTTP server). Update site URL examples for each server are as follows:


z	 Domino server supports feature provisioning over the NRPC protocol 

z	 Domino server 

NRPC://<server-hint-or-host>/<replica-id>/site.xml -> 

NRPC://updates.ibm.com/__85257258006000A1/site.xml


z	 Local replica ID 

NRPC:///__85257258006000A1/site.xml 

Note the use of the double underscore and replica ID in the NRPC protocol. 

z	 Domino server optionally supports feature provisioning over the HTTP/HTTPS protocols 

HTTP://updates.ibm.com/updatesite.nsf/site.xml 

Eclipse update sites in conjunction with Domino NSFs allow for such usage scenarios as the 
following: 

z	 Host the updatesite.nsf on a Domino Web server. 

z	 Supply an updatesite.nsf to others, in which others can merge this updatesite.nsf into their 
own. 

z	 Supply individual features and plug-ins to others for their own use in their own composite 
applications. 

z	 Create custom features and plug-ins with the additional capability to create a new 
updatesite.nsf and import these features and plug-ins. 

z	 Eclipse update site server (HTTP server)  supports feature provisioning over the HTTP/HTTPS 
protocols 

HTTP://updates.ibm.com/updatesite/site.xml 

Domino Update Site NSFs 
Domino provides the capability to put an Eclipse update site inside an NSF database. An update site is 
typically a separate database that doesn't contain composite applications. However, since any Notes 
application NSF can contain a composite application, an update site NSF may contain a composite 
application.  For example, a third party could deliver a composite application and an update site, with the 
former pointing to the latter. Or an administrator could put the composite application in an update site NSF 
and make it available to users that way. You can define update sites in an update site NSF as described 
below. 
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Creating and preparing the updatesite.nsf 

1. Create an update site application, for example updatesite.nsf, using the File > Application> New menu 
sequence, using the Eclipse Update Site (8) template (updatesite.ntf) installed with the Domino 8 server.  

The updatesite.ntf template is installed with the Domino server. The update site application 
(updatesite.nsf) acts as an Eclipse-based update site hosted in an NSF Notes application on a Domino 
server. It dynamically provides the site.xml, features, and plug-ins.   

2. Open the update site application updatesite.nsf. 

3. Click the Import Local Update Site... action button. 

4. From the resultant explanatory dialog box, use the Browse button to navigate to the update site folder 
that contains the site.xml file that you want to import. 

5. Select the site.xml file. 

6. Click OK. 

An "Importing update site" progress bar appears. 

Editing a Composite Application's feature requirements update site URL

There are two methods you can use to edit a composite application's feature requirements update site

URL:


A. Recommended method: Using the Composite Applications Editor to specify an update site for feature

requirements


The preferred way to edit the update site URL for a feature requirement is through the use of the 
Composite Application Editor (CAE) as described in the following steps: 

1. In Notes 8 Beta, open the composite application. 
2. Click Actions > Edit Application... . The Composite Applications Editor (CAE) opens in a new window. 
3. From the resultant component list, right-click the desired component and select Edit Component

Properties.

4. Click Advanced. A list of properties appears. 
5. Select the property for the desired feature, for example url.Feature_NN, and click Edit.  


Alternatively, click Add and enter the name and the value.  

6. Click OK to exit Advanced. 
7. Click OK to exit the Properties pane. 
8. Click Done or the red X to close and save the changes.
9. The modified CA XML is re-read and processed. 

B. Alternate method: Configuring a composite application to specify an update site 

Use this process to define update sites for the contents of a particular composite application NSF. 

1. The administrator obtains a composite application NSF, for example MyCompAppabx.nsf. 

2. Accompanying the composite application NSF, the administrator obtains an update site folder, which 

contains a \features and \plugins subdirectory, as well as a site.xml file. The site.xml file lists features

contained within the update site folder.
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3. The administrator modifies the composite application's .xml to point to a specific Domino update site. 

a. Open a composite application, for example MyCompAppabx.nsf, in Domino Designer on the 
Domino server. 

As the application is opening, do not click Cancel. 


Accept any security screen prompts.


b. Click Composite Application > Application in the left pane navigator. 

c. Click the composite application name in the list and then click the Export tab.


This action outputs to an xml file of the same name, for example MyCompAppabx.xml.


Leave the composite application open.


d. Open the xml file created in the previous step. 

e. Modify each "url.feature" value to point to the needed Domino update site. For example, for each 
<preference namename="url.feature"> entry, where url.feature is the placeholder for the update site 
URL and the specific feature name, point to the needed Domino update site. 

The following format uses an NRPC protocol:


NRPC://<server>/__<replicationID>/site.xml 


The following format uses an HTTP protocol:


http://<server>/updatesite.nsf/site.xml


4. Save and close the xml file. 

5. In Domino Designer and within the open composite application, click the composite application name in 
the list, click the Refresh tab, and select the modified composite application .xml file. 

6. Open the update site application updatesite.nsf and import the site.xml file from the local update site 
folder that accompanies this composite application. 

A user can now open the composite application using a Notes database link, bookmark, or File > 
Application > Open (or Ctrl-O) on the server to initiate update. 

For information about controlling user-initiated updates, see the "Enabling user-initiated update" release 

note.


Retrieving composite application definitions  (CA XML) from Domino

The NRPC URL format for retrieving composite application updates is as below:


NRPC://<Server-hint-or-host>/<replica-id>/composite.xml?<param>=<value> 

Where: 
Server-hint-or-host = DNS host name, IP address, or server name 
Replica-id of the database on the target server 
Param = <name|unid> 
Name = String to be used to lookup CA design element in view -- Look up first as a name 

and if not found, then as an alias.

UNID = UNID of the composite application design note


For example: 
NRPC://abx_tc.upcdev.ibm.com/__8525634000734621/composite.xml?name=Hannover 
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WebSphere Portal and Composite Applications 
WebSphere Portal composite application update is made available to the Lotus Notes 8 user through the 
Home Portal Account setting in Lotus Notes 8, as determined by the Domino administrator. In addition, the 
administrator must also have installed the Lotus Notes 8 server client installer on the same WebSphere 
Portal server to which the user's Home Portal Account points. WebSphere Portal composite application 
update pertains most applicably to the Lotus Notes 8 user who is working with composite applications that 
contain portlets.  For related information see the Expeditor 6.1 information center at 
http://publib.boulder.ibm.com/infocenter/ledoc/v6r1/index.jsp -- look for updates at the 6.1.1 version 
information center as it becomes available. Also see the Domino Administrator help and release note 
topics, "Installing the Notes server client installer",  "Specifying the home portal account using policy" and 
"Specifying the home portal account using preferences" release notes. 

Related information and examples 
For information and examples describing how to create and deploy composite applications in the Notes 
context, such as composite applications tutorials, see the Domino Designer help supplied with this Beta 
and IBM developerWorks at http://www.ibm.com/developerworks, including the composite applications 
blog at http://www.ibm.com/developerworks/blogs/page/CompApps. For example, for information about 
NSF-based update sites, see 
http://www-03.ibm.com/developerworks/blogs/page/CompApps?entry=nsf_based_update_sites. 

You can use the following site map to find information about a specific topic: 

http://www.ibm.com/developerworks/blogs/page/CompApps?entry=blog_sitemap 

Domino Designer, Domino Server 

Enabling user-initiated update for Notes 8

You can enable users to manually initiate updates by setting a Domino policy as described below:


1.	 Using the Domino Administrator 8 client, open the Desktop policy settings document. 

2.	 On the Basics tab, locate the Provisioning section at the bottom of the document. 

3.	 In the "Allow user to do user initiated updates" field, click "Enable" to allow user-initiated updates 
or "Disable" to prevent user-initiated updates. 

This setting overrides any other setting applicable to user-initiated update that may reside in the

plugin_customization.ini file.


See the "Displaying the Eclipse Update Manager UI in Notes" and "Managed settings for Java 

preferences may not be updated" release notes for related information.


Lotus Notes 

Displaying the Eclipse Update Manager UI in Notes  8 
To allow users to install or update custom or third-party Eclipse features or plug-ins into the Lotus Notes 
runtime after Lotus Notes install, you can enable display of the Eclipse Update Manager user interface. By 
default, the Update Manager UI is not displayed. 

To expose the update manager in Lotus Notes, add the following line to the user's 

plugin_customization.ini file (<install_dir>\framework\rcp\plugin_customization.ini) and then restart Lotus 

Notes. 


com.ibm.notes.branding/enable.update.ui=true 

Once this line is resident, users can access the Update Manager UI from within Lotus Notes by clicking 

File > Application > Install.
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Note: The value specified in the plugin_customization.ini file acts as a default value when no policy has 
been set. If the Domino desktop policy specifies the user-initiated updates setting, the Domino policy 
setting overrides the plugin_customization.ini setting. 

Information about creating Eclipse features and plug-ins using the Eclipse Development Environment 
(IDE) and importing them into Lotus Notes can be found in the Lotus Expeditor information center 
( 
http://publib.boulder.ibm.com/infocenter/ledoc/v6r1/index.jsp?topic=/com.ibm.rcp.tools.doc.appdev/welco 
me.html) and at the IBM developerWorks site (http://www.ibm.com/developerworks/lotus/community). 

For information about installing custom or third-party Eclipse features, see "Enabling and using third-party 
feature installation and update" in the Domino 8 Administrator help supplied with this Beta release. 

Related information about installing custom Eclipse features and plug-ins using the Notes installer is 
available in the Domino 8 Administrator help in the "Customizing Notes installation of Eclipse features and 
plug-ins" topic. 

Information about using the Eclipse Update Manager is available in Lotus Notes help. 

Lotus Notes, Domino Designer, Domino Server 

Signing Eclipse plug-ins 
Once you have created and signed new Eclipse features and plug-ins, you can control the response to 
untrusted content during feature install and update using either Domino or Eclipse settings.  Domino 
policies override Eclipse preferences set in the plugin_customization.ini file. 

For information about Domino policy settings specific to signed plug-ins, see the Domino 8 Administrator 
help topic "Creating a security policy settings document". 

For information about signing custom and third party features and plug-ins, and controlling preferences 
using the plugin_customization.ini file, see the Domino 8 Administrator help topic "Signing custom or 
third-party Eclipse plug-ins for install and update". 

Domino Server 

Linux for System z configuration 
A detailed reference for the planning, installation, and configuration of Domino on Linux for  System z can 
be found in the Redbook "IBM Lotus Domino 6.5 for Linux on zSeries Implementation " found here: 

http://www.redbooks.ibm.com/abstracts/sg247021.html 

While written for an earlier Domino release, the planning considerations and task descriptions still apply to 
this release. 

Increasing the per-process filehandle limit 
By default, the Linux kernel limits the number of file descriptors that any one process can open; the 
default is 1024.  This limit includes socket file descriptors that are opened during basic client/server 
communications, therefore is too restrictive for the Domino process. Do not assume that having fewer 
than 1024 databases (or files) in the Domino data directory is an indicator of the maximum number of 
open file descriptors that Domino will require. In order to scale above "tens" of client connections, this 
default must be overridden by the Linux administrator. 
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The mechanism for overriding the default varies depending on how the Domino server is started.  There 
are 2 basic scenarios: 

1. Domino is started from a login session

For this case, the default must be overridden by modifying the file /etc/security/limits.conf AND 
insuring it is respected by the login.  Edit /etc/security/limits.conf using root and add or modify the 
lines: 

domsrvr soft nofile 20000 
domsrvr hard nofile 49152 

where "domsrvr" is an example of the user id that will run the Domino server. Specify the UNIX user 
name in the first column that is the owner of the notesdata directory specified during Domino 
installation. If more than one Domino partition exists on the same Linux for System z platform, repeat 
these lines for each user id.  The "soft" value specifies the new default file descriptor limit (ulimit -n), 
and the "hard" value specifies the maximum file descriptor limit that may be set by the user. 

For SLES 8 and SLES 9 
In order for these limits to be respected following logon, ensure the following line is in the appropriate 
pam.d login file: 

session required /lib/security/pam_limits.so 

For RHEL 4 
In order for these limits to be respected following logon, ensure the following line is in the appropriate 
pam.d login file: 

session required /lib64/security/pam_limits.so. 

For example, if ssh login is used, this line must appear in /etc/pam.d/sshd 
If telnet is used, this line must appear in /etc/pam.d/login 
If rlogin is used, this line must appear in /etc/pam.d/rlogin 

The user id must login after the above changes are made and saved. 

2. Domino is automatically started through  /etc/init.d 

The redbook "IBM Lotus Domino 6.5 for Linux on zSeries Implementation " discusses this procedure 
in detail (Chapter 9, Section "Automating Domino startup and shutdown").  It is worth noting, however, 
that /etc/security/limits.conf settings are NOT respected when Domino is automatically started by a 
/etc/init.d script. Therefore, a line such as the following MUST appear in the "start" section of such a 
script: 

ulimit -n 20000 

Warning: Always make /etc/security/limits.conf change ( 1. above) in addition to modification of the 
"start" script. Otherwise, on the occasion that Domino is started from a login session, the file 
descriptor limit will be inadequate. 
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Kernel values modified by Domino 
In addition to the above, other Linux kernel value changes are needed for large scale Domino 
environments. Unlike the per-process filehandle limit, which must be modified before logon of the Domino 
user id, these values can be modified by Domino itself.  At startup, a program named "tunekrnl" runs with 
root authority and sets these values in the /proc filesystem.  Once set, these /proc values will not change 
until Linux is (re)booted, at which time they revert to their default values.  The exception to this is 
"mapped_base", which is a process-local setting made at each Domino startup.  The "tunekrnl" log of 
/proc filesystem changes tends to vary from many (following a Linux boot) to few (subsequent Domino 
startups).  The kernel values modified by "tunekrnl" are: 

kernel parameter default value tunekrnl value description
 /proc/sys/fs/file-max  (as low as 8192)  131072 maximum number of 

system-wide file descriptors 
/proc/sys/kernel/sem  250 32000 32 128  250 256000 32 

1024
 shared semaphore allocation 
sizes and limits 

/proc/sys/kernel/shmmax  32 M  256 M  maximum shared-memory 
segment size

 /proc/sys/net/ipv4/tcp_fin_timeout  60  15 retransmission timer for a FIN 
(socket close) in seconds

 /proc/sys/net/ipv4/tcp_max_syn_backlog  1024  16384 maximum value of the listen() 
connection backlog

 /proc/sys/net/ipv4/tcp_tw_reuse  0  1 1 enables "time-wait 
assassination" allowing for 
rapid re-use of sockets

 /proc/sys/net/ipv4/ip_local_port_range  32768 61000  1024 65535 increases the range of port 
values available for connect()

 /proc/<pid>/mapped_base  1 Gigabyte  16 Megabytes "floor" address value above 
which memory allocations may 
occur on SLES 

Swap configuration for Linux for System z 
SLES8 (31-bit) supports up to 2 Gigabytes of memory; a Domino server supporting thousands of users 
will typically require more than 2 Gigabytes of memory, causing swapping to occur in this environment.  At 
least 1 Gigabyte should be allocated as a swap "disk", however actually swapping to disk (DASD) hinders 
performance.  One mechanism to keep swapping within system memory is XPRAM.  The following 
general steps are an example of the configuration of 1 Gigabyte of XPRAM for Linux for System z in a 
native environment: 

1.	 Configure at least 1 gigabyte extended memory from the hardware console.  Linux for System z will 
automatically detect that.  

2.	 Configure the xpram driver. 

3.	 The following Linux commands set swap space 1G from a 3G partition that was made into a file 
system and mounted off of the xpram_fs directory: 

insmod xpram devs=1 sizes=2000000

mkswap /dev/slram0

swapon /dev/slram
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4.	 Make sure the xpram swap has higher priority than other disk swap. 

5.	 Note that these settings will disappear on a reboot.  To keep them active, place these commands into 
/etc/init.d/boot.local 

64-bit native environments, such as SLES9 (64-bit), should be configured with more than 2 gigabytes of 
real memory rather than dedicating the memory resource to XPRAM.  In these environments, Linux swap 
should still be configured, however routine swapping is not expected and using disk for the swap region is 
acceptable. 

Domino Server 

CA key rollover not recommended in large organizations 
In Domino 8, administrators can assign a new set of public and private keys to a Domino certificate 
authority (CA), which are used to certify the keys of OUs, users and servers in that organization. The 
process of assigning new keys is known as key roll over, and is documented in the Domino Administration 
Help topic "Certificate authority key rollover." 

The CA key rollover feature has not been tested in Domino customer deployments, so its use is currently 
not recommended in these environments. Organizations that want to become familiar with the feature are 
encouraged to use the feature to roll over the keys of a test CA, and then test users in their environment. 

Domino for System i 

Choose the format of HTTP log files 
HTTP log files are written in EBCDIC format by default on the System i platform.  You can change the 
format of these files to ASCII by setting the following in the NOTES.INI file.  The setting will take effect the 
next time the server starts or when HTTP starts again (for example, "tell http quit" then "load http").  

HTTPLogFormatAscii=1


If HTTPLogFormatAscii is not present in the NOTES.INI file or if the setting is HTTPLogFormatAscii=0, 

then the HTTP log files will revert to their default EBCDIC format.


Domino Server 

Domino and DB2 - database A<database name>

This release note explains the database "A<database name>", for example, ADOMINO, that is created in

Domino and DB2 configurations that include a remote DB2 server.


If the DB2 server is remote, the computer on which the Domino server is installed must have at least the

DB2 Run-Time Client installed on it.


Note It could also have ESE installed. 

Example of a remote configuration

In this example there are two computers :  


z	 Computer A -- IBM AIX with the Domino server and the DB2 Run-Time Client installed.   
ls05.notesdev.ibm.com 
On computer A we are using a db2instance named: db2inst2 

z	 Computer B -- IBM AIX with the DB2 server ESE "the remote machine" installed on it.   
p5viper.notesdev.ibm.com 
On computer B we are using a db2instance  named:  db2inst5  (port 50003 ) 
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The environment of the user who starts the Domino server must have the NOTES.INI setting

DB2INSTANCE=db2inst2.

The Domino server is started with transaction logging enabled.


During server enablement, the Domino Administrator client creates a DB2 node on computer A, using the 

information supplied to the Domino Administrator client. 


DB2 nodename: nodeaa

Host name: p5viper.notesdev.ibm.com

Port number/ service name: 50003


At server startup, using the information supplied to the Domino Administrator client, the following occurs:  

The DB2 database is created on computer B as database: ADOMINO

The DB2 database is catalogued on computer A as database: DOMINO

DB2 database name is assigned: Domino


The name of the DB2 database created on the DB2 server is <the database name the user entered  
pre-pended with the letter A >   ADOMINO 

Manually cataloging the DB 2 database that the Domino server will use
 Complete these steps to ensure that the Domino server uses a db2node to get to the db2database.  

1.	 To catalog a node (this <node name> is in the Domino server's NOTES.INI setting 
DB2INSTANCE=nodename ), enter the following: 

z db2 catalog TCPIP node <node name>  remote <machine name> server  <port number> 
z db2 catalog tcpip node nodename remote machine.notesdev.ibm.com server 50001 

2.	 (Domino Administrator client ) Before restarting the DB2-enabled Domino server, run the DB2 
command: 

db2 list node directory
In the DB2INSTANCE db2inst2 on computer A, you will see the following information indicating that 
the DB2 node has been created:

 $ id

 uid=5102(db2inst2) ...

 $ db2 list node directory


 Node Directory


 Number of entries in the directory = 1

 Node 1 entry:


 Node name

Comment

Directory entry type

Protocol

Hostname

Service name


= NODEAA

= nodeAA

= LOCAL

= TCPIP

= p5viper.notesdev.ibm.com

= 50003


3. To catalog a database where the <database name> is in the Domino server's NOTES.INI setting 
DB2DATABASE=databasename, enter the following: 
z	 db2 catalog database <database name> as <loop back db alias name>  at node <loop back node 

name> authentication server 
z	 db2 catalog database adomino as Domino at node nodename authentication server 

93 



IBM Lotus Notes, Domino, Domino Designer 8	 Release Notes 

4. 	 The first time that you start the DB2-enabled Domino server, the following occurs: 
The database that is created on the remote DB2 server B  is named: ADOMINO 
The Domino startup process prepends the character A to the DB2 database name supplied to the 

Domino Administrator client 
The database is cataloged as DOMINO 

5. To verify that the DB2 database  ADOMINO was created, enter the following command: 
db2 list database directory

In the DB2INSTANCE db2inst5 on computer B, that is, the DB2 server, you will see this output 
indicating that the DB2 database ADOMINO was created: 

$ id

 uid=5105(db2inst5) ...

$ db2 list database directory


 System Database Directory


 Number of entries in the directory = 1


Database 1 entry:

 Database alias = ADOMINO
 Database name = ADOMINO
 Local database directory = /local1/db2inst5
 Database release level = b.00
 Comment =
 Directory entry type = Indirect
 Catalog database partition number  = 0
 Alternate server hostname =
 Alternate server port number = 

6. To verify that the DB2 database DOMINO was cataloged in the DB2INSTANCE db2inst2 on 
computer A, that is, the Domino server , enter this command: 

db2 list database directory
You will see the following output: 

$ id

uid=5102(db2inst2) ...


$ db2 list database directory


 System Database Directory


 Number of entries in the directory = 1


Database 1 entry:

 Database alias = DOMINO
 Database name = ADOMINO
 Node name = NODEAA
 Database release level = b.00
 Comment =
 Directory entry type = Remote
 Authentication = SERVER
 Catalog database partition number  = -1
 Alternate server hostname =
 Alternate server port number = 
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Domino Web Access 

DWA: Configuring the new Sametime buddy list

To configure the new Sametime buddy list:


On the DWA server 

z Turn on Java servlet support 

1. Open server doc and go to [Internet Protocols...] -> [Domino Web Engine] 

2. Select "Domino Servlet Manager" in the "Java servlet support" field. 

z Create a file named servlets.properties and put it in the server's data directory 

z Add the following content to the servlets.properties file: 
servlet.DWABuddyList.code=com.lotus.dwa.stbuddy.DWABuddyList 

z Be sure to restart the server after finishing the settings above 

On the Sametime server 

z Add the IP address of the DWA server to a setting document in stconfig.nsf on the Sametime server 

1. Open stconfig.nsf on the Sametime server 

2. Open "By Form" view and open the document called "CommunityConnectivity" 

3. Enter the IP address of the DWA server to "Community Trusted IPs" field 
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4. Restart the Sametime server 

Domino Server 

Error message displays setting up partitioned server

When you set up a partitioned server with the nserver command, an error message window with "You 

must specify a valid data directory" will pop up.  This pop-up, however, should be a Windows partition

selection option. 


Workaround

Directly load the Notes.INI pameter, for example, C:\Lotus\Domino\nserver.exe = 

C:\Lotus\Domino\data2\notes.ini


Lotus Notes, Domino Server 

Installing GNU debugger on Linux prior to running NSD 
You must install the GNU debugger on Linux systems running Domino servers to allow the NSD process 
to gather information related to system failures.  Install the gdb directory in usr/bin and then ensure that 
the Domino server ID has permission to execute /usr/bin/gdb.  Installing gdb allows NSD to capture call 
stacks from processes that are failing so that the problem can be examined and resolved.  If you do not 
install the GNU debugger prior to running NSD, then NSD will be unable to capture critical diagnostic 
information about Domino processes. 

96 



IBM Lotus Notes, Domino, Domino Designer 8	 Release Notes 

Domino for System i 

Java JVM property settings on a per Domino server basis 
A property in the NOTES.INI file can be used to specify JVM Properties for the Domino server. This 
property, JavaUserOptionsFile, specifies a text file which contains the properties to add to the JVM. This 
text file can be either ASCII or EBCDIC and have up to 256 properties specified. Each entry must be in 
the form of "property=value" and be on a separate line. 

Any property that can be set with the -D Java option is valid. Domino already provides a way of adjusting 
the stack sizes, etc. 

If Domino specifies a property, and that property is also specified in the JavaUserOptionsFile, the 
JavaUserOptionsFile value is used. For example, if Domino specifies the property "Foo=1", and the 
JavaUserOptionsFile specifies "Foo=2", the JVM is created with "Foo=2". 

Note There are currently 2 exceptions to this: java.class.path and java.library.path. Domino will link the 
values specified in the JavaUserOptionsFile to what Domino is already setting for these two properties. 

Multiple Domino servers can share the same options file. 

One use of this feature is easier enablement of Java applications that have native methods. In order for 
the System.load() or System.loadLibrary() to find the service program, that service program must be in the 
current path. In this case, the administrator would have to know what directories the Domino for iSeries 
code uses. With this change, the administrator can set the JavaUserOptionsFile in the NOTES.INI and in 
the referenced file specify "java.library.path=/QSYS.LIB/PGMAPP.LIB" where PGMAPP.LIB is the library 
containing the service program loaded by the java application. 

For example: 

In the server's NOTES.INI the following line is added: 

JavaUserOptionsFile=/PGMApp/JvmOptions.properties


The file "/PGMApp/JvmOptions.properties" could have the following: 

java.library.path=/QSYS.LIB/PGMAPP.LIB 


java.class.path=/PGMApp/bin/PGMApp.jar 


PGMApp.debug=0 


PGMApp.serverName=Server1


Domino Server 

NAB does not contain cross certificates for authentication 
Although cross certificates are created when you set up your first server, the Name and Address Book 
(NAB) does not contain cross certificates capable of authenticating you when you set up an additional 
server. 

Workaround 

1.	 Manually copy the names.nsf/admin4.nsf/server.id/ file and the cross certifier locally to the 
newly-installed server. 

2.	 Set up the additional server again. 
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Domino Server 

Server Fast Restart 
What is Server Fast Restart ? 
When a Domino outage occurs, Fast Restart allows a new Domino instance to start while NSD 
diagnostics are being run on the initial Domino server instance.  When diagnostics are completed the 
initial Domino server instance is automatically terminated.  In the current beta release, Server Fast 
Restart is only available on AIX and Solaris versions of the Domino server. 

How does Server Fast Restart  work? 
All files and connections in use by the initial Domino instance are closed but processes and shared 
memory remain active until NSD diagnostics are completed.   The new instance will be started by a 
Server Fast Restart process called faultmon. 

When the initial Domino instance fails it will send a message to a monitoring program called faultmon. 
faultmon receives the message over a named pipe, and restarts Domino.  faultmon has two options 
for restarting the new Domino instance; the default option is to start the new Domino instance in the 
background, while the second option allows the user to specify a script to start the new Domino instance. 

How to configure Server Fast Restart ? 
Server Fast Restart is an extension of Fault Recovery. To use this feature, Fault Recovery must already 
be enabled in the server document. Server Fast Restart will honor the NSD "Timeout is ignored but N 
crashes in M minutes" settings in the server document. 

1. To enable Server Fast Restart in the current beta release the following must be added to the Notes.INI 
file: 

SERVER_FAST_RESTART=1 
Debug_DisableOSFileLocks=1 

2. (Optional) To enable a script to start the new Domino instance, add the following to the Notes.INI file: 

SERVER_FAST_RESTART_SCRIPT=<path to script including script name> 

Following is a sample script which assumes you have xwindows installed and running: 

rome:carolynn{506}% more rapidstart
#!/usr/bin/csh -f
setenv DISPLAY rome:0.0 
/usr/dt/bin/dtterm -e /local1/M4/lotus/bin/server & 

You will need to modify the script to include the name of the host you are running xwindows on.  Also, as 
root on the system, you will need to run "xhost +" to allow the display of the new xterm to work correctly.  
Make sure you try the script to ensure it works before you continue with setup. Problems with running the 
script will be easier to track down if there is less going on at that time. 

3. Start faultmon in the Domino data directory: 

/opt/m4/lotus/bin/faultmon 

4. Start Domino as normal 
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Observations and known behaviors : 

1. AIX: The new server will generate ipc keys with a new and unique ID, while the failed server instance's 
ipc keys will also be around for NSD to use.  Once NSD is finished using the failed server instance's ipc 
keys, NSD will clean up the keys, as well as the processes. 

2. Solaris: The new server will generate new and unique files in /tmp to support the new Domino 
instance, specifically the files titled ".*please_do_not_remove". The failed server instance's files will 
be left for NSD to use.  Once NSD is finished using the failed server instance's files, NSD will clean up the 
files, as well as the processes. 

3. When using NSD with Server Fast Restart with Domino, it is necessary to use the -key option to 
specify which instance to collect information about.  Future releases will allow NSD to default to the 
current running instance. 

a. A quick way to determine the key for the current instance is to look for the last key generated in the 
technical support directory. From the Domino data directory: 

cd IBM_TECHNICAL_SUPPORT

ls -tla | head


b. To run NSD to collect data with an example key of FD9AA800, from the Domino data directory: 

/opt/m4/lotus/bin/nsd -key FD9AA800 

c. To run NSD to terminate Domino with an example key of FD9AA800, from the Domino data 
directory 

/opt/m4/lotus/bin/nsd -kill -key FD9AA800 

4. In the current beta release, Server Fast Restart does not work with a server ID with a password. 

5. To ensure satisfactory performance of the new Domino instance while NSD is collecting data, it is 
recommended to have double the amount of physical memory available.  Specifically, if the Domino 
instance uses up to 4 GB of physical memory, it is recommended that the new instance of Domino has 
access to an additional 4 GB of physical memory. 

Domino Server 

SSL Cryptographic Accelerators 
Starting with Notes/Domino 7, the SECManipulateSC API function can be used to push the server's RSA 
keypair from an SSL keyring file onto a cryptographic token that supports PKCS#11.  This will cause all 
private key operations involving the server key to be performed upon the token. This cryptographic token 
can be a traditional smartcard (which will result in terrible performance issues) or an SSL cryptographic 
accelerator that provides a PKCS#11 interface. 

The only cryptographic accelerator that has been tested is the Rainbow CryptoSwift eCommerce Server 
Accelerator PCI CS400 model 2.2.6a, using the PKCS#11 DLL installed to 
c:\WINNT\system32\Cryptoki22.dll with the PKCS11_NO_HWCHECK=1 NOTES.INI variable set. 

In the current beta release, the server's ID file must be smartcard-enabled in order for the PushKyrKey 
operation to succeed. 
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Here is some pseudocode to demonstrate the use of SECManipulateSC. As always, real code should 
check for and handle errors. 

error = SECManipulateSC (SC_manip_GetVersion, 
NULLSCMCTX,

 NULL,
 &Version,
 NULL); 

/* SC_manip_PushKyrKey was added in Version 5 of this interface. If Version is 
not at least 5, then that operation will fail. */ 

/* Initialize the PKCS#11 context.
*/
SCMCTX Context = NULLSCMCTX; 
error = SECManipulateSC (SC_manip_InitializeContext, 

&Context,

NULL, NULL, NULL);


/* Set up the server's ID file
*/
error = SECManipulateSC (SC_manip_EnterIDFile, 

&Context,
 NULL, 
&dwIDLen,
ServerIDPath); 

/* Unlock the smartcard
*/
error = SECManipulateSC (SC_manip_EnterPIN, 

&Context, 
NULL,
&dwPINLen, 
PIN); 

/* Note -- SC_manip_EnterPIN will use an external authentication path if it 
exists. If the token doesn't support a protected authentication path, 
SC_manip_EnterPIN will use the supplied PIN if one exists or generate a prompt
if a NULL or zero-length PIN was used. */ 

/* Smartcard-enable the server's ID file
*/
error = SECManipulateSC (SC_manip_SCEnableID, 

&Context, 
NULL,
&dwPwdLen,
ServerIDPwd); 

/* Push the keyring private key to the token
*/
if (Version >= 5) 
error = SECManipulateSC (SC_manip_PushKyrKey, 

&Context, 
NULL,
&dwKyrLen, 
KyrPath); 
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/* Alternately, starting in 7.02 and the current beta release, push the 
keyring
* private key and the corresponding X.509 certificate to the token
*/
if (Version >= 8) 
error = SECManipulateSC (SC_manip_PushKyrKeyAndCert, 

&Context, 
NULL,
&dwKyrLen, 
KyrPath); 

/* Clean up

*/

SECManipulateSC (SC_manip_TerminateContext,


   &Context, 

NULL, NULL, NULL);


Uninstallation information 

Lotus Notes, Domino Designer, Domino Server 

Uninstalling Notes 8 Beta on Windows 
You can uninstall Lotus Notes 8 from the Windows client using the following procedure: 

If you installed Lotus Notes 8 multi-user, you must log in as an administrative user to uninstall. When 
uninstalling a multi-user install, each user's Notes data directory and workspace are left intact to preserve 
data. 

Shut down the Lotus Notes 8 application before starting the uninstall procedure. 

1. Click Add/Remove Programs from the Control Panel. 

2. Locate and select IBM Lotus Notes 8 in the application list. For example, if you are uninstalling a Beta 
version, the listed application might be "IBM Lotus Notes 8 Beta 2". 

3. Click Remove. 

4. Respond to all prompts. 

Uninstall may take several minutes to complete. 

Lotus Notes 

Uninstalling Notes 8 Beta on Linux 
You can uninstall Lotus Notes 8 Beta from the Linux client using the following procedure: 

Each user's Notes data directory and workspace are left intact to preserve data. 

Shut down the Lotus Notes 8 application before starting the uninstall procedure. 

1. Log in as an administrative user. 

2. Navigate to <install path>/uninstaller.bin using a File Browser or shell terminal. 

3. Run the uninstaller.bin file by either double-clicking on the icon in the File Browser or executing 
./uninstaller.bin in a shell. 

Uninstall may take several minutes to complete. 
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Lotus Notes, Domino Designer 

Uninstalling Notes 8 Beta silently

You can uninstall Lotus Notes 8 Beta silently.


z Uninstall cannot complete if Notes is running during uninstall. 

z Each user's data directory and workspace will be left to preserve data. 

z Shut down the Lotus Notes 8 application before starting the uninstall procedure. 

z Run the uninstall as an administrative or root user. 

Windows

You can uninstall Lotus Notes 8 Beta silently from Windows.


1. Ensure that Lotus Notes 8 is not running. 

2. Open a command prompt window.

3. Change to the directory in which the installation package uninstaller resides or specify the full path to
the MSI file.


4. Run the uninstall command to silently uninstall Lotus Notes 8 -- sample syntax is shown below: 

msiexec /x "Lotus Notes 8.0.msi" /qn 

Linux

You can uninstall Lotus Notes 8 Beta silently from Linux. 


1. Ensure that Lotus Notes 8 is not running. 

2. Open a Linux shell. 

3. Change to the directory in which the uninstaller resides or specify the full path to the uninstaller. 

4. As the root user, run the following command to silently uninstall Lotus Notes 8: 

<install_dir>/uninstaller.bin -silent 

Lotus Notes 

Cleaning a previous Notes 8 Beta installation from your client 
If you experience a problem installing this IBM Lotus Notes 8 Beta 3 on a system on which a previous, or 
the current, beta have been installed, some troubleshooting suggestions are provided below. In all 
instances, be sure to uninstall any previous Beta version before installing or upgrading to this Lotus Notes 
8 Beta 3. Uninstall instructions are provided in the release notes supplied with each beta. If, after 
uninstalling your beta release, you continue to experience problems installing IBM Lotus Notes 8 Beta 3, 
use the manual cleanup instruction provided below. 

Note: If you attempted to install IBM Lotus Notes  8 Beta 3 before removing an earlier beta version , you

should first use the cleanup instructions for Beta  3, located at the bottom of this document and then use

the cleanup instructions for Beta  2 or earlier shown directly below this note . 


System on which a Lotus Notes 8 Beta 2 or earlier beta version was installed : 

If after uninstalling a Beta 2 or earlier beta version of IBM Lotus Notes 8, you experience an issue

installing this Beta 3 version, some troubleshooting suggestions are provided below. 
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Cleanup instructions for Windows -- Lotus Notes 8 Beta 2 or earlier: 

1. Delete the Lotus Notes 8 Beta <install path>\framework folder. 

2. Remove C:\Program Files\Common Files\InstallShield\Universal\ibm\notes8. 

Note: Subsequent installation may fail if you uninstalled the Lotus Notes 8 Beta, but temporary files 
were left in Program Files\Common Files\InstallShield\Universal\ibm\notes8. Symptoms are a 
relatively quick install, or a "null" error in the installation panels. To prevent this problem, be sure to 
uninstall Lotus Notes 8 and manually remove any files left in Program Files\Common 
Files\Universal\ibm\notes8. 

3. Remove the user workspace located in Documents and Settings\<user name>\IBM\RCP\<timestamp> 

if present.


Note: If multiple workspace folders are present, delete the most-recently created folder.  You can 
determine which folder was created most recently by clicking View > Details. 

4. Delete the following two registry keys, if they exist, using the Start > Programs > Run > regedit 

command sequence:


HKEY_LOCAL_MACHINE\SOFTWARE\Lotus\Notes

HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Lotus\Expeditor


Note: If the only folder inside HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Lotus is Expeditor, 

delete the Lotus folder.


Cleanup instructions for Linux -- Lotus Notes 8 Beta 2 or earlier: 

1. Remove the Lotus Notes 8 Beta<install path>/framework folder. 

2. Remove /home/<user name>/InstallShield unless you have installed other programs on your system

with Macrovision InstallShield.


3. Remove /home/<user name>/IBM. 

4. Remove /home/<user name>/install.log if present. 

5. Remove the contents of /tmp that are owned by <user name>. 

6. Remove /home/<user name>/install.xml if present. 

7. Remove /home/<user name>/tmp_notes_args.properties if present. 

8. Remove  /home/<user name>/notes. 

9. Update the following hidden files: 

Note: To view these hidden files in File Browser, click View > Show Hidden Files and scroll down the 
list until you find the them. 

z Remove  /home/<user name>/.notesrc. 

z Restore /home/<user name>/.profile by removing Notes references from any variables. 

z Restore /home/<user name>/.bash_profile by removing Notes references from any variables. 
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System on which a Lotus Notes 8 Beta 3 version was installed :


If after uninstalling a Beta 3 version of IBM Lotus Notes 8, you experience an issue re-installing, some 

troubleshooting suggestions are provided below. 


Cleanup instructions for Windows -- Lotus Notes 8 Beta 3:


 1. Delete the Lotus Notes <install path>\framework folder. 

2. Delete the following two registry keys, if they exist, using the Start > Programs > Run > regedit 

command sequence:


HKEY_LOCAL_MACHINE\SOFTWARE\Lotus\Notes


HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Lotus\Expeditor 

Note  If the only folder inside HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Lotus is Expeditor, 
delete the Lotus folder.

 3. If Notes appears in your Add/Remove Program panel, run the Windows installer cleanup utility located
at http://support.microsoft.com/default.aspx?scid=kb;en-us;290301. 

Cleanup instructions for Linux -- Lotus Notes 8 Beta 3: 
As root user: 

1. Remove  <install path>/install.log (and any other log files left over in that directory). 

2. Remove<install path>/framework. 

3. Remove /root/InstallShield (unless you have installed other programs on your system with 
InstallShield). 

4. Remove /root/lotus. 

5. Remove /root/install.log if present. 

6. Remove /root/install.xml if present. 

7. Remove /etc/lotus/notes if present. 

As non-root user: 

1. 	Remove /home/<user name>/lotus. 

2. Remove /home/<user name>/InternalProvisioning.log. 

3. Remove the contents of /tmp owned by <user name>. 

Lotus Notes 

Cannot uninstall Notes 8 on Linux using application browser 
You cannot uninstall Lotus Notes 8 Beta from a Linux client using the right-click menu in the Application 
Browser. 

1.	 Click Computer\More Applications. 

2.	 Right-click "Lotus Notes 8 Beta" in New Applications. 

3.	 Click Uninstall. 

This action yields no response. 

See the "Uninstalling Notes 8 Beta on Linux" release note for information about uninstalling Lotus Notes 8 
Beta from a Linux client. 
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Lotus Notes 

Ending the Notes 8 uninstall process before completion 
If you end the Lotus Notes 8 Beta uninstall program prematurely, you may be prompted to navigate 
though various error messages, then be prompted to restart your system.  After restart, rollback begins.  
When rollback is complete, some files and empty folders may remain in your installation directory. To 
avoid this complication, be sure to let the uninstall program run to completion. 

Lotus Notes 

Repair not supported for Eclipse-based features and shortcuts 
For Lotus Notes 8 shortcuts, including the IBM Lotus Productivity Tools, and for installed features resident 
in the <install_dir>\framework folder, the traditional Windows Repair utility, obtained using Add/Remove 
Programs > Change, is not functional.  Running the Repair utility can leave the Lotus Notes 8 installation 
in a bad state and should be avoided.  If you inadvertently run the utility and then encounter problems 
uninstalling or reinstalling Lotus Notes 8, see the "Cleaning a previous Notes 8 Beta installation from your 
client" release note for related information. 

Lotus Notes 

Uninstalling if Notes 8 path contains a space 

The Lotus Notes 8 uninstaller will not run if the installation path contains a space. If you find yourself in 
this situation, see the "Uninstalling Notes 8 Beta" release notes for manual uninstall steps. 
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Known limitations, problems, and workarounds


Limitations 

Browser issues 

Lotus Notes 

Vista: Web browser does not support applet if UAC is disabled 
On Windows Vista, if the User Account Control (UAC) is turned off by the user, the Notes client web 
browser will not support running applets within web pages. 

Client issues 

Lotus Notes 

Features not available in "basic" configuration of Notes 8 
A "basic" configuration of Notes 8 is available for cases in which the client machine's memory is too low to 
run the standard configuration. As in previous releases of Notes, clients running this basic configuration 
can access only applications that reside on Domino servers, and can use only the 3.x implementation of 
embedded Sametime Contacts. 

The following Notes 8 features are not available when you install the basic configuration: 

User Interface 

z	 Access to the Notes Getting Started Page using Help -> Getting Started Page from the main 
menu. 

z	 Sidebar to provide access and mini-views of Sametime Instant Contacts, Feed Reader, Calendar 
and Activities 

z	 Consolidated user preferences 

z	 Choice of preview pane location, below list or beside list. 

z	 "Open" button to open applications. 

z	 Ability to set how Window tabs display in user preferences. 

z	 Embedded Web browser, with the option to set default to your chosen browser. 

z	 Easier methods to find and work with Location documents. 

z	 New user interface for Help that lets you keep the Help pane open as you work. 
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Mail 

z	 Improved choices for "Reply to All," "Include History," and "Include Attachments." 

z	 Thread layout display when applying to a mail thread. 

z	 The ability to right-click operations for an entire mail thread, such as deleting a thread or moving a 
thread to a folder. 

z	 The ability to perform operations for an entire mail thread, such as deleting a thread, or moving a 
thread to a folder. 

z	 Within the Inbox, the ability to see all related messages in a thread. 

Contacts 

z	 Recent Contacts view that shows users with whom you have recently interacted, such as e-mail 
correspondence or chats. 

Search 

z	 New centralized search interface for queries and results (Domain Search, Find People, Find 
Application, Web/Intranet Searches available as search scopes). 

z	 New Search capability for Help that searches across all "books" in the help system, such as Lotus 
Notes Help and Activities Help. 

z	 Optional Desktop Search that can be launched by right-clicking Live names, and is also available 
in the Search scope drop-down menu. 

Composite applications 

z	 Composite applications that make it convenient for a user to access a collections of components 
(applications) to address a business need for a particular group of users. 

Other 

z	 The Home Page includes buttons for the IBM Lotus Productivity tools (Documents, Spreadsheets, 
Presentations), however, these tools are not included with the basic configuration of Notes, and 
the buttons are not active. To use these tools, you must install the standard configuration. 

z	 Ability to view collaboration history with another user, such as e-mail correspondence, saved chat 
transcripts, or shared documents. 

Lotus Notes 

Japanese JIS2004 characters may not display properly on Win XP 
Japanese JIS2004 characters may not display properly in Lotus Notes 8 running on Windows XP, unless 
you do the following: 

To enable JIS2004 support on Windows XP, do the following: 

1. Install the language support for Japanese on any non-Japanese  version of Windows. 

2. Click Start > Control Panel > Regional and Language Options. 

3. On the Languages tab, check the "Install files for East Asian languages" check box. 

4. Install the JIS2004 support package from http://support.microsoft.com/kb/jp927489/ 
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To enable JIS2004 font linking, do the following: 

1.	 Click Start > Run. 

2.	 In the "Run" text box, type regedt32 to open the registry. 

3.	 Navigate to [HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\FontLink\SystemLink]. 

4.	 Double-click on the "Tahoma" key in the right panel. 

5.	 Add "msgoth04.ttc,MS PGothic", in a new line, in the edit box. 

6.	 Double-click on the "Arial" key in the right panel. 

7.	 Add "msgoth04.ttc,MS PGothic", in a new line, in the edit box. 

8.	 Click OK to restart the computer. 

Font linking provides the ability to render non-Latin characters when the font set by the application does 
not support those particular characters. It is suitable when an application cannot use a single font to 
render all the required characters. 

Note: If you use the Registry Editor incorrectly, you can cause serious problems that may require you to 
reinstall your operating system. Use the Registry Editor at your own risk. 

To enable the JIS2004 dialog font, do the following: 

1.	 Right click in the desktop and click Properties. 

2.	 Click the Appearance tab on the Display Properties dialog. 

3.	 Click Advanced. 

4.	 Select Message Box in the "Item" menu on the Advance Appearance dialog, then select "MS PGothic" 
in the "Font" menu. 

5.	 Click OK on the Advanced Appearance dialog. 

6.	 Click OK on the Display Properties dialog. 

On Windows XP, certain combination sequences of Japanese characters are not correctly rendered by 
Notes in its standard configuration, even though they are rendered correctly by Notes in its basic 
configuration.  Also, some of the characters newly-added to the JIS2004 standard may not be properly 
rendered by the Notes client in its standard configuration. 

Lotus Notes 

Log and Trace dialog box shows Log Settings only 
The "Trace Settings" section of the "Log and Trace" dialog is not in place, and displays only a "Log 
Settings" section.  This issue is expected to be addressed in a future release. 
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Composite Applications issues 

Domino Designer 

Composite Application Editor saves application with no changes 
The Composite Application Editor saves an application when nothing has changed.  There currently is no 
workaround, so care must be given when multiple users are editing an application on a Domino server. 

Lotus Notes, Domino Designer 

Composite applications only open in Notes client 
A composite application can only be opened in the Notes client.  In that case, the CA.XML that defines the 
application is read and any additional features are then provisioned. 

When a composite application is opened in the Domino Designer client, the CA.XML is NOT read, and 
provisioning does not occur. 

Domino Designer 

Errors occur using merged WSDL files in composite applications 
There are known problems with composite applications that contain multiple WSDLs in the same NSF 
component. It is recommended, therefore, that you do not use more than one WSDL in a single NSF. 

Domino Designer 

Errors occur when adding local components 
Errors may occur when adding local components (for example, Lotus Productivity Editors) to composite 
applications from the Composite Application Editor Component Palette.  This occurs because not all local 
components are currently supported. 

Domino Designer 

No "locking" occurs when editing NSFs simultaneously 
In cases where two or more users are editing an application on a Domino server using the Composite 
Application Editor, only the changes of the first user that saves are actually saved.  There is no "locking" 
of applications in Domino as there is in WebSphere Portal. 

Domino Designer 

NSF components in composite application not visible in a browser 
NSF components in composite applications are not visible when you view your application with a browser.  
In the previous beta release , you could configure the component on Portal using DAP to display the NSF 
component. This feature has been disabled for this release. 

When using the Composite Application Editor, you should use the Domino Application Portlet when calling 
NSFCompGen for NSF components to be visible. 
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Domino Designer 

Only one page is made available in Launch tab 
In multi-page composite applications with child pages, only one page is made available for selection in the 
Page field drop-down box of the Database Infobox Launch tab.  As a result, child pages cannot be opened 
directly when opening the database, because they do not show up in the Page field of the Launch tab of 
the Database Infobox. 

Domino Designer 

References to obsolete tools appear in Designer documentation 
While using the Domino Designer Help, you may find references to the "WSDL" and "NSFCOMPGEN" 
tools appear in the documentation and in Search lists.  These tools are obsolete and any references to 
them should be ignored. 

Domino Designer 

Stacked folder tab names display as  "Untitled"

When restarting Notes with an open composite application, stacked folder tab names in the composite

application may redisplay as "Untitled" even if they have an existing title.  There is no current workaround.


Domino Designer 

Timing problems occur with page transitions and properties 
Timing problems occur with page transitions in combination with publishing properties onPageOpen using 
multiple pages.  Abnormal page switching may occur when you fire multiple properties on multiple pages. 

Domino Designer 

Wire does not fire in composite application 
While creating a composite application, for example, that has two views which are tabbed, a component 
wire may not fire.  To be more specific, by changing which view/tab is on top, the next selection in the 
main view on the left will not fire the component wire.  There is no workaround. 

DB2 issues 

Domino Server 

DB2: Update systems account password limitation 
If you have a remote DB2  configuration on a Microsoft Windows platform, IBM AIX platform, or Linux 
platform, and the DB2 instance is on a Linux server, the Update System Account password checkbox is 
active on the Edit ID DB2 Username/Password dialog box.  The feature is not supported in this 
configuration - if you click the check box, the following message appears: 

UNSUPPORTED FUNCTION: Change password function is not supported by the

system
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Lotus Notes, Domino Server 

Domino and DB2 - DB2 Access Views 
SQL inserts, updates, and deletes against a DB2 Access View should only be performed by one user at a 
time. Multiple users interacting with the data in one DB2 Access View at one time can cause the Domino 
server to crash. 

Domino Server 

Domino and DB2 - server enablement 
To successfully create the original DB2 database during this process of enabling the Domino server to 
communicate with the DB2 server, you must be logged on to the Domino server with a user name that 
meets this criteria: 

z	 You must be logged on to the Domino server with the user name of the owner of the Domino 
server 

z	 The user name must be in the SYSADM group 

z	 The user name must meet DB2 naming conventions for the platform on which you are running the 
Domino server. For information about the DB2 naming conventions, go to the DB2 Information 
Center at: 

http://publib.boulder.ibm.com/infocenter/db2help/index.jsp. 

Domino Domain Monitoring issues 

Domino for System i 

DDM memory probe on i5/OS reports 2x usage for Java agent 
Due to platform differences, a Java agent on System i will be reported as using about 2x the CPU as on 
other platforms. 

Domino Server 

Do not create, modify, or delete any DDM Filter documents 
If you create, modify or delete any DDM Filter documents, the event task may hang. 

IBM Lotus Productivity Tools issues 

Lotus Notes 

Forms are not saved correctly in  .PPT files

If an IBM Lotus Productivity Tools document that contains forms is saved as a Microsoft PowerPoint (.ppt) 

file and reopened, the forms in it will be showed as rectangular frames.
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Lotus Notes 

Presentation tables cannot be displayed in OpenOffice  2.0 
A presentation table cannot be displayed by OpenOffice 2.0 if the file has previously been opened and 
saved by IBM Lotus Presentations. 

Lotus Notes 

Save unsupported document type may cause data loss 
Unsupported document types can be opened by alternating their extensions, but this can cause data loss 
when the file is saved back. 

For example, changing a .HTML file into a .SXW file and opening may result in the document content 
being lost when subsequently saving the file. 

Lotus Notes 

Table height in .PPT files enlarged if blank cells 
When using Lotus Presentations to display a .PPT file containing a table, if the table has blank cells it will 
be displayed incorrectly; the table height will be extended. 

Lotus Notes 

Table in Notes cannot be copied to Presentation 
Selecting and copying a table in Notes, then pasting it into the Productivity Tools Presentation editor will 
result in only the text in the table to remain. 

Lotus Notes 

User cannot Undo if a document is not completely loaded 
The "Undo" command does not work when a document is still loading (for example, the page number in 
the status bar keeps on increasing), until that loading is finished. 

Lotus Notes 

"Reversing Path Direction" not supported for animation effect 
"Reversing Path Direction" is an attribute for "Motion Paths" animation effects in Microsoft PowerPoint.  
This attribute is not supported in Lotus Presentations; there will be no animation effect if this attribute is 
set to 'True'. 

Installation issues 

Lotus Notes 

Redundant icon is left in "Add or Remove Programs " using SURunAs 
A redundant icon is left in the "Add or Remove Programs" list when Smart Upgrade RunAs is run by a 
non-Administrator with installation privileges. 
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Mail issues 

Lotus Notes 

Cannot display Categorized Inbox in Notes 
If a mail template has the 'Pick Inbox Style' agent run, it will create an Inbox with some default categorized 
views. If you then replace the design of your mail application while a column is sorted, after the replacing 
the design, it will not create categorized views, and may have other column display problems. 

Notes client on Linux issues 

Lotus Notes 

IBM Support Assistant limitation 
Running the IBM Support Assistant may cause the Notes client to quit unexpectedly or crash when 
running on SLED10. 

Lotus Notes 

URL links do not work on the Getting Started page 
The Getting Started page has two URL links - to a Notes 8 Web site and a Notes 8 Beta Web site.  These 
URL links do not work running Notes on SLED10. 

Notes 8 link - http://www-142.ibm.com/software/sw-lotus/products/product4.nsf/wdocs/hannover 

Notes 8 Beta link - 
https://www14.software.ibm.com/webapp/iwm/web/preLogin.do?lang=en_US&source=swerplotus 

This is an Eclipse issue which is expected to be resolved in the next beta release. 

Policy issues 

Lotus Notes 

'Enable Plugins in Notes Browser ' cannot be disabled via policy

The option 'Enable Plugins in Notes Browser', under User Preferences - Basics - Additional options, 

cannot be disabled via a desktop policy.


Lotus Notes 

Dialing rules not locking down via Desktop policies 
The following dial up fields on the location document are not under policy control: 

z Country code 

z Area code 

z Phone number 
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Lotus Notes 

How-to-apply settings not applied to some Desktop settings 
The following User Preferences fields on the Notes client Basic tab are not under "How to apply" control 
via Desktop policies: 

z Enable Java Script error dialog 

z Show in-line MIME images as attachments 

z When text language is unspecified, use the forms 

z Invoke Notes on vCard files 

z Enable persistent breakpoints in LotusScript debugger 

z Do not prompt when forwarding a document with edited attachments 

Lotus Notes 

Replication box not consuming configured values via policies 
The Schedule - Replication schedule dialog box on the Replicator page will not lock down when the 
replication tab on a Desktop policy is configured to "Set and prevent changes".  Configured Replication 
schedule fields will not be consumed on the client. 

Server issues 

Domino Server 

Linux for System z: Restrictions 
Following are the restrictions for Domino on Linux for System z 

SLES 10 and RHEL 5:  

z SNMP Agent capability is not supported by Domino on Linux for System z at this time. 

Lotus Notes, Domino Server 

Application Preference - Database Design Compression 
The Database Design Compression feature on the Advanced tab of the Database Properties dialog box is 
available for Microsoft Windows platforms only. 

Domino for System z 

Domino for Linux on System z jconsole program limitation 
The following is a list of Domino Console restrictions for Domino on Linux for System z: 

1.	 The jconsole command may be run from a Linux for System z system by setting the DISPLAY 
environment variable to point to a workstation running the XWindows server. 
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Domino Server 

NETBIOS over TCP/IP not supported on Windows 2003 x64 
NETBIOS over TCP/IP does not work on Microsoft Windows 2003 x64 Edition (64-bit) servers.  If you 
enable a Domino NETBIOS port, the server will crash. 

Domino for System i 

System i: Features not available with Domino 8 
The following features are not available with the Domino 8 Beta release on System i: 

z	 Domino DB2 datastore (NSFDB2) and related Query View and Domino Access View capabilities. 

z	 Integration and forwarding events to the Tivoli Enterprise console 

z	 The feature Fault Recovery restart in less than  30 seconds with Full NSD is not implemented for 
System i and Domino 8 beta. 

z	 Domino 8 does not support the batch installation feature using the LODRUN command with 
physical media.  The OS400/INTLENG/BATCH directory files were removed from the CD when 
the Domino product grew to require a second CD for installation. 

z	 iSeries Cluster Enabled Domino is not available. For more information on System i High

Availability (HA); see http://www.ibm.com/eserver/iseries/ha/


z	 xSP hosting has been removed. If the CFGDOMSVR or CHGDOMSVR commands specify 
XSP(*YES), the setting is ignored. 

z	 SNMP Agent is not supported. 

z	 IPV6 support with i5/OS V5R4 is available but limited.  With Domino 8 beta you can configure a 
Domino server to communicate using IPV6, but the following functions are not supported with 
IPV6 and i5/OS V5R4 and still require an IPV4 connection: 

z	 iSeries Navigator and iSeries Navigator Tasks on the Web  (requires an IPV4 connection so 
System i) 

z	 Java applications (including Java console) 
z	 HTTP (Apache) Plugin 
z	 FTP 

You can configure a Domino server to communicate using IPV6 using the CFGDOMSVR CL 
command or configuration wizard (domwzd.jar). 

Domino for System i 

System i: Java Console limitations 
Following are the System i Java Console limitations for Domino 8: 

Ending a server from the Java Console 
To End the Domino server from the Java console issue either of the following commands:  
z	 QUIT 
z	 RESTART SERVER 

The following Java Console options are not supported to end i5/OS Domino server:  
z	 Menu: File->Stop Server 
z	 con kill domino 
z con restart domino 

If you issue any of these commands, the WRKDOMSVR panel will show that the server is in an 
*ENDING state, however the server does not end. 
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Multiple Java Server Console instances 
If you intend to use more than one instance of the Java Server Console on the system, the first Java 
Server controller that starts will bind to port 2050.  Subsequent requests to start the Java Server controller 
for another Domino server will attempt to use that same port and will fail. 

Workaround 
To start more than one Java Server controller, manually create or edit the dcontroller.ini file in the 
Domino server's data directory and specify the IP address of the Domino server and a port number 
other than 2050. 

Domino Server, Domino for System i 

System i: Java heap dump not generated with  "classic" JVM 
If you choose to use the non-default "classic" JVM using the Notes.INI value JavaUseClassicJVM=1, 
note that a heap dump (.phd file in the server's data directory) will not be generated if the JVM encounters 
an out of memory condition.  The heap dump will be generated if you use the default JVM, J9. 

See the "System i: Software requirements" release note for more information. 

Domino Server, Domino for System i 

System i: Tivoli Enterprise Console not supported 
The Tivoli Enterprise Console (TEC)  functionality with the Domino server is not supported on the Domino 
for System i platform. 

Domino for System z 

System z: zFS filesystem limitation 
On System z, Lotus does not recommend using the z/FS aggregate dynamic GROW feature for Domino 
file systems.  z/FS is based on a UNIX file system software product that can take minutes (15 minutes in 
some cases) to grow a z/FS file system in an aggregate.  During the time the z/FS aggregate is grown, all 
file systems within an aggregate are quiesced, in order to format the expanded part of the file system.  
This quiesce would be detrimental to Domino, as all disk I/O and client responses would cease during the 
aggregate GROW process.  

Lotus also recommends that you continue to monitor the console log for the message "Warning: 
cannot merge full text index a/notes/data/mtdata/mtstore.ft due to 
insufficient disk space" and manually grow z/FS files systems as needed during off-peak hours. 

Web Services issues 

Domino Server 

Consuming SOAPENC faults with multi -refs 
Java Web service consumer script library methods are unable to fully deserialize thrown provider faults 
that employ SOAPENC multi-ref's.  An empty fault is returned instead.  This may be addressed in a future 
release. 
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Domino Designer 

Multi-byte characters in WSDL documents 
WSDL documents are Unicode-based XML documents and, as such, may contain characters which are 
multi-byte in local operating system character sets.  Because of file system dependencies, importing 
WSDL into a Java Web service or Java script library may not succeed for WSDL documents containing 
such characters. 

Domino Designer, Domino Server 

Web Service version compatibilities 
Web services created using Domino Designer 7.x will run on a Domino 8 server with original Domino 7.x 
behaviors, except for obvious bug fixes.  However, the reverse is not supported, for example, a Domino 
7.x server cannot support Web services implemented or generated using Domino Designer 8, due to 
Domino Designer 8 modifications and improvements to mappings between WSDL/XML Schema and Java 
or LotusScript language constructs. 

Accordingly, invoking a Designer 8 Web service or requesting its WSDL document will, if hosted on a 
Domino 7.x server, return one of the following HTML messages: 

"This version of the Web Service design is not supported on this server" --  from a Java Web 
service 

or: 

"Error 500" 
"HTTP Web Server: Lotus Notes Exception - Unknown LotusScript Error." -- from a LotusScript 

Web service 

Further, opening a Designer 7.x Web service using Designer 8 will display the following warning: 

"The selected Web service has less-advanced features than are supported by this version of 
Designer. If changes regenerate the WSDL interface, then less-advanced Domino Web Service 
runtime environments will no longer execute this service". 

However, for Domino 8 Beta 3, Domino 7.x Web services saved using Designer 8.0 will lose their 
compatibility with previous versions of Domino and Designer, regardless of the changes made.  This 
restriction may change for the final release. 

Also, making changes using Designer 8 that regenerate the WSDL interface for a Domino 7.x Web 
Service will require confirmation in a dialog box, since the Web Service will be permanently upgraded for 
Domino 8, and will no longer be compatible with Domino 7.x. 

Finally, opening a Designer 8 Web service using Designer 7.x will display the following warning: 

"This Web Service has been previously saved in a newer version of Designer. This version of 
Designer being used will not be able to save the Web Service." 
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Domino Designer, Domino Server 

Web Services and Arrays

By default, the WSDL representations generated by Domino Designer 8 for arrays in a LotusScript or 

Java Web service implementation are of the following forms:


z	 XML "literal" form for Web service design elements that have rpc/literal, document/literal, or wrapped 
SOAP message formats: 

<complexType name="xxxArray"> 
<sequence> 

<element name="elem" minOccurs="0" maxOccurs="unbounded" 
type="[array element type]"/> 

</sequence>

</complexType>


z	 the SOAP-encoded ("SOAPENC") form for Web service design elements that have the rpc/encoded 
SOAP message format: 

<complexType name="ArrayOfxxx">

<complexContent>


<restriction base="soapenc:Array"> 
<attribute ref="soapenc:arrayType" wsdl:arrayType="[array 
element type]"/> 

</restriction>

</complexContent>


</complexType>


In addition, the XML "literal" form is also generated from Java Web service implementations for what are

commonly known as Java Bean "indexed" properties in a Java Web service value type.  


During WSDL importing, XML "literal" arrays are always supported, regardless of SOAP message format.  
However, Domino Designer 8 no longer imports WSDL descriptions using SOAP-encoded ("SOAPENC") 
arrays together with "literal" SOAP message formats (i.e. rpc/literal, document/literal, or wrapped). 

The remainder of this Release Note is specific to LotusScript Web services . 

Empty Arrays 
Empty arrays in a SOAP request or response (i.e. literal array elements that are completely absent, or 
elements with a SOAPENC "arrayType" attribute, but no array content children) are supported for Domino 
8.0 Web services by passing uninitialized dynamic arrays to the Domino 8.0 provider or consumer.  

This is a change in behavior from Domino 7.x Web service providers (which still either trigger runtime 
SOAP faults, or receive arrays of length 1).  This change suggests that the receiving consumer or 
provider should be implemented to handle ErrUninitDynArray errors, for detecting that empty arrays have 
been received during attempts to access them. 
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Fixed-Size and Dynamic Arrays 
Fixed arrays are supported only when they are used within a Type declaration. For example: 

Type MyType

myArray(2,2) As Long ' fixed-size array


End Type


Dynamic arrays are supported only when used within a Class declaration: For example: 

Class MyClass

myArray() As Long ' dynamic array


End Class


Using arrays in other constructs may cause unpredictable results, including causing server stability 
problems (see SPR# TCAR6HPUH6). 

Multidimensional Arrays 
Serialization of multidimensional SOAP-encoded arrays are not currently supported. Such a serialization 
results in a single-dimension SOAP array containing all of the LotusScript array's elements, but with an 
incorrect array-size value in the "arrayType" attribute. (see SPR# TCAR6HPT4L) 

Support for deserialization of multidimensional SOAP-encoded arrays was added with the 7.0.1 release. 
There are, however, some limitations: 

z	 Multidimensional arrays are not supported when the array is a member of a LotusScript "Type" 
statement, or when the elements in the array are defined with a LotusScript "Type" statement.  
For such cases, it is suggested that a "Class" construct be used instead. 

z	 So-called "jagged" arrays are not supported.  An multi-dimensional array is considered to be 
"jagged" when sub-arrays within a given dimension are of varying lengths.  For example: 

<a xsi:type="soapenc:Array" soapenc:arrayType="xsd:int[][2]" 
xmlns:soapenc="http://schemas.xmlsoap.org/soap/encoding/"> 

<item soapenc:arrayType="xsd:int[1]"> 
<item>100</item> 

</item> 
<item soapenc:arrayType="xsd:int[2]"> 

<item>200</item>

<item>300</item>


</item>

</a>


z	 The optional "asize" component of the SOAP "arrayType" syntax is not recognized.  The length of 
deserialized arrays will be based solely on the actual number of array elements present in the 
SOAP message. For example, for an array with the arrayType attribute of "xsd:string[10]", but 
with 5 or 15 actual items, the length of the array would be 5 or 15 respectively, not 10.  

z	 The SOAP attributes "position" and "offset", for sparse and partially transmitted arrays, are not 
supported. 

Domino Designer 

XML schema mechanisms "include" and "import" are not supported 
The XML schema mechanisms "include" and "import" are not supported.  That is, any XML schema 
defined in an imported WSDL document must not refer to any external XML schema documents. 
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Known problems and workarounds


Accessibility issues 

Lotus Notes 

Clicking Details in Update Manager temporarily disables Tab key 
When the Update manager dialog is showing the progress of the current provisioning operation, clicking 
on "Details", and then using the Tab key to cancel, disables keyboard strokes.  You can not then tab away 
or cancel; you must let the operation finish first.  Note, though, that you can use the mouse to cancel. 

After the job finishes, the keyboard strokes are back to normal. The tab keys work properly if you do not 
click on "Details" first. 

Lotus Notes 

JAWS announces the state of indeterminate progress bar 
When background tasks occur in Notes, an indicator appears on the status bar that contains an 
indeterminate progress bar. JAWS constantly announces the state of this progress bar at various times, 
even though this progress bar is not actually indicative of the state of progress of the background jobs. 

Workaround 
Highlight Notes while JAWS is running and press Insert+6, create a new configuration, choose Set 
Options -> User Options, and turn off "Announce Progress bar Updates". 

Activities issues 

Lotus Notes 

Activity entry will not save pasted data if no other edits made 
If data from the clipboard is pasted into an activity entry description field, and no other edits are made (for 
example, if no keystrokes such as Enter, or other edits to the name, or tag fields of the entry are 
performed), then the pasted data will not be saved.  As a workaround, make sure at least one keystroke is 
entered in addition to the paste.  A simple carriage return using the Enter key will suffice before selecting 
"Save". 

Lotus Notes 

Activity with Notes Document  - Error due to server access rights 
If a user is added as a member to an activity that contains a server-based Notes document, and that user 
does not have the proper access rights to the server on which the documents resides, they will receive a 
generic "#59:34" Notes error when trying to view the document. 
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Lotus Notes 

Error sometimes occurs when performing certain actions 
An Error dialog sometimes displays when creating a new activity or adding an entry to an activity.  Click 
on the OK button in the dialog to clear the error, and the transaction will complete successfully. 

Lotus Notes 

Issues when adding several Notes documents to Activities 
By default there is a limit of 25 documents that a user can drag-and-drop to the Activities sidebar at one 
time, set by the ENV_WMCSELECTION_MAXDOCUMENTS variable in the Notes.INI file. Occasionally during 
this operation a user may receive a message stating "An error occurred while performing drop" which 
could be due to the amount of documents or content being brought over. 

If this is the case the aformentioned .INI variable can be decreased to a smaller number to help alleviate 
the problem. 

Lotus Notes 

Linux: Activities chat entries do not display embedded images 
Embedded images in a chat entry for clients using the SLED 10 Linux platform will not display when 
opened; an id for the image will display in its place. The embedded image is added as a response to the 
chat entry. The workaround to view the image is to open the response file entry. 

Lotus Notes 

Long user name within a Group will not have access to activities 
Users with a user name of 100 or more characters within a Group will not have access to activities to 
which the Group has been assigned. The workaround is to add the user as an individual member to the 
activity, or create a shorter user name for that user. 

Lotus Notes 

Open Activities windows will not close upon switching IDs 
Switching an ID in the Lotus Notes client will close all open application windows except any open 
Activities windows. Close any open Activities dialog windows prior to invoking "Switch ID" in the client. 

Lotus Notes 

Outline view display issue after manual refresh 
The Outline view for Activities entries will display only 30 entries after a manual refresh action, even 
though there may be more than 30 entries in the Activity.  To work around this issue and correctly display 
all entries, toggle back to the List view and then to Outline view again. The Outline view then will correctly 
display all entries. 

Lotus Notes 

To Do items cannot be marked complete by assignees 
To Do items may be assigned to members of an activity, however, if the assignee does not have owner 
access to the activity (for example, only Author access), they will not be able to mark the To Do as 
complete. The "Mark Complete" context menu choice will be available, but the To Do will continue to 
display as incomplete.  The workaround is to have an Owner mark the To Do as complete. 
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Calendar and scheduling issues 

Lotus Notes 

Drag-and-drop between Side and Main calendar not supported 
In this beta release, users are unable to drag-and-drop calendar items between the Main calendar and the 
Side calendar. 

Lotus Notes 

Invitees are not displayed in "bcc:" list 
When choosing the calendar Meeting option, and clicking the address book to add invitee names to the 
"bcc:" field, the chosen names are not displayed. 

Note that the invitees are added to the Meeting notice, they are just not displayed in the attendee list 
when creating the Meeting invitation. 

Lotus Notes 

Pasting a calendar entry in a view copies to incorrect location 
When using the Notes client in a Calendar view, if you select an entry and paste it to another empty slot, it 
will be pasted to an incorrect location. 

Workaround 
Open the calendar entry and select the new time or date. 

Lotus Notes 

Tentative Accept from Notes states that it was accepted 
The static text on a tentatively-accepted meeting invitation incorrectly displays as "Accepted". 

Lotus Notes 

To Do view does not have "Ctrl-Click here to add a new document "

The To Do application no longer displays the link "Ctrl-Click here to add a new document" in the Notes

client.  
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Client issues 

Lotus Notes 

Cannot add RSS feeds to reader 
On systems running a firewall, the feed reader may display the error "Valid feed not found".  This indicates 
that there is no access to the network/feed, even when the feed is available but not parseable.  The feed 
reader can also be blocked and display no error message.  For example, you may be unable to add a new 
RSS feed but see no error. Restarting the client resolves this issue. 

Lotus Notes 

Close All option closes the sidebar

The Lotus Notes 8 File menu item or toolbar action "Close all" closes the sidebar.  If the sidebar is closed, 

you can redisplay it by clicking View > Sidebar, and selecting Open or Thin from the resultant list.


Lotus Notes 

Date /Time format is not mirrored in Calendar View 
If you enable bi-directional orientation as Right-to Left, the Date/Time format is not mirrored in either the 
Calendar View or sidebar "Day-at-a-glance" view. 

Lotus Notes 

Drag-and-Drop e-mail to Mail, Calendar, To Do bookmarks 
The Notes Basic client allows drag-and-drop of e-mail to the Mail, Calendar, and To Do bookmarks, but 
this feature is not yet implemented in the Notes 8 client.  As a workaround, use the action button More -> 
Copy Into New -> Message, Calendar Entry, or To Do. 

Lotus Notes 

Drag and drop bookmark to empty folder solution 
You cannot drag and drop a new bookmark into an empty bookmark subfolder, or as the last bookmark in 
a subfolder. However, you can use the context menu to create a bookmark in a new subfolder.  Once the 
subfolder is no longer empty, you can use drag and drop to create bookmarks in it. 

Lotus Notes 

Drag and drop from feed reader to IE browser fails 
Some links may not drag properly from the feed reader into the internal Web browser when Internet 
Explorer is set as the Notes internal browser. 
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Lotus Notes 

Empty window appears upon initial launch 
Lotus Notes 8 may open an empty window in the following situation: 

1. Install and open Lotus Notes 8 Beta. 

2. Click Launch. 

3. Right-click one of the menu options, such as Mail. 

4. Click Open.

5. Click Launch again and right click the Mail menu. 

6. Click Open in New Window.

A window with no content appears. Close the window, do not use it. 

Lotus Notes 

F1 Help for File > Preferences not fully implemented 
At this time, only a few Preference dialogs bring up a Help topic when you press F1.  To find Help for a 
preference, click Help > Help Contents from the main menu, and either use Help Search or look in the All 
Topics list. 

Lotus Notes 

Feed reader does not support sites requiring authentication 
The Lotus Notes 8 feed reader does not currently support sites that require authentication. If you attempt 
to subscribe to a feed and receive an authentication, or other security-related error message, you can 
then create an account in Notes (using the procedure below) and retry the feed subscription: 

1. Obtain the URL for the feed to which you would like to subscribe. 

2. Open Lotus Notes 8 and click File > Preferences > Accounts. 

3. Click New Account.

4. In the Account Name field, type a descriptive name of your choice. 

5. In the Description field, type a brief description of the feed to which you want to subscribe. 

6. In the Type field, chose either HTTP or HTTPS. 

7. In the Server field, paste in the URL of the feed to which you want to subscribe. 

8. Click OK. 

For related information about Lotus Notes 8 accounts, see the Notes 8 Help; click Help > Help contents > 
Lotus Notes > Setting Preferences > Account Preferences. 

Lotus Notes 

Generic icons display on tabs restored from a previous session 
Generic icons will be displayed on window tabs that are restored from the previous session. These icons 
will display until the user clicks on the tab, at which point they will be updated with the correct 
database/document icon. 
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Lotus Notes 

Grouped tab mode view display 
In the group tab mode, you should not close the root view (listed at the bottom of a group list under a 
separator) before closing all the view documents.  Note that once the view is added back to the list, it is 
treated as a document in the list, rather than the anchor for the group.  The view item moves down the 
group list as other documents are opened. Also if you save tab states on shutdown, which is the default, 
when you restart the client the group tab name becomes the name of the last viewed document in the 
group. 

Lotus Notes 

JIS2004 character display on Windows XP Notes  8 client 
Certain JIS2004 characters may not display properly in Lotus Notes 8 running on a Windows XP client. If 
the user has MS PGothic and MS Mincho fonts installed, the characters should render correctly.  To 
ensure that Japanese JIS2004 characters display properly, do the following: 

To enable JIS2004 support on Windows, do the following: 

1.	 Install the language support for Japanese on any non-Japanese  version of Windows. 

2.	 Click Start > Control Panel > Regional and Language Options. 

3.	 On the Languages tab, check the "Install files for East Asian languages" check box. 

4.	 Install the JIS2004 support package from http://support.microsoft.com/kb/jp927489/ 

To enable JIS2004 font linking, do the following: 

1.	 Click Start > Run. 

2.	 In the "Run" text box, type regedt32 to open the registry. 

3.	 Navigate to [HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\FontLink\SystemLink]. 

4.	 Double-click on the "Tahoma" key in the right panel. 

5.	 Add "msgoth04.ttc,MS PGothic", in a new line, in the edit box. 

6.	 Double-click on the "Arial" key in the right panel. 

7.	 Add "msgoth04.ttc,MS PGothic", in a new line, in the edit box. 

8.	 Click OK to restart the computer. 

Font linking provides the ability to render non-Latin characters when the font set by the application does 
not support those particular characters. It is suitable when an application cannot use a single font to 
render all the required characters. 

Note: If you use the Registry Editor incorrectly, you can cause serious problems that may require you to 
reinstall your operating system. Use the Registry Editor at your own risk. 

To enable the JIS2004 dialog font, do the following: 

1.	 Right click in the desktop and click Properties. 

2.	 Click the Appearance tab on the Display Properties dialog. 

3.	 Click Advanced. 
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4.	 Select Message Box in the "Item" menu on the Advance Appearance dialog, then select "MS PGothic" 
in the "Font" menu. 

5.	 Click OK on the Advanced Appearance dialog. 

6.	 Click OK on the Display Properties dialog. 

Lotus Notes 

Location button is missing after switching from IBM Editors

The location button on the bottom right will disappear when closing an IBM Word Processing, 

Presentation, or Spreadsheet tab. This can also happen if you switch to another tab such as Mail.


You can workaround this issue by selecting File -> Locations and selecting "Switch to Location" if you

need to change a location.  Or you can restart the Notes client, and the location button will appear on the

bottom right again.


Lotus Notes 

Notes action bar and navigator do not inherit system font size

The Notes action bar and Notes application side bar do not inherit the system font size. To resolve this 

display concern do one of the following:


z	 Switch to high contrast mode by clicking Control Panel > Accessibility options > Display tab, enable 
the "Use High Contrast" checkbox, and click Apply. 

or 

z	 Click File > Preferences > Windows and Themes > Operating System Theme. 

Lotus Notes 

Notes fails to restart successfully after a crash 
In some situations, after a Notes crash and subsequent run of NSD, Notes may fail to restart successfully.  
When this happens, rather than restarting Windows, a manual NSD using the -kill option should be 
executed.   Complete the following steps: 

1.	 Open a Command Prompt window 

2.	 Change to the directory containing the Notes.ini file (Notes Program directory or Notes Data 
directory in multi-user installations) 

3.	 Run the command "<NotesProgramDirectory>\nsd.exe -kill" 

4.	 Start Notes normally 

Lotus Notes 

Opening a file entry that is already open will show error dialog

If a file entry is already open, and a user attempts to open it again, an error dialog will display with a

message stating "An error occurred while opening file ... ". If such an error dialog is encountered, make 

sure the file is not already open. This error dialog can be closed without incident.
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Lotus Notes 

Theme does not change after disabling high contrast 
If you enable the high contrast theme using the UI sequence Control Panel >  Accessibility options > 
Display tab,  enable the "Use High Contrast' checkbox, and apply the settings, then later return to the 
Display tab and disable the "Use High Contrast" checkbox, the visual theme does not change to the 
default Notes 8 theme. Colors and fonts change because they using the default native.css. However, the 
theme remains still set to the "Operating System" theme in the Windows and Themes preference panel. 
To resolve this theme display issue, restart the Notes client after disabling the "Use High Contrast" 
setting. 

Lotus Notes 

Toolbars can experience display issues in new window theme 
The toolbars can experience redraw issues when using the Notes client in the new window theme - this 
can be enabled using File - Preferences - Windows & Themes, and selecting "Launch each document in 
its own window". 

For example, when reading a message, the new window is smaller, so if you have enabled additional 
toolbars there will not be enough room to display the toolbars completely, and overflow buttons will be 
used.   At times these overflow buttons do not display correctly in the new window mode, and sometimes 
some of the toolbar sections do not display correctly (they may get cutoff).  Resize the new window to be 
a little larger, and the toolbars and overflow buttons will redisplay correctly.  

Note: This tends to happen more when using your display in 1024x768 mode. 

Lotus Notes 

Unexpected feed reader subscription behavior 
The Notes 8 feed reader does not allow you to subscribe to feeds that force a URL redirect.  However, if 
you open a browser and enter the feed URL, record the actual destination URL, and use that destination 
URL in your feed subscription, the feed subscription will be successful. 

For example, the following feed may fail if a redirect is required: 

http://www.computerweekly.com/Feeds/RSS.aspx?cat=135 

In this instance, if you put the above address into a Web browser address bar,  the URL resolves to the 
following, which you can then use to subscribe to the feed using the Notes 8 feed reader. 

http://feeds.reedbusiness.co.uk/9d63ef1e-138d-422d-b543-2db74210f87a/CW360/The%20latest%20E-B 
usiness.xml 

Of related note, when you first enter the URL (http://www.computerweekly.com/Feeds/RSS.aspx?cat=135 
), the address is converted correctly, but you may receive an error message stating that the XML page 
cannot be displayed. If this happens, click "Go" again to resolve the URL, and display the expected XML 
page. 

Lotus Notes 

Use Help table of contents to access Help topics on Preferences 
Context help for Preferences is not in place; to access Help topics on Preferences, choose Help -> Help 
Contents -> Lotus Notes ->  Setting Preferences. 
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Composite Applications issues 

Lotus Notes, Domino Designer 

Applications not opened in the correct window 
Applications are not opened in the correct window when the Composite Application Editor has focus.  This 
occurs when opening another database/composite application from the client while the Composite 
Application Editor is open. 

Workaround 
Whenever a new application is opened while the Composite Application Editor is open, click on any 
application in the main window to make it active. 

Lotus Notes 

Cannot open a URL Link to a Composite Application 
This release note applies to Lotus Notes 8 running on the Windows platform: 

There are some known issues with URL links to Composite Applications.  You can create such a link with 
an opened Composite Application by using Edit -> Copy As -> Application URL or Edit -> Copy As -> 
Page URL, and then paste it into a Notes document.  Sometimes the link will inadvertently be truncated, 
resulting in an error message when you open the link. 

You may be able to open the Composite Application using your browser by copying the URL into the 
browser.  In Lotus Notes, with the document in Edit mode, put the cursor anywhere within the link.  Select 
Hotspot -> Hotspot Properties. Copy the URL in the Value field of the Hotspot Resource Link dialog.  
Paste it in a browser.  The browser will then attempt to open the application in Lotus Notes. 

Alternatively, when creating a link to a composite application, use  Application Links (Application -> Copy 
As a Link) instead of Application URL or Page URL. 

Domino Designer 

Component data is sometimes not visible when editing 
When editing composite applications with the Composite Application Editor, component data is 
sometimes not visible on the Editing pane. 

Workarounds 
1. Re-add your component to the application and the content of the original component should display
within Composite Application Editor editing area.  You then should delete the surplus component that has 
no data displaying. 

2. Exit the Composite Application Editor to see your component data.  The component data will display 
when the application is running in the Notes client.  Re-edit the application again in the Composite 
Application Editor and the component data should appear. 
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Lotus Notes, Domino Designer 

Component repositioning 
You can reposition a component in Lotus Notes 8 Beta, regardless of whether the "Allow user to 
reposition component" option is enabled or disabled for that particular component. For example, if you 
start Lotus Notes 8 Beta, open an application using the Composite Applications Editor, right-click on a 
component in the editor, and open the Edit Component Properties dialog, you will see the "Allow user to 
reposition component" option. Enabling or disabling this option has no effect; you will be able to reposition 
the component regardless. 

Lotus Notes 

Composite applications open even if errors exist 
The Notes 8 Beta client will open composite applications, even if they contain errors. There is currently no 
preference check to determine whether or not to open composite applications that contain errors. 

For example, a component in the composite application may be unavailable. When you open the 
composite application you may see an old version of the component, a placeholder, or no component at 
all. It is not always obvious that one or more components have not been properly provisioned. If needed, 
you can close the application. 

Domino Designer 

DAP configuration settings impact what client displays 
DAP (Domino Application Portlet) configuration settings (via browser/server), can impact the way 
applications display on the Notes client. 

Workaround 
When entering the Configuration user interface for DAP,  go to the Rich Client Configuration page and 
make sure the following preferences are set as follows: 

com.ibm.rcp.fastView false

com.ibm.rcp.fixed true

com.ibm.rcp.visible true


Lotus Notes 

Linux: Cannot open Composite Application bookmark or URL link 
On Lotus Notes for Linux, you may not be able to open a Composite Application from a bookmark or from 
a link in a Notes document.  The workaround is to open the application directly from the Ctrl+O dialog.  
Alternatively, you may be able to open the Composite Application with a Firefox browser by copying the 
URL into the browser. 

In Lotus Notes, with the document in Edit mode, put the cursor anywhere within the link.  Select 
Hotspot->Hotspot Properties. Copy the URL in the Value field of the Hotspot Resource Link dialog.  
Paste it in the browser.  The browser will then attempt to open the application in Lotus Notes. 

Domino Designer 

Problem encountered wiring components with  ?OpenDatabase 
In Composite Application Editor, you encounter problems wiring components with the ?OpenDatabase 
command. 

Workaround 
Do not manually enter the URL with ?OpenDatabase.  Use the Component Picker in the Composite 
Application Editor to select the URL. 
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Domino Designer 

Tab names for components do not display

The tab name for components in composite applications may not display until selected.  In other words,  

NSF components are not initialized until clicked.


Workaround

Select each component first in the Edit mode navigator of the Composite Application Editor.


Domino Designer 

Tab remains when deleting a page in CAE 
When deleting a page in the Composite Application Editor with a child page, the tab at the top still 
remains. There is no workaround. 

Domino Designer 

Updates to Eclipse features not recognized automatically 
Composite application Eclipse feature updates, provisioned via HTTP, are not recognized automatically.  
You must make a change to the CA.XML and have it point to the new versions, or you need to have 
Auto-update turned on and the update site URL needs to be in that list.  In summary, if Auto-Update is not 
enabled you need to change the composite application XML to get the new versions. 

Domino Designer 

WSDL files must be changed to run Customer Profiles sample 
Changes need to be made to the WSDL files generated by the WSDL.nsf provided in the Composite 
Application Toolkit before you use them with the Customer Profiles sample. 

Workaround 
Do the following to use the WSDL files generated by the WSDL.nsf with the Customer Profiles sample 

z	 Import the new CorpAcct WSDL into corpacct.nsf. 

z	 Change the Composite Settings in the ID and Account Column Properties of the "All Documents" 
view of corpacct.nsf to match what is specified in the new WSDL files. 

z	 Update the WSDL files for the two Java Portlets - 
com.ibm.notes.samples.AccountManagerComponent and 
com.ibm.notes.samples.SalesHistoryComponent - into their respective deployable plugins. These 
are available in <Install Dir>\framework\shared\eclipse\plugins. 

z	 Open the composite application sample in the client. 

z	 Edit the composite application using the Composite Application Editor by redefining the wires to 
the settings in the new WSDL files. 

z	 Save and close the Composite Application Editor. 
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Contacts issues 

Lotus Notes 

New Location added in PNAB does not display in Location Switcher 
If a new location document is created from the personal name and address book, it is not immediately 
available to be displayed in the location switcher.  The location will be displayed after exiting and 
restarting the Notes Client.  

Workaround 
The new location is immediately displayed if the new location is created from the Location Switcher rather 
than manually creating it in the personal name and address book. 

DB2 issues 

Domino Server 

Do not upgrade Domino 7.x to Domino 8 DB2-enabled Notes database 
If you have enabled your Domino servers to communicate with DB2, and you have DB2-enabled Notes 
databases, do not migrate directly from Domino 7.x to this Domino 8 Beta release.  If you do so, you will 
be unable to access your data. 

Workaround 

1.	 Create NSF database replicas of the DB2-enabled Notes databases. Use the Create Replica tool in 
the Domino Administrator.  Be sure to create the replica on a Domino server configured with NSF as 
the default datastore. 

2.	 Upgrade to Domino 8. 
3.	 Run the server enablement tool to allow the Domino and DB2 server to communicate. 
4.	 Convert the NSF database replicas back to DB2-enabled Notes databases. 

Domino Server 

Domino and DB2 - error SQL0964C 
The error "SQL0964C - The transaction log for the database is full" occurs when you run Fixup on a large 
DB2 enabled Notes application and an "out of log space" condition occurs. 

When this error occurs, the Domino server is unable to process application requests on behalf of DB2 
enabled Notes applications. If you need to run Fixup for fixing corrupt folders, and you do not have a 
replica of the DB2 enabled Notes application, you can allow folder fixup by adding the following Notes.INI 
setting to your Notes.INI file on the server. 

DB2NSF_Allow_Folder_Fixup=1 

Using this Notes.INI setting for a large DB2 enabled Notes application can render DB2 enabled Notes 
applications inoperable until the Domino server is restarted. 
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Designer issues 

Domino Designer 

Java Reference tab cannot expand beyond Classes or Interfaces 
The Domino Designer Java Reference tab listings cannot be expanded beyond the Class or Interface 
level.  If you click on the Reference tab, and expand the categories, you will see: 

java.applet

Classes


Applet

Interfaces


AppletContext

AppletStub

AudioClip


... 
but you will not be able to expand to see subcategories below this level. 

As of the current release of Domino Designer, you can restore full expansion by disabling the JIT; exit the 
Designer and the Notes client, add the Notes.INI variable JavaEnableJIT=0, and and restart Notes.  
This issue is expected to be addressed in the gold release of Domino Designer 8. 

Domino Domain Monitoring issues 

Lotus Notes 

DDM Remote Server Console Common Action not working correctly 
The Domino Domain Monitoring Common Action Remote Server Console does not enter the correct 
server name in the Server textbox of the Remote Server
 Console dialog box. 

Domino Web Access issues 

Domino Web Access, Domino for System i 

DWA with Sametime chat/awareness only works with port  80 
Sametime chat and awareness do not work with Domino Web Access when the HTTP server is 
configured to use a port other than 80.  

Workaround 
Configure the HTTP server to listen on port 80. 
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IBM Lotus Productivity Tools issues 

Lotus Notes 

Linux: No "Save as type" option available 
There is no "Save as type" combobox in the 'Save as' dialog for IBM Productivity Tools running on the 
SUSE platform.  File extensions need be set specifically to save a file as a certain type. 

Lotus Notes 

ODF file association is overwritten 
The following file extension associations that are defined by the OpenDocument standard are overwritten 
on Windows platforms when you install IBM Notes 8 Beta: .odt, .ott, .ods, .ots, .odp, and .otp.  If you want 
to change the association, please consult your system administrator. The following gives one possible 
way to change the association of certain file extensions: 

1.	 In the File Explorer, right-click on a file with the extension whose association you want to change, and 
then click "Open With" 

2.	 In the "Open With" dialog, click the program that you want to use to open the file, or click "Browse" to 
choose the program on a disk 

3.	 Select the check box "Always use the selected program to open this kind of file" 

Lotus Notes 

Special characters are not supported in file name

Use of special characters, like "*" and "#" in a file name is not supported, and should be avoided.  

Unpredictable results, including opening the wrong file and overwriting other files, may occur. 


Avoid using special characters when saving a document. If a file name contains special characters, 

rename it before opening it.


Lotus Notes 

Unavailable network printer can cause performance downgrade 
If a user's default printer is a network printer, and is not available, the performance of the IBM Lotus 
Productivity Tools may be downgraded because of network latency.  As a workaround, change the default 
printer to an available printer. 

Lotus Notes 

Using Productivity Tools and Notes  8 simultaneously 
If you open one of the IBM Lotus Productivity Tools editors, for example from the Desktop or Start menu, 
and then open Lotus Notes 8 Beta the "Tools" and "Window" options in the Notes 8 top bar may display 
grayed and unusable. This issue only happens when the Lotus Notes 8 Beta is started after one of the 
Productivity Tools editors. To avoid this issue, start Lotus Notes 8 Beta before starting any of the Lotus 
Productivity Tools editors. 
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Installation issues 

Lotus Notes 

Avoid modifying or repairing Notes Standard client installation

When attempting to Modify or Repair a Notes Standard client installation from the Control Panel you will

receive a fatal error.


Lotus Notes 

Client Install - unexpected dialog navigating Back then Next

In the client installation, in same cases after navigating "Back" through the installation dialogs and then

selecting the "Next" button an unexpected Network Installation dialog will appear.  If this happens, exit

and relaunch the installation and avoid navigating "Back" to previous install dialogs if possible.


Domino for System i 

Domino installation may fail with signature violation on i 5/OS

Domino and OS/400 signatures

When installing Domino 8 for System i, the installation may fail with the following error message (check

the job log for the job that issued the RSTLICPGM command): 


Object has a signature that is no longer valid. 

This is likely the result of installing Domino to a system that has the more stringent levels of object

signature validation enabled for restore operations. 


The policy to be used for object signature verification during a restore operation (for example, product

installation) is controlled by the QVFYOBJRST system value, which has a default value of 3. 


When installing Domino for System i, the system value QVFYOBJRST must be set to a value of 3 or lower 
prior to installing Domino. 

After installation of Domino has completed, the system value may be changed back to a more restrictive 

setting. 


An example of changing the system value QVFYOBJRST is provided below: 

CHGSYSVAL SYSVAL(QVFYOBJRST) VALUE('1') 

Domino Server 

Information and known issues with the new UNIX ISMP installer

The new ISMP installer requires that you log on as the root user in order to perform the install.  The 

following known issues occur when using the UNIX ISMP installer:


z	 There are three modes of installation with the new ISMP installer.  Graphical interface in interactive 
mode -- use this method to synchronously monitor the installation processing and results.  If the target 
console has no graphical interface, or if one is not desired, you can use console or silent installation. 

When launching the install in graphical mode where the graphical interface is unavailable, the installer 
will exit display a message indicating that the installer is unable to run in graphical mode, and to try 
running the installer with -console or the -silent option. 
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To run the installation in graphical mode, enter: ./install
To run the installation in console mode, enter: ./install -console 
To run the installation in silent mode, enter: ./install -silent -options <path to 

unix_response.dat> 

The new ISMP installations can also be uninstalled in both graphical and console modes from the 
/opt/ibm/lotus/notes/latest/<platform>/_uninst directory. 

To run the uninstall in graphical mode, enter: ./uninstaller.bin

To run the uninstall in console mode, enter: ./uninstaller.bin -console


z	 When installing on a system with low disk space, a message may display indicating that there may 
not be enough temporary disk space, and to try using -is:tempdir, in order to use a temporary 
directory on a partition with more disk space. 

To run the installation specifying the temporary directory, enter: 
./setupPlatform.bin -is:tempdir "<directory>" 

where <directory> is the name of a directory on a partition with more available disk space 

z	 The new installer validates the group name such that the user must belong to the group being 
specified. If you successfully installed with specific user and group names in previous Domino 
versions, it does not necessarily mean that the previously supplied group name will now be valid.  

If you provide user and group names, and the following message appears: "Group <group name> is 
not a valid group for user <user name>...," either (1) add the user to the group you are supplying or 
(2) as that user, type the "id" command and choose a valid group that the user already belongs to. 

z	 Existing script.dat files from previous Domino versions cannot be used with the new ISMP 
installer.  Modify a local copy of the file sample unix_response.dat provided with the install kits.  
More options are now available than in the previous installation's script.dat file. Take note of the 
following information: 

z	 If you select a Setup Type other than CustomServer, do not modify any of the Feature sections, 
for example, the "License" feature. Use these feature options to customize your installation when 
using a Setup Type of CustomServer. 

z	 Do not attempt to record a response file at this time.  The installation will hang and the response 
file will be incomplete.  Use the file sample unix_response.dat provided with the install kits. 

Domino Server 

Invalid path entries for new UNIX ISMP installer

The following are invalid characters for the UNIX ISMP installation:


 ' ^ ( ) | { } [ ]  \ : * ? " < > | as well as a space 

Note that the installer may not warn you if you have entered one or more of these invalid characters, 

depending on the platform you are installing on.
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Lotus Notes 

Java Console functionality is not available

If you load a Microsoft Vista or Microsoft XP system with the latest Notes 8 client kit you will either not ga

in Java console functionaility or, if you had it, you will lose it.  When installation and setup are complete, 

launching the Java console from the Notes binary directory (c:\program files\IBM\lotus\notes\jconsole.exe) 

will display the following error:


Lotus Notes, Domino Designer 

Notes client installation needs "C" drive 
The Macrovision InstallShield utility will install to any drive, as long as a "C" drive exists.  If the "C" drive is 
absent from your workstation, you will see the message "Error 1327 Invalid Drive C:\", and the 
installation will abort. 

Lotus Notes 

Notes does not remember previous install features when re -run 
When performing a "Modify" installation, that is, an installation for a second time from the installation kit, 
features selected during the initial installation are not displayed as "selected" in the feature panel during 
the second, modified installation.  You must select the same features installed during the initial installation 
or the feature will be uninstalled. 

This issue is expected to be addressed in the Gold release of Notes/Domino 8. 
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Lotus Notes 

Renaming folder from "Database" to "Application" may fail

In some cases, renaming the "Database" Folder to "Applications" does not complete on a new installation.  

It is not functioning as expected.


Please look for a workaround to this issue in the Notes and Domino 8 Beta forum, the site from where you 

downloaded the Notes 8 beta client, and these beta release notes.


Lotus Notes, Domino Designer 

Shared node install: Do not use option "b" in silent mode 
if you use the progress bar option "b" (/qb and /qb+) when doing a silent shared installation, the message: 
"1904 nslxbe registration warning" appears at the end of the installation, and during 
subsequent uninstallation.  You can click "OK" to ignore these warning messages, and the 
installation/uninstallation will finish successfully. 

These warning dialogs do not happen when using "/qn+" and "/qn" for shared node install. 

Lotus Notes, Domino Server 

Smart Upgrade Governor information is not refreshed 
If you move from Enable to Disable for the Smart Upgrade Governor, the dynamic configuration 
information is not refreshed.  After restarting the server, the correct information can be shown. 

Domino for System i 

System i: CHKPRDOPT error messages in language environments 
Domino 8 for System i is only provided as an English (2924) language feature. To deploy Domino in a 
language other than English, you must first install the English version of Domino, and then install the 
Language Pack.  

If you install Domino 8 on a system where English (2924) is not the primary language installed, error 
messages will result from the CHKPRDOPT command as follows:   

CHKPRDOPT PRDID(5733LD8) 

Product 5733LD8 release V8R0M0 option *BASE load 2924 correctly installed.

Language *N not installed.                                                

Product 5733LD8 release V8R0M0 option *BASE load 5050 correctly installed.

Errors found by CHKPRDOPT.                                                


Similar messages may also result during the LODRUN or RSTLICPGM commands and are also normal.   
These conditions are normal and do not affect the ability to configure or run Domino servers. 

Domino Server, Domino for System i 

System i: Domino install does not launch using EZ-Setup on Vista 
The Domino installer does not launch when using EZ-Setup from iSeries Navigator on Windows Vista to 
install and configure Domino. 

Workaround 
Use one of the other install mechanisms (standalone setup.exe from the physical or electronic media, or 
LODRUN or RSTLICPGM CL commands) to install Domino 8 for System i. 
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Domino for System i 

System i: Domwzd missing System Database panel 
Register an additional Domino server, and then run the Domino configuration wizard to "Set up an 
additional Server".   The panel "Provide System Databases for this Domino server" is not displayed. 

Note: This problem occurs only with the Domino configuration wizard launched from iSeries Navigator; it 
is fixed in the DOMWZD.EXE file that extracted from the Domino 8 Beta 2 Web kit. 

Domino for System i 

System i: Installation will fail if WRKDOMSVR command active

Installing Domino 8 on System i will fail if a WRKDOMSVR CL command is being run in another session.  

If this occurs, an error message in the job log indicates that the QGNNINDS object cannot be allocated.  

Verify that there are no interactive jobs running the WRKDOMSVR command, and that all Domino servers

are ended, when you perform the installation.


Instant Messaging issues 

Lotus Notes 

How to display Chat History entries 
The File -> Open Chat History command will display the chat history entries that are saved in local files 
when the Sametime Chat History preference is set to "save to local file".  However, when the Sametime 
Chat History preference is set to "save to mail file", you need to open the Chat History view in the mail file 
to see the saved entries. 

Lotus Notes 

IM Vertical Orientation View is not working 
The Instant Messaging/Lotus Sametime icon does not display in the bottom row of the client if the user 
changes the "Vertical orientation" setting to "Bottom" in the Names section, as outlined in the following 
example: 

1.	 Install and launch the Notes client 

2.	 Open "Mail" and select a view from the Views folder in the Navigator 

3.	 Select "View -> Design" to open Domino Designer 

4.	 Select the "Name" column and right-click to open Column Properties 

5.	 In the advanced format tab from the Column Properties dialog, set the Row Height to 3 for the View 
property 

6.	 The Sametime icon does not display in the Mail view 
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Mail issues 

Lotus Notes 

Deleting messages may cause conversations to be out of order 
In Notes 8, you can view an entire e-mail conversation by selecting a member document and opening an 
in-line conversation subview in Inbox or All Documents.  In the subview, messages are organized by the 
hierarchy of how they arrived.  For example, all replies are shown under the message to which they are 
replies, and indented. 

If you delete a message which has replies to it, the hiearchy of the conversation may appear broken.  For 
example, assume there are two replies to the first e-mail (the 'root'), and each of these replies has more 
replies.  If you delete the first of the two replies, the second one moves up, and the "children" of the first 
reply appear below the "children" of the second. 

What you started with: 

first e-mail (root) 
reply 1 (<-- this one is deleted) 

reply -to-reply 1 
reply 2 

reply -to-reply 2 

What now appears: 

first e-mail (root) 
reply 2


reply -to-reply 2

reply -to-reply 1


Also, if you delete the root message in a conversation, only the first reply and any children will appear in 
the conversation. Note that if you have Soft Delete enabled, you can fix both of these issues by restoring 
the deleted message(s) from the Trash folder. 

Lotus Notes 

Documents selected in Mail mini-view will not appear in Preview 
Selecting an item in the Mail mini-view (beneath the Navigator pane) will not display the contents of that 
document in the Notes client. 
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Lotus Notes 

Errors after restarting Mail Application 
Occassionally, the error below will occur after the Mail application is closed and restarted. 

Lotus Notes 

Mail view displays incorrect fields in Subject and Date columns 
When you replace the Notes mail template design, and the new template contains different columns or 
different column orders than the old template design, you must restart the client after mail template 
replacement or the mail columns will display incorrectly. Once you restart the client and open mail the 
columns will display correctly. 

Lotus Notes 

Mini-view documents not shown in preview pane
 Selecting a document in the "Mail Mini-view" in Notes 8 Beta will not display it in the Preview pane. 

Lotus Notes 

New mail window not inheriting multi -row toolbar from parent 
When Notes 8 mail opens a new window, that window does not inherit multiple row toolbars from the 
parent window. The following example illustrates this behavior. 

1. Start Lotus Notes 8.
2. Change to a new window theme by clicking File > Preferences > Windows & Themes. 
3. Add two toolbar sets, for example Navigation and Address. The toolbars appear on a second row. 
4. Open Mail and create a New mail message. 

The new mail message displays a single toolbar row, regardless of the toolbar display in the parent 
window. 
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Lotus Notes 

New window instance created each time Mail document is opened 
When you open a Lotus Notes 8 Beta client mail message from the Inbox, it opens in a new window, tab, 
or grouped tab, depending on your preference setting. If you return to your mail Inbox and double-click 
that same message, it opens in another new window, tab, or grouped tab.  Instead, this action should 
redisplay the already open instance and give it focus. 

Lotus Notes 

Radio buttons in Rule folder for Notes Standard are icons 
In the Tools/Rules folder in the left navigation panel, select a document rule, then single-click the radio 
button to Enable or Disable it.  In Notes 8 Basic, you can toggle them on and off by clicking them. In Notes 
8 Standard, however, they are not buttons but icons, so clicking on them doesn't do anything. 

Workaround 
Open the Rule form to change the Enable/Disable status, then save it; the radio button can then be 
refreshed.  Or, go to another folder or view, then come back to the Rule folder. 

Notes client on Linux issues 

Lotus Notes 

Accelerator key issues 
Some Accelerator keys are invalid in the Notes client running on Linux.  For example, in the "Choose 
SmartIcons Set" dialog box the "Alt + t" accelerator key sequence does not work.  Or, in the Notes Basic 
Client, the configuration item  "Alt+n, e, or d" do not work. 

Lotus Notes 

Add Bookmark dialog does not display choosing Create  - Bookmark 
Choosing Create -> Bookmark from the menu does not take effect when creating a bookmark for a 
document in a Notes application. Instead, click the document content before choosing Create -> 
Bookmark; then, the "Add Bookmark" dialog will be shown. 

Lotus Notes 

Adding actions for Hotspot issues 
The "@Function Formula" choice is missing when adding an action in the Action HotSpot dialog.  
Additionally, you cannot mark a simple action with the mouse in an editor.  After marking, pressing the 
Edit Action button causes only the Add Action dialog to display. 

142 



IBM Lotus Notes, Domino, Domino Designer 8	 Release Notes 

Lotus Notes 

Appearance issues 
The appearance of some items in the Notes client on Linux may differ as follows: 

1.	 The Inbox, Calendar, and Contacts views have different appearances than other database views 

2.	 The Notes windows on Linux have similar appearances as on Windows operating systems, but may 
have different styles than other Linux applications, especially in some advanced window manager 
systems, for example XGL.  Some Notes dialogs have no 3-D effects when they are being dragged by 
a mouse in an XGL-enabled desktop 

3.	 The Open File dialog is different than the standard dialog in GNOME 

4.	 The Attach dialog box does not allow users to sort the file list by any criteria 

Lotus Notes 

Applications menu remains open 
When running Lotus Notes 8 on SLED 10, some menu remain open when others are selected.  For 
example, click Open and then scroll down and hover on Applications; the Applications menu appears to 
the right.  Scroll further down and click Web Browser; the web browser opens but the Applications menu 
also remains open and functional. This behavior may also occur for other Open menu options that launch 
their own menu. 

Lotus Notes 

Arabic dictionary spell check fails 
If you have set Arabic as the default dictionary, and you run spell check, the message "No misspellings 
found" always appears, whether there are spelling errors or not. 

Lotus Notes 

Arabic only displays a single character in Contacts Name 
There is only a single Arabic character displayed in the Contacts Name field.  Placing the cursor over that 
field will display a blank chat dialog. 

Lotus Notes 

Attachment issues 
All Attachments share the same icons.  In addition, a keyview error displays when viewing a .ZIP file or 
unsupported file, and the attachment name is not displayed in the File -> Viewer tab. 

Lotus Notes 

Bookmark.nsf and desktop6.ndk cannot be upgraded from R 7 
The files bookmark.nsf and desktop6.ndk cannot be upgraded from Notes 7 to Notes 8. 

Lotus Notes 

Cannot drag Notes to another workspace if modal dialog is active 
For Notes running on RHEL 5 only, if you drag the Notes icon in the OS task bar from one workspace to 
another while a modal dialog is opened (for example, CTRL+O), only the modal dialog displays in the 
second workspace. The Notes main window is still in the first workspace. 
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Lotus Notes 

Cannot paste chart from Productivity Editors to Notes 
Copying charts from the IBM Lotus Productivity Editors to Notes documents does not work. The menu 
item for pasting is grayed out in Notes. 

Lotus Notes 

Changing location to Online does not always send outgoing mail 
Notes does not always send mail after changing your location from "offline" to "online". 

Lotus Notes 

Checkboxes are missing from Contacts Preferences dialog 
As an example, install Notes 8 as a root user in a Simplified Chinese locale. Edit the 
rcplauncher.properties file and add a '#' character in front of the lines config.notes.7 and 
config.notes.8. Next, log out as the root user and log in as a new user, to launch Notes and open the 
Address Book on Local. if you then choose the "More" drop-down menu and select "Preferences", you 
cannot enable "Synchronize Contacts". 

Lotus Notes 

Clicking document shortcut does not bring client to front 
When the Notes client is running, clicking a Notes document shortcut does not bring Notes to the 
foreground. The document is indeed opened, but the main Notes window is not brought up to the user. 

Lotus Notes 

Clicking down arrow button causes the Regional list collapse 

clicking the down arrow (
Note thatOpen the Preferences window, click "Regional Settings", and expand the Regional profile list.  

) to scroll down causes the list to collapse, however, reopening the list and 
clicking the down arrow then works. 

Lotus Notes 

Configuration wizard issues 
Following are the issues with the Configuration wizard for Notes running on a Linux client: 

1.	 "Finish" and "Next" return the same result. Launch notes for the first time, and complete the 
configuration wizard through the "Additional servers" option. If you then choose either the "Finish" or 
"Next" button, the following processes are the same. 

2.	 The configuration wizard memorizes former Domino server names. Launch and configure Notes for 
the first time, type a current user name and an incorrect server name, then press the "Next" button; 
the error message "User or server name not found in Domino Directory" displays.  If you then choose 
"Previous" to go back and type the correct Domino server name, when you then choose "Next", you 
will see the same error message. 

Lotus Notes 

Context position not correct for MIME mail 
MIME mail body text will not dsplay context in the correct position when right-clicking, in either Preview or 
in opened mail (read mode).  The context pop-up appears on the top-left of the screen. 
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Lotus Notes 

Conversations checked/unchecked status cannot be changed 
The menu item "Conversations" (Actions -> Conversations or Show -> Conversations) check/uncheck 
status is not updated in your mail view after checking or unchecking it. 

Lotus Notes 

Copy/Paste French accented characters to  "Starts with" fails 
Copying French accented characters from the OS clipboard , and pressing Ctrl+V in the Mail database 
Inbox view to launch the "Starts with..." dialog, then attempting to paste the accented characters, will 
display illegible characters. 

Lotus Notes 

Ctrl+F1 does not bring up Help in Getting Started page 
Ctrl+F1 does not bring up Help in the Getting Started page for the Notes client on Linux. 

Lotus Notes 

desktop6.ndk cannot be used on Linux 
The desktop6.ndk file is not compatible with Linux.  The message "Unable to load workspace file: 
desktop6.ndk. The file is damaged, obsolete or intended for a different operation system. Delete the file 
and create a new workspace?" is displayed if using this file on Linux. 

Lotus Notes 

Difficult to recognize French accent in the menu 
French accented characters change as follows: the apostrophe (') apostrophe becomes a dot (.) and the 
caret (^) changes to a dash (-).  The workaround is to change the system theme to a larger font. 

Lotus Notes 

Drag and drop from a view to Notes  8 Open list - SLED10 
You cannot drag and drop Lotus Notes 8 Beta view items such as mail messages or calendar entries to 
the Notes 8 Open list. You also cannot drag and drop a URL from a Web browser to the Open list. 
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Lotus Notes 

Duplicate icons in "Tab1(Workspace)" 
Clicking "Open -> Application -> Tab1(Workspace)", shows duplicate icons, as in the picture below: 

Lotus Notes 

Embedded editor does not display scroll bar in bi -di format 
The embedded editor will not display the scroll bar if the following two conditions are met: 

1.	 The embedded editor property "Disable scroll bars " has been used to adjust the editor's width and 
length, to make it display vertical and horizontal scroll bars. 

2.	 In the user preference setting File - Preferences - User Preferences - International - Bi-directional, the 
"Support right to left languages " option is set to "Right" for 'Menu direction'. 
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Lotus Notes 

Exit/Launch issues 
Install Notes as a root user. Select an install path with a blank (for example, "/opt/ibm/lotus/notes test"). 
Log out as root and log in as a normal user. Notes will not launch and the error message "Failed to login" 
displays. 

Notes libraries are installed with incorrect SELinux labels on RHEL 5.  To work around this issue, change 
SELinux setting to "Permissive", restart the machine, launch Notes, and set "Troubleshoot browser" to 
list labels. 

When launching Notes, the password dialog appears. Selecting "Exit Notes" and clicking the OK button

displays an error message:


Lotus Notes 

File type with DBCS unreadable when selecting a GIF file 
When you have installed Lotus Notes 8 in a DBCS locale, for example Simplified Chinese, and you then 
open choose View - -> Image Resource -> New from a document, the display is readable before you 
select any .GIF file, but will become unreadable after selecting a .GIF file. 

Lotus Notes 

Focus is lost under some conditions 
In Notes, open a mail message from Activities, and click the "Open Original Email" button to open the 
original mail.  Press <ESC>, and the original mail is closed, but the tab bar loses focus. Clicking <ESC> 
again will not close the current page. 

In addition, for the Locate Object dialog, focus is taken from CAE and is given to the main Notes client; 
focus is not returned to CAE even after closing this dialog. 

There are some unnecessary screen refresh events due to unexpected focus changing. 

Lotus Notes 

Font list dialog box closes 
The Font list dialog box closes automatically when changing the scroll bar. 
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Lotus Notes 

Frame should be invisible when deselecting Search , Launcher

If you choose the "Create a new Home Page button", select "My Work", click "Next" and, on the Basic tab, 

deselect the "Search" and "Launcher" checkboxes, the Home page is created with a gray screen frame, 

and a message "Unable to load frame's content: Unable to display element, database does not contain 

design element".


Lotus Notes 

Frame title may not display correctly 
If you exit Notes with an application opened, and then restart Notes, the frame title may not be displayed 
normally, and the frame size cannot be changed, as shown below: 

Actual: 

Expected: 

Lotus Notes 

Help document does not work in some conditions 
The Help for Rich Text Lite fields does not work, and the "?" icon on the Mail view toolbar does not 
function. 
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Lotus Notes 

High Contrast mode is not automatically detected by Notes client 
If a user selects a High Contrast theme in the System Control Center, the Notes client does not 
automatically detect and use the high contrast resolution when running on SLED10. 

To use the Notes client on Linux with high contrast, first select the high contrast theme in the System 
Control Center. Then, from the Notes client, select File -> Preferences -> Windows and Themes.  Select 
'Operating System Theme' in the Theme drop-down list.  Click Apply, OK.  Exit and then restart the Notes 
client. 

Lotus Notes 

Home page issues 
Following are the issues using the Home page in the Notes client on Linux: 

1.	 An error message displays when loading a Home page that contains a web

page


2.	 The message "Unable to load frame contain" displays if the Home page is created without the

Search and Launcher frame


Lotus Notes 

Import Chinese characters from HTML fails 
Importing from an HTML document with a Simplified Chinese character set, such as gb2312 and 
gb18030, results in the Chinese characters becoming unreadable. 

Lotus Notes 

Import/Export French text to RTF fails 
Copying French text and pasting it to the body of a message, then exporting that message to Microsoft 
RTF format, unreadable characters will be exported. The reverse is also true, importing from RTF to 
Notes. 

Lotus Notes 

Installation issues 
Following are the installation issues using the Notes client on Linux: 

1.	 Installer halts at 7% for a long time 

2.	 Installer does not add product information to the RPM database 

3.	 There is no support for installing more than one instance of Notes on the same OS 

4.	 There is no support for incremental installation 

5.	 After upgrading the Notes client, the JVM directory does not give permission to "others". 

Lotus Notes 

Intermittent text displays when scrolling mouse 
Open a document in Edit mode, and scroll the mouse wheel continuously.  Note that text appears and 
disappears as you are scrolling the mouse wheel. 
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Lotus Notes 

Launcher pane failure for language file name 
If you drag-and-drop an application with a language file name (DBCS) from the Linux desktop to the 
Launcher pane, the application is unable to be launched when double-clicking the application icon. 

Lotus Notes 

Linux: Can't drag/drop URL from external browser to open list 
Using Notes on SLED 10 and RHEL5, you cannot drag and drop a URL from an external browser to the 
Notes Open list. For example, you cannot  drag and drop a URL from a Mozilla Firefox browser to the 
Notes Open list. 

Lotus Notes 

Mail navigator folder issues 
Users are unable to rename folders using Actions -> Folder Options -> Rename in the mail menu.  
Additionally, long folder names are truncated after resizing the mail navigator. 

Lotus Notes 

Mail template must be later than April  26 
There are intermittent issues when trying to load the mail and calendar applications if using previous mail 
templates earlier than April 26. Replacing the template design is required to update to the current beta 
release. 
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Lotus Notes 

Navigator colors are off when resizing Discussion application 
Open a discussion application, move the mouse pointer to drag and resize the navigator, and you will see 
the following: 

Lotus Notes 

No flag for misspelled words that contain an accented character 
An incorrectly spelled word that contains an accented character is not flagged, and does not display the 
Spell Check dialog for suggestions. 

Lotus Notes 

Not able to switch locations in language locale 
Install Notes 8 as a root user in a language locale, edit the rcplauncher.properties file, and add a 
'#' character in front of the lines config.notes.7 and config.notes.8. If you then log out as root, 
and log in as a new user to launch Notes, the Edit Locations menu is displayed instead of Online, and the 
drop-down menu does not work. 
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Lotus Notes 

Notes crashes if Action Bar Height is set too high 
Switching to the Action Bar Size tab, choosing "Expand Bar Height", and putting a large value such as 
Fixed.Input 65533 into the 'Pixels' field will cause Notes to crash. 

Lotus Notes 

Notes embedded windows are white in XGL mode 
Using Notes with XGL enabled, open the TeamRoom application and go to the "Announcement" view.  If 
you then choose ALT+C and "A" to create a new agent, and close without saving, all Notes embedded 
windows are white. 

Lotus Notes 

Notes fails to launch in any language locale 
Install Notes as a root user, then edit the 
/opt/ibm/lotus/notes/framework/rcp/rcplauncher.properties file, and change 
"config.notes.8=en_US" to "#config.notes.8=en_US". Also change "config.notes.7=-nl" to 
"#config.notes.7=-nl", and save the file. Next, change the OS locale to any non-English locale. 

If you now reboot and log back in as a common user, when you attempt to launch Notes, it displays the 
message "An error has occured. See the log file 
/home/USER/lotus/notes/data/workspace/logs/error-log-0.xml." 

Lotus Notes 

Notes files are left in temporary folder after uninstall 
Some Notes-related files will be left in the /tmp directory after uninstalling Notes. 

Lotus Notes 

Notes not launched if switched to German locale 
As an example, install Notes in a Simplified Chinese locale as a root user, and then log in as a user with a 
German locale to launch Notes.  Notes will not run successfully, but no error message is displayed. 

Lotus Notes 

Open document may not get focus when using new window mode 
When using the Window Management theme "Launch each document in its own window", the focus may 
not be restored to a document window if it's already open in a new window.  When attempting to open the 
document, it may appear as if nothing is happening.  Move or minimize the main application window to 
find the open document behind the main window, or find the document window in the system tray and 
click on it to restore the window. 

Lotus Notes 

Overall performance on Linux worse than on Windows 
Overall, performance is still worse running Notes 8 on Windows than on Linux, especially startup and exit 
speed. The startup speed may be quite low on a Linux system with many fonts installed. 
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Lotus Notes 

Preferences dialog issues 
Following are the issues using the Preferences dialog in the Notes client on Linux: 

1.	 Invisible port names "Serial 1" and "Serial 2" are displayed in Notes Ports 

2.	 "Calendar and To Do" pane is not responding when switching from Notes Ports 

3.	 Opening Calendar and To Do to resize the Preferences window is slow 

4.	 "Mark documents read when opened in preview pane" under 'Additional

Options' in the Notes Basic Client cannot be checked as an option


5.	 Modeless Notes dialog boxes do not block Java controls in the Preference dialog; users can still

select Java items from the Preference dialog


Lotus Notes 

Preview icon missing on Linux client 
For Lotus Notes 8 on a SLED 10 Linux client, the Preview icon is incomplete or missing from the Show 
action drop-down menu in the Mail view. 

Lotus Notes 

Print issues 
Following are the print issues using the Notes client on Linux: 

1.	 All pages are printed when the "Current Page" option is checked 

2.	 Print speed is slow for documents with multi-fonts or multi-languages 

3.	 Bitmap font print output is noticeably smaller on paper 

4.	 Several font sizes on paper are much bigger than the actual size, including B&H series, Adobe 

Courier, Adobe Helvetica, and Adobe New Century Schoolbook


5.	 Arabic characters of Efont Biwidth and Efont Fixed fonts are much smaller than actual size 

6.	 "Multi-Page Print Preview" displays incorrectly 

7.	 Only CUPS is supported as the printing interface. Other interfaces, like lp, lpr, kprinter, or gtklp, are 
not supported. In addition, performance is bad when printing a large document, and the Notes 
"background printing" feature is not supported at all. 

Lotus Notes 

Redundant words remain on "User Security" page 
The option "Log in to Notes using your operating system login" on the User Security dialog is redundant. 

Lotus Notes 

Regional profile is not set to OS locale as default language 
When installing the Notes client on Linux to any locale, the Regional profile is always set to "English" as 
the default in the Preferences dialog. 
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Lotus Notes 

RHEL 5: System hangs when scrolling a graphic 
Notes hangs when scrolling a document which contains a graphic. 

Lotus Notes 

Search Directory does not display type -ahead 
The Search Directory is not displaying a type-ahead pop-up. 

Lotus Notes 

Simplified Chinese document export issue 
All Chinese characters become illegible in an exported file if the source document contains English 
characters, or contains spaces at the beginning of the document. 

Lotus Notes 

Slow response for Inbox "More - Preferences"

There is a slow response after choosing the action button "Mail - Preferences" from the Inbox.


Lotus Notes 

Some CJK text might be rendered incorrectly 
Some Linux users are accustomed to setting English (en_US) as the default locale setting, though some 
Chinese, Japanese, or Korean text might be rendered incorrectly. This also happens on Windows if the 
system code page is not a Chinese code page. 

To avoid this kind of issue, users may switch the system locale to a Chinese locale, for example 
zh_CN.UTF8. 

Lotus Notes 

Some file types cannot be imported into an RTF field

Microsoft Word, WordPerfect 5.x, and WordPerfect 6.0/6.1 files cannot be imported into an RTF field.  

Additionally, there is not an option for "Lotus Word Pro" in the FileType list when importing a file.  Also, 

importing a PNG file causes a keyview error; the PNG file cannot then be imported after accepting the

keyview error message.


Lotus Notes 

Some Japanese documents will not be printed correctly 
While most documents will be printed correctly, at times they may display illegible characters. 

Lotus Notes 

Some options do not work in Rich Text Lite fields 
Java applets, embedded views, and the DatePicker do not work in Rich Text Lite fields. 
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Lotus Notes 

Summarize and Show Time Slots are duplicated 
Duplicated menu items "Summarize" and "Show Time Slots" exist in the Calendar formatting drop-down 
menu. 

Lotus Notes 

Text alignment and cursor positioning issues 
When editing a document, tabbed text may realign itself with the margin temporarily, and then return to 
the correct position. Also, using the scrollbar may result in the text content of the note becoming 
unreadable. Additionally, placing the cursor using the mouse may result in strange behavior where the 
vertical bar cursor is actually where you've placed it, but the vertical bar cursor drawn on the screen is in a 
different place. 

Lotus Notes 

Thumbnail image display of open mail documents 
The thumbnail image of various Notes 8 open documents or views on Linux is not always correct.  For 
example, if you have a Home, Getting Started, Mail - Inbox, and several mail messages open, and you 
then click Windows > Show Thumbnails, some of the thumbnail images may display content from pages 
other than their own. 

Lotus Notes 

Two Preference items cannot be saved 
The "Table Properties" and "Mobile" settings in the Toolbar pane of the Preferences dialog cannot be 
saved. 

Lotus Notes 

Unable to paste Notes application link on Linux desktop 
Notes application link shortcuts cannot be pasted on to a Linux desktop client. 

Lotus Notes 

Unexpected characters in  "Smartcard Configuration " dialog box 
In User Security, select "Your Identity/Your Smartcard"; the "Smartcard Configuration" dialog box pops 
up. Note that there are unexpected characters in the dialog box, as shown below: 
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Lotus Notes 

View design issues 
Following are the view design issues using the Notes client on Linux: 

1.	 No message appears when switching style from "Standard Outline" to 

"Calendar" in View Properties.


2.	 Private View design displays incorrectly; for example, dragging a column to

change its order, the Date and Topic column contents becomes disordered (see 

below). Restarting Notes will cause the private view to display correctly.


Lotus Notes 

"Show Java Debug Console" menu option missing 
The "Show Java Debug Console" menu option under 'Tools' is missing. 

Lotus Notes 

"Table Rows" tab may not be refreshed 
The table property tab "Table Rows" is not refreshed at times, when switching from "Show only one row at 
a time" to "Show all table rows". 

Programming issues 

Domino for System i 

System i: JVM crash trying to create Double object from String 
The JVM crashes when trying to create a Double object from a String.  To workaround this issue, please 
load and apply PTF 5722999 MF40560- LIC-INCORROUT I5/OS PASE FLOATING-POINT RESULTS. 
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Roaming User issues 

Lotus Notes 

Roaming User issues and cleanup functionality 
There are outstanding issues with the Roaming User functionality in the Notes 8 basic configuration* 
which prevent new use instances of a Roaming User setup.  Since the "Cleanup" functionality is 
dependent upon Roaming User, this functionality is also affected. 

* Please note that Roaming User is not supported in Notes 8 in its standard configuration. 

Workaround 
Do not create new Roaming Users. 

Search issues 

Lotus Notes, Domino Server 

Double quotations needed for searching DBCS 
The Notes 8 web query syntax for Search now causes a need for double-quotation marks to search for 

DBCS entries. 

Lotus Notes 

Error occurs in Notes IPC Asynch Message processor 
When searching some applications, the following error may occur: 

"An internal error occurred during: "Notes IPC Asynch Message processor 
(16)".java.lang.NullPointerException 

Workaround 
Switch the tab view and resubmit your search. 

Lotus Notes, Domino Server 

Number fielded query needs parentheses 
A number fielded query is not handled properly without parentheses.  If there are no parentheses, then 
the "Query is not understandable" message is displayed. Be sure to use parentheses around the number 
fielded query, for example, ([Number1]>2). 
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Lotus Notes, Domino Server, Domino for System i, Domino for System z 

Search issues using Autonomy KeyView filters

Following are the issues with Search ans the Autonomy KeyView filters:


z	 AutoCAD (DXF) and Autodesk Drawing (DWG) files are not filtered properly 

z	 Microsoft Outlook Personal Folders and MIME attachments are not able to be filtered 

z	 PDF logical reading option block searches English words when English and Hebrew are in the same 
line 

z	 Some Amipro file types are not able to filter properly on UNIX/AIX/Solaris 

z	 Cannot find some OpenOffice-formatted files with the KeyView filters. 

Lotus Notes 

Search results in Mail views 
When executing a search in the Mail views, all results will come back highlighted.  If the user selects a 
single document, it will still show that everything is selected, but the preview shows the top document from 
the selected list, upon refresh. 

Lotus Notes 

Search view in local Mail file may display duplicate items 
at times, the Search result in a local mail file will display duplicate items.  To work around this issue, clear 
Search, and submit the Search with mail server replication. 

Domino Server, Domino for System i 

System i: Summary information for Domain Search not displayed

Domain Search Results for File Systems are not displaying the Summary information for PDF File Types.  

On System i (i5/OS), the name of the PDF files is displayed instead of the Summary information.


Security issues 

Lotus Notes 

Invalid key format error when exporting a key to a token

When attempting to export a private key from the ID file onto a smartcard or other cryptographic token, 

you may receive a "The cryptographic key's format is invalid" error.  This occurs when the key is in a 

format that cannot be exported to a smartcard, such as a classic (630-bit) Notes key, or a key that has 

already been exported from the ID file onto a smartcard.
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Lotus Notes 

Problems using Entrust certificates on smartcards 
When using pre-loaded certificates and keys stored on smartcards, Notes/Domino follows the "PKCS#11: 
Conformance Profile Specification" for RSA Asymmetric Client Signing, which specifies a set of attributes 
that must be in the keys and certificates, and a set of functionality that must be supported by the 
smartcard and smartcard software. In particular: 

"A unique non-null CKA_ID value exists and has proper associations for all keys and certificates." 

Some certificate authorities, including a number of Entrust CAs,  may generate certificates and keys that 

contain a null (zero-length) CKA_ID attribute. This bug has been reported to Entrust, where it is being

tracked as "SR 1-44960142".  Future releases of these Entrust CAs may fix this problem. 


Attempting to import these certificates with Notes clients before 7.0.1 will result in an "Illegal null

parameter passed to security function" error. 


 A workaround has been added to 7.0.1 and this beta release to find, import, and use these noncompliant 
certificates and keys, with several caveats: 

z	 The first import attempt will only find and import compliant certificates and keys. Subsequent imports 
will find and import noncompliant certificates of this type, if any private RSA keys with a null CKA_ID 
attribute were noticed during the first import attempt. 

z	 The ID file must be smartcard-enabled; the mode of operation added in 7.0 to allow certificates to be 
imported and used without first smartcard-enabling the ID file cannot be used with these certificates 
and keys. 

z	 The "Lock ID with Key on Smartcard" functionality is not available when using these noncompliant 
certificates and keys. 

z	 These non-compliant certificates must be imported in order to be used; the new functionality added to 
7.02 and this beta release to allow use of certs without first performing an "Import Internet Certificate 
from a Smartcard" action is not supported. 

Lotus Notes 

Unable to send encrypted MIME mail addressed to a group 
For a group of users who use MIME (in the user's person document "Format Preference for incoming mail 
= Prefers MIME" ia set), some users are set up to read their mail from browsers, and some from a Notes 
client. 

If you send an unsigned, unencrypted mail to a group containing these MIME users, the mail is received

by all users.
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If you send encrypted mail to the group containing these MIME users, when the mail is created, 
encrypted, and the "Send" button is pressed, the following message appears: 

Note that the group is treated like a single user for finding certificates, instead of being expanded to show 
multiple users. 

Server issues 

Domino Server, Domino for System z 

Automatic server restart on Domino on Linux for System z 
This release note only applies if you are running Domino on Linux for System z using SUSE Linux 
Enterprise Server (SLES) 10 or Red Hat Enterprise Linux (RHEL) 5. 

SuSE Linux Enterprise Server  (SLES) 10 on Linux for System z : 

The Automatic Server Restart feature after a crash does not work without the following package being 
installed: 

z ksh-93r-12.25.s390x.rpm 
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Red Hat Enterprise Linux  (RHEL) 5 on Linux for System z : 

The Automatic Server Restart feature after a crash does not work, due to Red Hat Issue Tracker 116193. 
There is currently no fix for this problem.  The following workaround is available: 

Edit the startup shell script and change the first line to:

#/bin/bash


or to change to bash as the default shell script. 

Domino for System i 

CFGDOMSVR OPTION(*ADD) fails when NABSVR contains IPV 6 address. 
Problem Description 
Configuring an additional (*ADD) Domino server fails when the NABSVR keyword contains an IPv6 
address. 

The more likely scenario for this to happen is when you have a *FIRST Domino server that is only 
configured to use IPv6 and you want your additional Domino server to get the Domino Directory from that 
server. In this case, when configuring your additional Domino server using CFGDOMSVR, you can 
specify an IPv6 address for it but, during its configuration, there is no way to activate IPv6 because the 
TCP_EnableIPv6=1 line is not added to the Notes.INI file.  Note that to add that line to the Notes.INI file, 
you have to edit it manually, and it cannot be done while the CFGDOMSVR is running. 

Workaround 
Configure an IPv4 port on your *FIRST Domino server and use it in the NABSVR keyword when 
configuring your additional Domino server. 

Domino for System i 

Database name with extended characters is not displayed 
TM

With i5/OS V5R4 and the HTTP (powered by Apache ) Domino plug-in based on WebSphere 6.0.2.3 
(PTF SI19429), the following error is displayed on the Web browser when attempting to load a URL that 
contains a Domino database name with double-byte or other characters that are not a-z and 0-9 (for 
example, 删除.nsf, Å.nsf or Ë.nsf). 

HTTP Web Server: Unknown Command Exception

[/%E5%88%A0%E9%99%A4.nsf/(/All)?OpenView]  


The same URL/Domino database name is successfully served using Domino HTTP via Domino Web 
Access. 

Domino Server 

Disregard Java error during Domino JVM startup 
During the startup and initialization of Domino's JVM, you may see the following Java error, which can be 
disregarded: 

RunJava JVM: java.lang.NoClassDefFoundError: 
com.ibm.websphere.management.configservice.ConfigService 

This is not a fatal error, and this package is not needed for server stability or performance.  This error will 
be removed in a future release. 
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Domino for System i 

HTTP crash when same port used by IPV 4/IPV6 servers 
The HTTP task of a server that is configured to use IPV6 will crash if the HTTP port is already in use by 
another server that is configured to use IPV4.  

Workaround 
In the Domino Directory, specify the host name(s) with an IPV4 or IPV6 address, and then enable "Bind to 

host name". 

Domino Server 

IMAP enabling a mail file on a transactional logged server 
There is a known issue when IMAP enabling (convert -e) a mail file on a transactional logged server.   The 
following console messages may be displayed depending on the size of the mail file to enable: 

Cannot write to log file: Recovery Manager: Log File is Full, try again later 
05/18/2007 05:11:59 PM  Mail Convert Failed on mail\test: Error enabling NSF 
support for IMAP: Recovery Manager: Log File is Full, try again later 

A potential workaround is to use a non-transactional logged server for IMAP enablement.. 

Domino Server 

Linux: Running NSD manually can cause Domino to crash 
Do not run NSD manually for Domino on Linux or Domino can crash.  This is caused by a known problem 
with gdb, and has been reported (reference Bugzilla report numbers 33787 and 33780). 

Domino for System i 

System i: Daylight Savings Time change not recognized 
You must end and restart your Domino server when the system value QTIME is updated. The Domino 
server will not automatically sense the Daylight Savings Time change. 

Web Services issues 

Domino Designer, Domino Server 

Deprecated Web Service methods in LSXSD .LSS 
The following class methods in the supplied LSXSD.LSS file for LotusScript Web services are deprecated 
for lacking time zone handling. 

XSD_DATE -- SetValueFromNotesDateTime

XSD_TIME -- SetValueFromNotesDateTime

XSD_DATETIME -- SetValueFromNotesDateTime
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As delivered, their original behaviors in LSXSD.LSS are retained for backward compatibility, however, the 
following new methods are added for Domino 8.0 in order to supply time zone handling: 

XSD_DATE -- SetValueWithZoneFromNotesDateTime

XSD_TIME -- SetValueWithZoneFromNotesDateTime

XSD_DATETIME -- SetValueWithZoneFromNotesDateTime


If needed, the older, deprecated methods can be modified to call the newer, "WithZone" methods. 

Domino Designer 

Importing WSDL containing xml :lang types 
Element "type" attributes with a value of "xml:lang" in WSDL schema definitions are rejected during WSDL 
import for lack of a mapping to an implementation type.  This may be addressed in a future release. 

Domino Designer 

Web services and Agents should have unique names 
Web services and Agents should have unique names, otherwise it is possible that the agent would be 
invoked via the ?OpenWebService URL, instead of the intended Web service. 
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Documentation updates 

Notes Client Help 

Lotus Notes 

No context help for programmer pane in Notes client 
When creating a button that is a hotspot, a programmer's pane opens in the Notes client. There is no 
context-sensitive help (F1, or clicking the Help button) in this pane. 

For help with Designer commands or formulas, or for more information about creating a button, see the 
IBM Lotus Domino Designer 8 Help. To download or view Lotus Domino Designer 8 Help, go to Lotus 
Documentation on the Web. 

Lotus Notes 

Web Style Query 
The new default for view searches is "web style" syntax, meaning that if the user searches several words, 
the documents returned contain those words, but not necessarily in order.  This is a change from the 
current Notes syntax; to search exact terms, quotation marks are now needed. 

In effect, the AND operator will be placed between all query terms, including those terms using operators 
such as NOT, ACCRUE, etc.  If the user types AND or OR (or the symbol equivalents) between two 
words, it will not be added. 

Commas continue to mean ACCRUE, and will be left in the web query. 

If an operator is given in lowercase (accrue, matchinglevel, exactcase, topic, etc.), it will become quoted 
to find the actual term instead of using it as an operator.  Operators must be in all uppercase in order to 
apply properly. 

The exception to this rule is the "common word" operators such as AND, OR, and NOT.  They do not 
have to be in uppercase. Please note that NOT, however, is not an operator, so if the word NOT, in any 
case, precedes a word without a needed operator, AND will be added, for instance (lotus not ibm) => 
(lotus and not ibm). 

Wildcards (* ?) will be passed through to a web query. 

Finally, the symbols + and - will mean AND and NOT, respectively. 

To turn off web-style query and use the old Notes query syntax, you can set the following Notes.INI 
parameter: 

UseFTSyntaxOnly=1 
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You can also turn off web-style query from the UI.  In the Notes client, choose File -> Preferences -> User 
Preferences, Basic tab, and make the change as shown below: 

There is also an "escape character" for web queries.  If the user uses a forward slash (/), that parameter 
will not make it into a web query. 
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Domino Administration Help 

Lotus Notes, Domino Server 

Allowing diagnostic data to be sent to IBM 
When the IBM Lotus Notes client (Basic configuration)  or IBM Lotus Domino server is restarted after a 
server crash, diagnostic information about the crash is collected from the Notes System Diagnostics 
(NSD) and other files. This feature is enabled by default for the Notes client, and you can enable it on the 
Domino server. No attachments or confidential customer information are collected. The following 
information is collected: 

z Client/Server Name 

z Notes/Domino Version 

z OS Version 

z Start Time 

z Crash Time 

z Uptime 

z User Comments (for clients) 

z Error message 

z Process 

z Callstack 

z Open Databases 

Enabling the Send to IBM feature on the Domino server 
To enable the Send to IBM feature on the Domino server, add the following setting to the Domino server's 
Notes.INI file: 

CRASH_SENDTOIBM=1 

When the Notes.INI setting CRASH_SENDTOIBM=1 is set on the server, no additional configuration is 
required. When the server restarts after a server crash, diagnostic information is collected and an email is 
sent to IBM. 

Send to IBM feature on the Notes client 
When a Notes client end user restarts their client after a crash, one of the following behaviors occurs 
depending on whether the Send to IBM feature is enabled and Automatic Diagnostic Collection (ADC) 
prompting is enabled. 

Send to IBM feature 
Enabled 

Enabled 

ADC prompting 
Enabled 

Disabled 

Result 
The Notes client end user is prompted to specify whether to 
send a diagnostic report to their company administrator and to 
IBM. The Notes client end user also has the option of viewing 
the report. 

A dialog box displays information to the end user that a 
diagnostic report will be sent to their company administrator. 
The end user is also prompted as to whether they would like to 
send a diagnostic report to IBM. 
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Send to IBM feature ADC prompting Result

Not configured 
 A diagnostic report is not sent to the company administrator but 

the Notes client end user is prompted to specify whether to 
send a diagnostic report to IBM. 

Disabled or The Notes client end user sees no messages or prompts 
enabled with no regarding diagnostic collection and reporting. A diagnostic 
prompting report is sent to the administrator. The end user could be 

prompted for comments if the administrator configured the 

Enabled 

Disabled 

feature to do so. 

To disable the Send to IBM feature on the Notes client, add this setting to the Notes.INI file on the Notes

client:


DEBUG_CRASH_SENDTOIBM_DISABLE=1 

Domino Server 

Calculating user licenses - documentation correction 
The Domino Administrator documentation contains the topic "Calculating the number of licenses in use." 
Step 3 of the procedure in that topic contained incorrect information. The corrected procedure is shown 
here: 

Calculating the number of licenses in use 
Use this procedure to recalculate the number of Notes and/or Domino Web Access users in your domain. 
A document is created for each server in your domain, listing the number of Notes and Domino Web 
Access users on each server. 

1.	 From the Domino Administrator, click the "Files" tab. 

2.	 Open the Domino User License Tracking database. 

3.	 Choose 'Active Users - By Server', or choose 'All Users - By Server', and then click "Recalculate 
Licenses". 

Domino Server 

Compact -C option not supported for DB 2-enabled Notes databases 
Compact -c is not supported with DB2-enabled Notes databases, in this Domino 8 release. 

Domino Server 

Domino and Microsoft Cluster Server 
Domino can be run on a Microsoft Cluster Server as long as the recovery configuration for Domino (auto 
restart and the recovery configuration for Microsoft clusters), do not conflict. 
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Domino Server 

Domino server time settings 
This release note applies to the topic "Preventing incorrect system time changes" in the Domino 8 
Administrator documentation. 

If the Restart_Time_Interval is set in the Notes.INI file and the difference between the OS Time and the 
Last_Domino_Time exceeds the Restart_Time_Interval, the Domino server will not restart.   The following 
parameter will be added to the Notes.INI file: 

LAST_DOMINO_TIME_ABORT= 01/23/2007 11:18:10 AM Startup aborted: Excess restart time interval. 

Workaround 
To prevent the Domino server startup from aborting when you attempt to start it, type a colon or a 
semicolon in front of the parameter LAST_DOMINO_TIME_ABORT. For example, use either the colon or 
the semicolon as shown below: 

:LAST_DOMINO_TIME_ABORT= 01/23/2007 11:18:10 AM Startup aborted: Excess restart time 
interval 
;LAST_DOMINO_TIME_ABORT= 01/23/2007 11:18:10 AM Startup aborted: Excess restart time 
interval 

Domino Server 

Filtering DDM events

The Domino 8 Administrator documentation contains the topic "Filtering DDM events".


The last sentence in the second paragraph of that topic has been corrected as follows:


Incorrect sentence :

New DDM filters are applied to new events that are generated after the Filter document is saved.


Corrected sentence :

New DDM filters are applied to new and existing DDM events after the Filter document is saved.


Domino Server 

Limited support for LtpaToken  2 
The Domino server supports the new format of SSO token, LtpaToken2, which was introduced in the IBM 
WebSphere Server release 5.1.1.  Support for the new token improves security for SSO deployments. For 
this beta release, LtpaToken2  is supported for SSO deployments that include Domino servers only (i.e. 
no WebSphere servers).  If the deployment includes Lotus extended product servers, such as Sametime 
or Quickplace, or if the deployment includes Domino servers running releases prior to this beta release, 
than the SSO configuration must be set for compatibility mode whereby the Domino 8 server will produce 
both LtpaToken2 and LtpaToken. 

Background 
When the Domino Web server is configured to support single-sign on (SSO) session authentication, the 
user logs in to a Domino server and has an SSO token (i.e. a cookie) stored in the browser. This token is 
used thereafter to demonstrate that the user is authenticated. It can be passed by the browser to other 
Domino servers in the SSO configuration as proof of authentication. When the user has a valid token, 
servers that the user tries to access do not reprompt the user for a password. 
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Prior to this release, Domino supported two token formats (Domino-only format LtpaToken, and 
WebSphere-compatible format LtpaToken). The new token format, LTPAToken2,  is a new type of 
WebSphere-compatible token.  Similar to the classic LtpaToken,  the new LtpaToken2 represents the 
logged-in user. 

Domino features that involve the use of SSO tokens, including the LtpaToken2, such as HTTP SSO 
caching of Internet password changes or SSO name mapping, will work with the new token format for 
Domino-only SSO deployments. 

Domino Server 

Modifying the Action field in the ACL dialog box 
The Access Control List (ACL) dialog box for Notes NSF databases contains an Administration Server 
field and an Action field on the Advanced panel. Use caution when modifying these fields. The Access 
Control List dialog box is accessed by choosing File - Application - Access Control from the menu bar of 
an open NSF. 

NAMES.NSF - Domino Directory 
By default, the Action field for the administration server for the Domino Directory is set to "Do not modify 
names fields." Do not change the Action setting for the administration server for the Domino Directory. 
The purpose of this setting is to allow the Administration Process to update names (people, group, or 
server names) in critical areas of a database. The Administration Process automatically manages the 
names in the Domino Directory. Changing the Advanced ACL setting for this database causes the 
removal of names which are critical to other Domino features, for example, mail routing and calendaring 
and scheduling. 

ADMIN4.NSF - Administration Requests database 
The Administration Requests database (ADMIN4.NSF) is a log database from which documents are 
routinely purged. If you set the Action field on the ACL dialog box to anything other than "Do not modify 
names fields," you may cause performance problems when the Administration Process (adminp) 
processes requests. This does not apply to cross-domain administration requests. 

Lotus Notes, Domino Server 

NSD now runs as a Microsoft Windows service 
Some Windows configurations prevent NSD from gaining access to the required information needed to 
collect diagnostic information.   For example, Restricted Users in Windows XP is such a configuration. In 
this configuration, manually installing NSD as a Windows service to allow NSD to access the required 
information.  In this Beta release, even with NSD installed as a Windows Service on Microsoft Windows 
Vista,  NSD will report multiple "access denied" errors. 

You can manually install NSD as a Win32 service.  When NSD is registered as a service, you can enter 
commands to start or stop the service, trigger NSD processing, generate status and trace messages, and 
request status information that can be written to the server console or to a log file. You can also uninstall 
the NSD service. 

Enter all NSD commands from a Windows console window. For example, to install the NSD service,  
open a Microsoft Windows console window, navigate to the location of the Notes.INI file, and enter the 
following command: 

nsd -svcinst
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Installing the NSD service 
Use this command to install the NSD service: 

–svcinst 
Installs the NSD Win32 service. Once installed and started, Notes and Domino fault recovery will use the 
Win32 service for all attempts to invoke NSD. 

Note that –svcinst only installs the service; it must be started separately, either by running NSD –svcstart, 
by using the Services control panel applet to start it, or by rebooting the system, in which case the service 
will start automatically. The install command registers  NSD as a Win32 system service. 

This option is only useful for situations where the service has previously been uninstalled and is only 
available on Windows versions of Notes and Domino. The -svcinst command is usually paired with 
-svcstart, which starts the service. For example, enter the following: 

nsd -svcinst -svcstart


Starting and stopping the NSD service 
Use the following commands to start and stop the NSD service: 

–svcstart 
Starts the NSD Win32 service. Once started, Notes and Domino fault recovery will use the Win32 
service for all attempts to invoke NSD. 
This option is only useful when the NSD Win32 service is installed and not started. It is only available 
on Windows versions of Notes and Domino. For example, enter: 

nsd -svcstart


–svcstop 
Stops the NSD Win32 service. Once stopped, Notes and Domino fault recovery will run NSD as a 
child process for all attempts to invoke NSD. 

This option is only useful when the NSD Win32 service is installed and started. This option is only 
available on Windows versions of Notes and Domino. For example, enter: 

nsd -svcstop


Using the NSD service 
Use the following commands to manage the NSD service. For example, you can generate status and 
trace messages and request status information that can be written to the server console or to a log file. 

–svclog 
When specified with another service option (svcinst, etc.), this option causes status and trace 
messages to be appended to a log file named "nsdsvc.log" in the data\IBM_TECHNICAL_SUPPORT 
directory. 
This option is only useful when specified with another service option and is only available on Windows 
versions of Notes and Domino. For example, enter: 

nsd -svclog


–svcreport 
Requests status information about the NSD Win32 service from Microsoft Windows, which is then 
written to the console (stdout), and appended to the nsdsvc.log file (if –svclog is also specified). This 
option is only available on Windows versions of Notes and Domino. For example, enter: 

nsd -svcreport
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Uninstalling the NSD service 
The uninstall command unregisters NSD as a Win32 system service. NSD -svcuninst does not remove 
any files from the system. 

Use the following command to uninstall the NSD service: 

–svcuninst 
Uninstalls the NSD Win32 service. Once uninstalled, Notes and Domino fault recovery will run NSD 
as a child process for all attempts to invoke NSD. 

This option is only useful when the NSD Win32 service is installed  and is only available on Windows 
versions of Notes and Domino. 

The uninstall command is usually paired with the –svcstop command. For example, enter the 

following to stop the NSD service, and then uninstall it:


nsd -svcstop -svcuninst


Domino Server 

NSD output now includes DB2 information 
NSD output now includes DB2 information. 

The first structure is the master pool structure.  There is one per process.  The most useful pieces of 
information here are the connectionCount (number of connections that have been allocated), the 
availableCount (number of connections allocated but not currently in use), and the connected flag 
(1=connected to DB2, 0=disconnected).  In the example below, 300 connections are allocated, and all of 
them are signed out of the pool, but the user is still connected to DB2.  The pool is empty and the limit for 
number of connections the user is allowed to create has been reached. 

-------DB2NSF CONNECTION POOL-------

hashtableSize = 61

connectionCount = 300

connectionCountMax = 300

availableCount = 0

availableLimit = 0

reuseCountLimit = 0

connectionLimit = 300

connectionPrealloc = 225

affinitySize = 5

poolIndex = 4294967295

stats_requests = 154

stats_wait = 154

stats_nowait = 1

stats_affinity_hit = 5

stats_affinity_miss = 30

stats_affinity_fullmiss = 23

resizeCheckInterval = 500

resizeCheckLimit = 200

resizeIncrement = 1

resizeWaitPct = 1

resizeAffinityPct = 10

resizeStatsWindow = 1000

resizeMax = 300

createOnMissingKey = 1

recycleEntries = 1
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keepPoolStats = 1

trackConnections = 0

availableMRU = 0

availableLRU = 0

henv = 1

connected = 1

pid = 5696


The pool entry structure is included in NSD output.  There is one per allocated connection in the pool for 
this process.  The most useful pieces of information here are the connected flag, the callerFileLine (the 
file:line of the first sign-out of the connection for this use), and the lastRefFileLine 0-2 (the file:line of the 
last access of this connection after it was signed out -- typically a lookup call). 

-------DB2NSF CONNECTION POOL ENTRY-------

connected = 1

cleanConnection = 0

inUse = 0

AutoCommit = 1

inTXN = 0

longHeld = 1

NIFConnection = 0

lastaction = 4

allocCount = 0

key = 1

nestingLevel = 0

henv = 1

hdbc = 1

next = 4027603030

prev = 0

this = 4027596832

tranNext = 0

affinityIndex = 5

inAvailableList = 0

refct = 0

allocatedHstmts = 0

reuseCount = 0

pid = 5696

callerFileLine = db2note.c:1426

lastRefFileLine[0] = db2note.c:1426

lastRefFileLine[1] = upschema.c:247

lastRefFileLine[2] = db2note.c:4748


Lotus Notes, Domino Server 

Storing roaming user ID in PAB during user registration 
Due to enhancements made to user registration for Roaming Users, you must now explicitly choose to 
store the roaming ID in the Personal Address Book by choosing the "In personal address book" option on 
the Register Person - ID Info panel (the Register Person - ID Info panel displays during the user 
registration process). Choosing this option causes Notes Client setup to attach the ID to the personal 
address book.  Storing the ID in the Domino Directory is no longer required. 
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Domino Server 

Streaming Cluster Replication 
The current cluster replicator is awakened when something has changed in a database. For each cluster 
replica, the cluster replicator opens the source and destination databases, and determines which notes, if 
any, are worthy of replication, and then replicates the changes.  It does the same for folder and unread 
operations. When complete, the cluster replicator moves on to the next database.  In a high-activity 
server, it is possible that the cluster replicator may get "backed-up" causing it to have a higher replication 
latency. On a heavily loaded and highly active server, it may take longer to replicate all changes for a 
particular database. In addition, the cluster replicator must do a 1-1 replication with each cluster-mate.  

Streaming Cluster Replication (SCR) takes advantage of the fully-connected nature of clusters and data 
streaming to produce a much lower overhead cluster replicator. In addition, SCR decreases the 
scheduled replicator overhead for clusters and can provide a significant reduction in cluster replicator 
latency. As changes occur (Note changes, unread changes, and folder changes), the changes are 
captured and immediately queued to other replicas in the same cluster.  The result is a more efficient 
cluster replication.  

To test the new SCR, you must have two or more Domino 8 Beta servers in the cluster. 

Domino Designer Help 

Domino Designer, Domino Server 

Importing WSDL now generates LotusScript classes as XSD _ANYTYPE 
This release note pertains to Programming Domino for Web applications -> Web services in Domino 
Designer -> Java and LotusScript mappings -> section "Classes". 

Importing a WSDL document into a Domino 8 LotusScript Web service consumer or provider now 
generates LotusScript classes that inherit from the "XSD_ANYTYPE" base class by default, except for 
classes which inherit from "WS_FAULT" instead. Correspondingly, all "XSD_ANYTYPE" base class 
references are suppressed during WSDL document generation. 

Domino Designer, Domino Server 

New properties for LotusScript WS _FAULT class 
For Domino 8, the following SOAP 1.1 properties with access methods have been added to the 
WS_FAULT Web service proxy class in the supplied lsxsd.lss file: 

PRIVATE FaultCode As STRING

PRIVATE FaultActor As STRING

PRIVATE FaultDetails() As NOTESDOMELEMENTNODE
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Domino Designer, Domino Server 

Web Service <any> element mappings - Java and LotusScript 
Domino Designer 8 includes mapping support for the XML Schema <any> element, both during WSDL 
import to a Web service provider or consumer script library, and during WSDL generation from a Web 
service provider implementation. 

Java 
For Java Web service providers and Web service consumer script libraries, importing WSDL 1.1 
documents containing XML Schema <any> elements (including wrapped service operation input or return 
types) will generate those elements as javax.xml.soap.SOAPElement interface types. Alternatively, 
javax.xml.soap.SOAPElement members of Java value type classes generate to WSDL as <any>
elements within sequence elements of some complexType, as will SOAPElement input or return types for 
wrapped Java service operations. 

javax.xml.soap.SOAPElement objects can be instantiated in a Domino 8 Web service through the 
use of the java.xml.soap.SOAPFactory class. Supported SOAPElement operations are those which 
are specified for the javax.xml.soap.SOAPElement interface and its related interfaces in the 
javax.xml.soap package.  The following example illustrates how one might instantiate, populate, and 
return a SOAPElement object in a Domino 8 Java Web service: 

import javax.xml.soap.*; 

public class PortType { 

public SOAPElement getAny() { 
try {
SOAPFactory SF = SOAPFactory.newInstance(); 

"theNamespace" ); 
SOAPElement SE = SF.createElement( "anyPart", "ns", 

Name nam = SF.createName( "xsi:type", "xsi", " 
http://www.w3.org/2001/XMLSchema-instance" );

SE.addAttribute ( nam, "xsd:string" ); 
SE.addTextNode( "The quick brown fox" ); 
return SE; 

} catch (SOAPException se) {


}
return null;

se.printStackTrace();


}

}


LotusScript

For LotusScript Web service providers and Web service consumer script libraries, importing WSDL 1.1. 

documents containing XML Schema <any> elements (including wrapped service operation input or return

types) will generate those elements as NotesDOMElementNode backend class instances.  Alternatively, 

NotesDOMElementNode members of LotusScript value type classes will generate to WSDL as <any>

elements within sequence elements of some complexType, as will NotesDOMElementNode input or

return types for wrapped LotusScript service operations.


NotesDOMElementNode objects can be instantiated in a Domino 8 Web service by using the documented

API's for the NotesDOMElementNode and related backend classes.


WSDL

Generated WSDL <any> elements include the namespace attribute value of "##other", defined by XML

Schema to indicate "not the targetNamespace for the ancestor <schema> element".  This prevents invalid

overlap between namespaces for generated <any> elements and the default namespace for possible

adjacent elements within a complexType, and lessens the need for WSDL fixups and reimporting.
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Domino Web Access Help 

Domino Web Access 

New Delegation and Calendar preferences 
You can set the following new user preferences: 

A new user preference provides an easy way to open another person's Mail, Calendar, To Do, and 
Contacts if you have been given permission to manage them. You can create shortcuts by setting a  
Delegation > Shortcuts preference. The shortcut you create appears as a tab menu option. For example, 
if you are managing another John Doe's mail file, the option Open John Doe's Mail is added to the Mail 
tab menu. 

You can set a new Calendar > Display preference to show meeting invitations as a "ghost" entry on your 
Calendar, to process cancellations automatically, and to either show them on your Calendar as cancelled, 
or just remove them. 

You can set up preferred sites, and meeting rooms/resources for those sites, that you can use when 
setting up meetings. Set a Calendar > Rooms Resources preference to always use a defined set of 
rooms and resources, to always add new ones when setting up meetings, or to prompt you for additional 
resources. 

Domino for System i Documentation 

Domino for System i 

System i: C and C++ Application requirements 
ATTENTION: 
Any applications that use the Domino C or C++ API on i5/OS need to be reviewed to make sure they are 
properly enabled for use with Domino on i5/OS.  

There are two important considerations: 

1.	 Bind to QNOTES/LIBNOTES 
Some applications incorrectly specify a library of *LIBL when binding to the LIBNOTES service 
program.  This can result in incorrect operation in a multi-versioned Domino environment.  
Applications must specify library QNOTES when binding to the LIBNOTES service program in order 
to function correctly in a multi-versioned environment.  

2.	 Enable for Teraspace 
When 64-bit support for Domino becomes available, Domino for i5/OS will also change to use the 
i5/OS 64-bit pointer and teraspace support.   To ensure proper operation, applications using the 
Domino C or C++ API must be teraspace-enabled.  This can be accomplished by recompiling the 
application with the teraspace compiler option specified.  This is expected to provide significant 
improvement in Domino i5/OS performance when 64-bit support is introduced.   
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For more details, see the following documents: 


Considerations when developing Domino C and C ++ API applications for i 5/OS:


http://www.ibm.com/support/docview.wss?rs=203&uid=swg21238494 

Domino 7 for i5/OS Application Development Guide  (Chapter 2 - Application Development 
Considerations) 

http://www.lotus.com/ldd/doc/uafiles.nsf/docs/i5osdom7/$File/apdev400.pdf 

For information on Domino 64-bit plans, see this document: 

http://www-1.ibm.com/support/docview.wss?rs=463&context=SSKTMJ&dc=DB520&uid=swg212 
33872&loc=en_US&cs=UTF-8&lang=en&rss=ct463lotus 

Domino Server, Domino for System i 

System i: CFGDOMSVR maximum length of DOM and ORG keywords 
When configuring a Domino server using the CFGDOMSVR CL command, the maximum length of the 
following keyword values are changed as follows: 

Keyword Maximum length 
Organization (ORG) 63 

Domain (DOM)  31 

Domino for System i 

System i: CFG/CHGDOMSVR TIMEZONE and DAYSAVTIME keywords 
The CL commands CFGDOMSVR and CHGDOMSVR that are used to configure Domino servers on 
System i are changed to incorporate support for the system value QTIMZON that was introduced in 
V5R3. 

CFGDOMSVR 
The Configure Domino Server (CFGDOMSVR) CL command is used to set up either a first Domino 
server or an additional Domino server. It is also used to remove an existing Domino server. 

CHGDOMSVR 
The Change Domino Server (CHGDOMSVR) CL command changes the configuration of an existing 
Domino server. You can use this command to change specific characteristics or to add features that 
were not included in the original server configuration.                                    

The TIMEZONE keyword of the CFGDOMSVR command is modified to accept a new value *SYSVAL 
which is the new default value.   

TIMEZONE-Specifies the time zone to be used by the Domino server. The possible values are: 

*SYSVAL 
Specify the Timezone for this Domino Server based on QTIMZON system value.        

time-zone 
Specify a new value for the time zone (GMT, ZW1, et. al.).                        
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The DAYSAVTIME keyword of the CFGDOMSVR command is modified to accept a new value 
*TIMEZONE. 

DAYSAVETIME Specifies whether the server time stamp should be adjusted for Daylight Savings 
Time.  This value does not affect the actual system time.  The possible values are: 

*YES 
Adjust the time stamp for Daylight Savings Time.                   

*NO 
Do not adjust the time stamp for Daylight Savings Time.            

*TIMEZONE 
Adjust the time stamp for Daylight Savings Time according to the Timezone system value. 

Note: *TIMEZONE cannot be specified here if *SYSVAL is not specified on the TIMEZONE 
parameter 

Similar values are accepted on the CHGDOMSVR CL command, along with the *SAME keyword.   

Refer to each command's Help Text for additional information and usage details. 

Domino for System i 

System i: Daylight Savings Time changes 
The United States and parts of Canada are extending the period of Daylight Savings Time (DST), 
beginning in 2007.  From 2007 onward, DST will commence on the second Sunday in March (three weeks 
earlier than previously), and end on the first Sunday in November (a one week extension).  For detailed 
information about these changes, and how they affect Notes and Domino, please see technote 
#21247972 at the following URL: 

http://www.ibm.com/support/docview.wss?rs=899&uid=swg21247972 

In addition, you can refer to the i5/OS Web page for additional information that pertains to iSeries and 
System i. 

http://www-03.ibm.com/servers/eserver/iseries/domino/dst2007.html 

Refer also to the release note:  System i: Daylight Savings Time change not recognized . 

Domino for System i 

System i: Parallel save capability with BRMS and i 5/OS V5R4 
BRMS has extended the parallel save and restore capability to the Integrated File System (IFS) with i5/OS 
V5R4. Domino users of BRMS may want to investigate whether this new capability will help to minimize 
their Domino backup window. 

Use the Work with Control Groups (WRKCTLGBRM) CL command and specify option 8 (Change 
Attributes) for the QLTSSVR (or your own) control group to change the Media Policy for Full Backup from 
"*NONE" to '2' (or more) more parallel devices.   

If parallel backup is selected, then BRMS is required on the restore operation. 
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Customers who run concurrent backups with Domino servers may already be minimizing the save time, if 
the servers consume approximately the same storage.   

For more information on this feature, refer to the BRMS Web page at the following URL:  

http://www-03.ibm.com/servers/eserver/iseries/service/brms/domino.html 

Domino for System i 

System i: Retrieve Domino Server Attributes API 
The Retrieve Domino Server Attributes  (QnninRtvDominoServerAttr ) API is used to retrieve specific 
information about each Domino server.  This API program retrieves all of the information provided by 
QnninRtvDominoServerI, plus additional information based on the format name.  It is modified in 
Domino 8 Beta to additionally retrieve IPv6 information. 

Retrieve Domino Server Attributes  (QnninRtvDominoServerAttr ): 
Required Parameter Group: 

1 Data buffer for Domino server information O Char(*) 
2 Data buffer length I Binary(4) 
3 Server name I Char(255) 
4 Server name length I Binary(4) 
5 Format name I Char(8) 
6 Error Code I/O Char(*) 

Service Program Name: QNNINLDS 
Similar Commands: None 

Authorities and Locks 
Default public authority 

*USE 

Required Parameter Group 
Data buffer for Domino server information 

OUTPUT; CHAR(*) 
This returns the information about a specific Domino server. For the format, see "Data Buffer". 

Data buffer length 
INPUT; BINARY(4) 
The length of the data buffer. The length must be at least big enough to hold the Bytes returned field 
and Bytes available field. Failure to provide enough room for the data will result in errors or 
incomplete data being returned. 

Server name 
INPUT; CHARACTER(255) 
The name of the Domino server to retrieve information. This is a blank padded field. If the server 
name was 10 characters long, then there would be 245 blanks following the server name. 

Server name length 
INPUT; BINARY(4) 
The length of the server name including the blanks. It should always be 255. 
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Format name 
INPUT; CHARACTER(8) 
The name of the format used to retrieve different Domino server attributes. You can use the following 
format names: 
DATR0100, DATR0200 

Error code 
I/O; CHAR(*) 
The structure in which to return error information. For the format of the structure, see Error Code 
Parameter. If this parameter is omitted, diagnostic and escape messages are issued to the 
application. 

Data Buffer 
For detailed descriptions of the fields in these tables, see Field Descriptions. 

DATR0100 Attribute Buffer 

Offset Dec Offset Hex Type Field 
0 0 Binary(4) Bytes returned 
4 4 Binary(4) Bytes available 
8 8 Binary(4) Primary type of Domino server 
12 C Binary(4) Secondary type of Domino server 
16 10 Binary(4) Number of active jobs in the subsystem 
20 14 Binary(4) Offset to data directory path 
24 18 Binary(4) Length of data directory path 
28 1C Binary(4) Offset to executable directory path 
32 20 Binary(4) Length of executable directory path 
36 24 Character(20) Subsystem description 
56 38 Character(10) Library name 
66 42  Binary(1) Server status 
67 43  Binary(1) Auto-Start with TCP/IP Servers 
68 44  Binary(4) Partition Number 
72 48  Binary(4) Offset to generic information 
76 4C  Binary(4) Length of generic information 
80 50  Character(16) Server release 
* * Character(*) Variable data 

DATR0200 Attribute Buffer 

Offset Dec Offset Hex Type Field 
0 0 Binary(4) Bytes returned 
4 4 Binary(4) Bytes available 
8 8 Binary(4) Primary type of Domino server 
12 C Binary(4) Secondary type of Domino server 
16 10 Binary(4) Number of active jobs in the subsystem 
20 14 Binary(4) Offset to data directory path 
24 18 Binary(4) Length of data directory path 
28 1C Binary(4) Offset to executable directory path 
32 20 Binary(4) Length of executable directory path 
36 24 Character(20) Subsystem description 
56 38 Character(10) Library name 
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DATR0200 Attribute Buffer (cont'd) 
Offset Dec Offset Hex Type Field 

66 42  Binary(1) Server status 
67 43  Binary(1) Auto-Start with TCP/IP Servers 
68 44  Binary(4) Partition Number 
72 48  Binary(4) Offset to generic information 
76 4C  Binary(4) Length of generic information 
80 50 Character(1) Log replication events 
81 51 Character(1) Log client session events 
82 52 Character(1) DOLS enabled 
83 53 Character(1) Day light savings time enabled 
84 54 Character(6) Time zone 
90 5A  Character(10) Collation sort order 
100 64  Character(11) SMTP type 
111 6F  Character(1) Directory type 
112 70  Character(1) Service provider configuration 
113 71  Character(3) Reserved 
116 74  Binary(4) Offset to organization name 
120 78  Binary(4) Length of organization name 
124 7C  Binary(4) Offset to web browser list, 

List Type 1 
128 80  Binary(4) Offset to News Readers List 

List Type 1 
132 84  Binary(4) Offset to Mail services List 

List Type 1 
136 88  Binary(4) Offset to Advanced services List 

List Type 1 
140 8C  Binary(4) Offset to Connection Services List 

List Type 1 
144 90  Binary(4) Offset to Directory Services List 

List Type 1 
148 94  Binary(4) Offset to Additional Services List 

List Type 1 
152 98  Binary(4) Offset to TCP Info List 

List Type 2 
156 9C  Binary(4) Offset to canonical name 
160 A0  Binary(4) Length of canonical name 
164 A4  Binary(4) Offset to server title 
168 A8  Binary(4) Length of server title 
172 AC  Binary(4) Offset to server host name 
176 B0  Binary(4) Length of server host name 
180 B4  Binary(4) Offset to domain name 
184 B8  Binary(4) Length of domain name 
188 BC  Binary(4) Offset to administrator(s) name(s) 
192 C0  Binary(4) Length of administrator(s) name(s) 
196 C4  Character(16) Server release 
* *  Character(*) Variable data 

181 



IBM Lotus Notes, Domino, Domino Designer 8 Release Notes 

Field Descriptions 

Auto - Start with TCP/IP servers: This is a flag that indicates if the server will be started automatically 
when TCP/IP is started on the system. 

z 0 - The server will not be started with TCP/IP 
z 1 - The server will be started with TCP/IP 

Bytes available: The length of data that could be returned by this API. This value is greater than "Bytes 
returned" when the length of the receiving variable is too small, causing truncation of data. 

Bytes returned: The length of data returned in this structure. This value includes this and all following 
fields. If the data is truncated because the receiver variable is not large enough to hold all of the data 
available, this value will be less than the bytes available value. 

Collation sort order : This field indicates which way the Domino server will sort characters.  The possible 
values are: 

*SAME HU Hungarian RU Cyrillic 
*STD Standard IS Icelandic SK Slovak 
CS Czech IT Italian SL-SI Slovenian 
DA-DK-AA Nordic 2to1 JA Japanese SQ-AL Albanian 
DE German KO Korean SV Swedish 
E2-ES Spanish - Modern LT Lithuanian TH Thai 
EL Greek LV Baltic TR Turkish 
EN Latin1                      NL Dutch ZH-CN Simplified Chinese 
ES Spanish - Traditional NO  Nordic ZH-TW Traditional Chinese 
ET-EE Estonian collation PL Latin2 
FI Finnish PL-PL  Polish
 FR French PT Portuguese
 HR Croatian RO Romanian 

Directory Type: This is a flag that indicates if the server is configured as a central directory or a 
config-only directory. The possible values are: 

z '1' - Central Directory 
z '2' - Config-Only Directory 

DOLS enabled: This is a flag that indicates if the server is enabled for Domino Offline Support (DOLS). 
The possible values are: 

z '0' - Not enabled for DOLS 
z '1' - Enabled for DOLS 

DST: This is a flag that indicates if the server is configured for Daylight Savings Time (DST). The possible 
values are: 

z '0' - Not configured for DST 
z '1' - Configured for DST 

Length of administrator name : This is the length of the data in the administrator name. 

Length of canonical name : This is the length of the data in the canonical name. If length is equal to 0 
(zero) then no canonical server name is available. Example of canonical server name:  
CN=MYSERVER/OU=SALES/O=ORG1/C=US 

Length of data directory path : This is the length of the data in the data directory path. 
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Length of domain name : This is the length of the data in the domain name (1-32). 

Length of executable directory path : This is the length of the data in the executable directory path. 

Length of generic information : This is the length of the data in the generic information. 

Length of organization name : This is the length of the data in the organization name (1-64). 

Length of server host name : This is the length of the data in the server host name (0-255). If length is 
equal to 0 (zero) then no server host name is available. 

Length of server title : This is the length of the data in the server title (0-60). If length is equal to 0 (zero) 
then no server title is available. 

Library name: This is the library name of the run time programs. 

Log client session events : This is a flag that indicates if client session events should be logged. The 
possible values are: 

z '0' - Do not log client session events 
z '1' - Log client session events. 

Log replication events : This is a flag that indicates if replication events should be logged. The possible 
values are: 

z '0' - Do not log replication events 
z '1' - Log replication events. 

Number of active jobs in the subsystem : This is the number of active jobs in the subsystem associated 
with this Domino server. If the Domino server is currently not running this value will be 0. If a -1 is returned 
then the number of active jobs running in the subsystem could not be determined. If a -1 is returned there 
is a diagnostic message written that gives some more information on why this information could not be 
retrieved. 

Offset to administrator name : This is the offset, from the start of the returned data, to where the 
administrator name can be found.  It will be somewhere within the variable data portion of the returned 
data. 

Offset to advanced services list : This is the offset, from the start of the returned data, to the list of 
advanced services of the server. This list is in List Type 1 format.  See below for the description of the List 
Type 1 format; 

Offset to canonical name : This is the offset, from the start of the returned data, to where the canonical 
name can be found. It will be somewhere within the variable data portion of the returned data. 

Offset to connection services list : This is the offset, from the start of the returned data, to the list of 
connection services of the server.  This list is in List Type 1 format.  See below for the description of the 
List Type 1 format; 

Offset to data directory path : This is the offset, from the start of the returned data, to where the data 
directory path can be found. It will be somewhere within the variable data portion of the returned data. 

Offset to directory services list : This is the offset, from the start of the returned data, to the list of directory 
services of the server.  This list is in List Type 1 format.  See below for the description of the List Type 1 
format; 
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Offset to domain name: This is the offset, from the start of the returned data, to where the domain name

can be found. It will be somewhere within the variable data portion of the returned data.


Offset to executable directory path : This is the offset, from the start of the returned data, to where the 

executable directory path can be found. It will be somewhere within the variable data portion of the

returned data. 


Offset to generic information : This is the offset, from the start of the returned data, to where the generic 

configurat information can be found.  It will be somewhere within the variable data portion of the returned

data. 


Offset to mail services list : This is the offset, from the start of the returned data, to the list of internet mail

packages of the server.  This list is in List Type 1 format.  See below for the description of the List Type 1 

format;


Offset to news readers list : This is the offset, from the start of the returned data, to the list of news readers

of the server.  This list is in List Type 1 format.  See below for the description of the List Type 1 format;


Offset to organization name : This is the offset, from the start of the returned data, to where the 

organization name can be found.  It will be somewhere within the variable data portion of the returned

data.


Offset to server host name : This is the offset, from the start of the returned data, to where the server host

name can be found. It will be somewhere within the variable data portion of the returned data.


Offset to server title : This is the offset, from the start of the returned data, to where the server title can be

found. 

It will be somewhere within the variable data portion of the returned data.


Offset to TCP/IP information list : This is the offset, from the start of the returned data, to the list of TCP/IP 

port information of the server.  This list is in List Type 2 format.  See below for the description of the List

Type 2 format;


Offset to web browsers list : This is the offset, from the start of the returned data, to the list of web browser

features of the server.  This list is in List Type 1 format.  See below for the description of the List Type 1 

format;


Partition Number: The internal partition number used by the Domino server to identifiy itself within a

partitioned server environment.


Primary type of Domino server : This is the type of Domino server. The possible values are: 


z 0 - Unknown Domino server type 
z 1 - Domino server 
z 2 - Stand alone QuickPlace server 
z 3 - Stand alone SameTime server 

If the server type is a Domino server, you may need to check the Secondary type of Domino server field to 
see if there are other capabilities of the server. 
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Secondary type of Domino server : This Domino server also has these additional capabilities. The 
possible values are: 

z 0 - No additional capabilities. 
z 1 - Also a QuickPlace server 
z 2 - Also a SameTime server 
z 3 - Also a QuickPlace AND SameTime server 

This field is only valid if the Primary type of Domino server field indicates a Domino server. 

Service provider configuration : This is a flag that indicates if the Service Provider Configuration (XSP) is 
enabled in the server. The possible values are: 

z '0' - XSP not enabled 
z '1' - XSP Enabled 

Server release: This is the release of the server in the format VRM. Example of a server release: 8.0.0 

Server status: This is the current status of the server. The possible values are: 

z 1 - Server ended 
z 2 - Server started 
z 3 - Server starting 
z 4 - Server ending 
z 5 - Server in standby mode 
z 99-Server in unknown status 

SMTP Type: This field indicates how the Domino server supports SMTP mail.  The possible values are: 

*MSF AS/400 SMTP server in combination with the AnyMail/400 Mail Server Framework (value 
is obsolete) 
*DOMINO Built-in Domino SMTP 
*QUICKPLACE Built-in QuickPlace SMTP (QuickPlace servers only) 

Subsystem description : This is the name of the subsystem description used for this Domino server. The 
first 10 bytes of the data will be the subsystem description name and the next 10 bytes will be the library 
name where the subsystem description can be found. 

Time Zone: This field indicates what time zone the server is configured for.  The possible values are: 
GMT Greenwich Mean Time BST Bering Standard Time HST Alaska-Hawaii 
Standard Time 
ZW1 1 hour West of GMT ZW12  12 hours West of GMT ZE6B 6 1/2 hours 
East of GMT 
ZW2 2 hours West of GMT ZE12C 12 3/4 hours East of GMT ZE6 6 hours East 
of GMT 
ZW3 3 hours West of GMT ZE12 12 hours East of GMT ZE5C 5 3/4 
hours East of GMT 
NST Newfoundland Standard Time ZE11B 11 1/2 hours East of GMT ZE5B 5 1/2 hours 
East of GMT 
AST Atlantic Standard Time ZE11 11 hours East of GMT ZE5 5 
hours East of GMT 
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EST Eastern Standard Time ZE10B 10 1/2 hours East of GMT ZE4B 4 1/2 hours 
East of GMT 
CST Central Standard Time ZE10 10 hours East of GMT ZE4 4 
hours East of GMT 
MST Mountain Standard Time ZE9B 9 1/2 hours East of GMT ZE3B 3 1/2 hours 
East of GMT 
PST Pacific Standard Time ZE9 9 hours East of GMT ZE3 3 hours East 
of GMT 
YST Yukon Standard Time ZE8 8 hours East of GMT ZE2 2 hours East 
of GMT 
ZW9B 9 1/2 hours West of GMT ZE7 7 hours East of GMT CET Central 
European Time 

Variable Data: This is the start of the variable data field. Use the offset and length fields to actually find 
and retrieve data from this area. 

List Formats 

List Type 1 

Offset Dec Offset Hex Type Field 
0 0 Binary(4) Number of Items in List 
4 4 Binary(4) Length of each item 
* * Character(*) Items in the list 

List Type 2 

Offset Dec Offset Hex Type Field 
0 0 Binary(4) Number of Items in List 
* * Character(*) TCP/IP list items in TCP List Format 

TCP List Format 

Offset Dec Offset Hex Type Field 
0 0 Binary(4) OffsetToNext Item 
4 4  Character(17) IPv4 Address 
21 15  Character(1) Port Enabled 
22 16  Character(10) Port Encrypted 
32 20  Binary(4) Offset To Port Name 
36 24  Binary(4) Length of Port Name 
40 28  Binary(4) Offset To Network Name 
44 2C  Binary(4) Length of Network Name 
48 30  Character(1) Port Compression 
49 31  Character(1) Type of Remote system information 
50 32  Character(2) Reserved 
52 34  Binary(4) Offset To Remote system information 
56 38  Binary(4) Length of Remote system information 
* *  Character(*) Variable data 
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TCP List Format Field Descriptions : 

IPv4 address: This is the IPv4 address for this Domino Server Port.  It is blank if an IP host name or IPv6 
address is available. 

Length of Network Name : This is the length of the Network Name data. 

Length of Port Name: This is the length of the port name data. 

Length of Remote system information : This is the length of the IP host name data, IPv4 address, or IPv6 
address. 

Offset to Network Name : This is the offset, from the start of this list element, to where the network name 
can be found. 

Offset to next item: This is the offset, from the start of the first element in the list, to where the next 
element can be found. 

Offset to Port Name: This is the offset, from the start of this list element , to where the port name can be 
found. 

Offset to Remote system information : This is the offset, from the start of this list element, to where the IP 
host name, IPv4 address, or IPv6 address can be found. 

Port Compression: This indicates if the data sent through the port is compressed. Possible values are; 

z '0' - Data is not compressed. 
z '1' - Data is compressed. 

Port Enabled: This is a flag that indicates if this Domino Server Port is enabled.  Possible values are; 

z '0' - Server port not enabled. 
z '1' - Server port is enabled. 

Port Encrypted: This indicates if the data sent through the port is encrypted.  Possible values are; 

z *ENCRYPT

z *NOENCRYPT


Reserved: This is a reserved field. 

Type of Remote system information : This indicates the type of address the Remote system information 
variable field contains for this Domino Server Port. Possible values are: 

z ‘1’ – “Remote system information” field contains an IPv4 address. 
z ‘2’ – “Remote system information” field contains an IPv6 address. 
z ‘3’ – “Remote system information” field contains the host name for this port. 

Variable Data: This is the start of the variable data field. Use the offset and length fields to actually find

and retrieve data from this area. 


Error Messages

CPF24B4: Severe error while addressing parameter list.

CPF3CF1: Error code parameter not valid

CPF3CF2: Error(s) occurred during running of &1 API.

CPF3C1E: Required parameter &1 omitted.

CPF3C21: Format name &1 is not valid.

CPF3C24: Length of the receiver variable is not valid.

LNT0907: The server name specified, &1, is not valid.
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Domino for System i 

System i: System Value QLOGOUTPUT

V5R4 introduced a new system value - QLOGOUTPUT (Job Log output).  This affects Domino servers / 

jobs as follows:


z	 Each Domino server runs in a separate subsystem.  The subsystem name is specified on the 
CFGDOMSVR command; the default is DOMINOxx, where xx is a number.  The WRKDOMSVR 
command shows the subsystem name.  

z	 Information for Subsystem is stored in the library QUSRNOTES 

z	 Each subsystem has a Job Description (JOBD)  used when submitting jobs to a system 

z	 To view JOBD: Enter the command WRKJOBD JOBD(QUSRNOTES/*ALL) 

z	 One of the parameter of JOBD is Job log output  , Keyword LOGOUTPUT: 

z	 When a job completes, one of three actions occur that affects how the job log is created. 
The following are values of the LOGOUTPUT parameter: 

z	 The job log server produces the job log: (*JOBLOGSVR) 

z	 The job itself produces the job log; if the job cannot produce its own job log, the job 
log will be produced by a job log server. (*JOBEND) 

z	 The job log is not produced; the job log remains in pending until it is removed. 
(*PND) 

z	 If LOGOUTPUT is set to *SYSVAL, the job uses the job log output value that is specified in 
the Job log output (QLOGOUTPUT) system value. 

z	 The shipped value for the Job log output (QLOGOUTPUT) system value is *JOBEND; the 
recommended value is *JOBLOGSVR. 

Additional information on JOBD and the QLOGOUTPUT can be found at: 

http://publib.boulder.ibm.com/iseries/ 

z	 Select V5R4 
z	 Search on qlogoutput 

Domino for System i 

System i: Use of the forward slash "/" character 
When issuing Domino console commands on System i, be aware of the command syntax and use of the 
forward vs. backward slash.  

For example, you may see the backward slash character "\" used to delimit directory and file names in 
general use examples. 

On System i, use the forward slash "/" character. 

188 



IBM Lotus Notes, Domino, Domino Designer 8 Release Notes 

Domino for System i 

System i: Using iSeries Navigator tasks on the Web 
Overview 
iSeries Navigator is the user interface of choice for many System i administrators, system operators, and 
end users. This Windows-based GUI, which is a part of the iSeries Access for Windows product, gives 
administrators an easy-to-use, Windows-based interface for managing key iSeries resources. 

However, in order to use iSeries Navigator, you must have the iSeries Access for Windows product 
installed, both on the iSeries and your PC. What if you are home, away from your primary PC at work, and 
you would like to perform some quick iSeries Navigator task. Maybe you need to check the system 
operator's message queue to make sure there are no messages needing a response before work can 
continue. Or you might need to check the status of a particular job that is currently running, or make sure 
a key piece of printer output is moved to the top of its print queue so it can be printed immediately. Well, 
with Domino 8 and i5/OS V5R4 you can perform these and many other tasks, even though you are away 
from your main work PC! All you need is a browser and access to the desired i5/OS system. 

This browser support is provided with a new feature called iSeries Navigator tasks on the Web. iSeries 
Navigator tasks on the Web allows you to perform a subset of iSeries Navigator tasks through an Internet 
Web browser.  The interface may look slightly different, but the tasks you can perform are the same as 
when using iSeries Navigator Windows interface.  

Administration of Domino servers from iSeries Navigator tasks on the Web is supported with i5/OS V5R4.  
This feature, allows you to perform most of the same tasks that you can perform when using the Domino 
plug-in for iSeries Navigator Windows interface, but from a browser. 

The iSeries Navigator Web interface for Domino differs from the iSeries Navigator Windows interface for 
Domino in that it is shipped with i5/OS, whereas, the iSeries Navigator Windows interface for  Domino is 
shipped as an iSeries Navigator plug-in as part of the Domino for System i product. Therefore, there is no 
need for any update operation to run on the client in order to get a newer version of the iSeries Navigator 
Web interface for Domino.  Whenever you update to a new i5/OS level, you get the latest version of the 
iSeries Navigator Web interface for Domino. 

Domino releases supported 

z Domino 6.0.x 
z Domino 6.5.x 
z Domino 7.0.x 
z Domino 8 

Languages supported 

z English 

Browsers supported 

z Microsoft Internet Explorer 6.0 
z Mozilla 1.7 
z Firefox 1.0.2 

Initial setup steps 
To administer Domino servers using iSeries Navigator tasks on the Web, you need at least one system at 
i5/OS V5R4 with SP3 (or later) that has the following products installed: 

z 5722SS1: (option 0003): Extended Base Directory Support  
z 5722SS1: (option 0012): OS/400 Host Servers 
z 5722SS1: (option 0030): OS/400 Qshell 
z 5722DG1: IBM HTTP Server for iSeries 
z 5722JV1: IBM Developer Kit for Java 
z 5722JV1: (option 6): Java Developer Kit 1.4 for Domino 6 & Domino 7 
z 5722JV1: (option 8): J2SE 5.0 32 bit  for Domino 8. 

189 



IBM Lotus Notes, Domino, Domino Designer 8	 Release Notes 

Required PTFs: 

z 5722SS1 Option 3  PTF SI24255 
z 5722DG1 Group PTF SF99114 Level 6 or later 

Prior to applying the 5722DG1 SF99114 Level 6 PTF(s), the end the following servers:   

IBM Help Server ENDTCPSVR *IBMHELP

ADMIN HTTP Server ENDTCPSVR *HTTP HTTPSVR(*ADMIN)

DDM Server ENDTCPSVR *DDM

LDAP Server ENDTCPSVR *DIRSVR


Note: You do not need the Domino product installed on the same i5 system that has the iSeries Navigator 
tasks for the Web support installed.  From any i5 system that has the Web support installed, Domino 
servers on any i5 system in the network can be managed. Also, any supported release of Domino for i5 
can be administered using this Web interface. 

Before users can access iSeries Navigator tasks on the Web, the system administrator needs to modify 
the HTTP Administration server configuration to automatically start the system application server 
instance. This special "system instance" must be configured and started before the iSeries Navigator Web 
application can function. To do this, the system administrator needs to perform these tasks: 

1.	 Start the HTTP Administration server if it is not already started

> STRTCPSVR SERVER(*HTTP) HTTPSVR(*ADMIN) 


2. Go to the HTTP Administration Web page: http://<system>:2001/HTTPAdmin (where <system> 
is the host name of the iSeries system). 
3.	 Click on the "Manage" tab 
4.	 Click on the "HTTP Servers" tab, then select "ADMIN - Apache" from the Server list 
5.	 Click on "General Server Configuration" in the left pane of the current page 
6.	 Specify "Yes" for "Start the system application server instance when the  'Admin' server is started 

" 
7.	 Specify "Yes" for "Stop the system application server instance when the  'Admin' server is


stopped" 

8.	 Click the "Apply" button 
9.	 Stop, then start the HTTP Administration server so these configuration changes take effect 

Once this "one time" configuration change is made to the HTTP Administration server, and the server is 
restarted, users will be able to access iSeries Navigator tasks on the Web. 

Note: For more information on how to set up this Web environment on your system, see in the IBM 
iSeries Information Center : 

http://publib.boulder.ibm.com/infocenter/iseries/v5r4/index.jsp?lang=en 

After you have set up iSeries Navigator tasks on the Web, all you need on your PC is a Web browser that 
connects to the Internet and you can begin working with the Domino tasks by clicking View All Tasks and 
selecting the Network tab. 

Also, you do not need to worry about learning a new interface for these Web tasks. The exact same code 
and user interface that are used within iSeries Navigator on the client are also used on the Web.  So, for 
example, if you're already familiar with the iSeries Navigator for Windows panel that appears when you 
select the "properties" action of a Domino server, you will see the exact same interface when you select 
"properties" of a Domino server on the Web. 
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You can also create your own URL that points to the Domino tasks on the Web, as well as other iSeries 
Navigator tasks on the Web, by using the URL Advisor. To use the URL Advisor, visit the following URL 
from a Web browser: 

http://<hostA>:<port>/webnav/WnServlet?task=home  

where: 

<hostA> is the iSeries system name. 
<port> is the HTTP port number set up with iSeries Navigator Web interface. 

Click Create a URL... to create the URL for the Domino tasks on the Web. 

Working with the Domino tasks on the Web 

Not all Domino operations that are available with the iSeries Navigator Windows interface are allowed in 
the Web interface. The following table shows the Domino operations that can be performed using the 
Web interface to Domino servers that reside in the network, and the special authorities needed for the 
user profile performing them: 

Special 
Operations Authorities Steps to follow 

needed 

Change the 
properties of a 
Domino server 

*ALLOBJ 
*JOBCTL 
*SECADM 
*IOSYSCFG 

To change the properties of a Domino server: 
1. Locate the system where the Domino server resides. 
2. Select Network. 
3. Select Domino Servers. 
4. Click the pop menu from a Domino server in the server list 

and select Properties. 
5. Change any of the properties of the Domino server and click 

OK. 

Delete a 
*ALLOBJ 
*JOBCTL 

To delete a Domino server from a system: 
1. Locate the system where the Domino server resides. 
2. Select Network. 

Domino server *SECADM 3. Select Domino Servers. 
*IOSYSCFG 4. Click the pop menu from a Domino server in the server list 

and select Delete. 
To start a Domino server, controller, or both on a system: 

1. Locate the system where the Domino server resides. 
2. Select Network. 
3. Select Domino Servers. 

Start Domino 

4. Click the pop menu from a Domino server in the server list. 
5. Click Start and select one of the following: Server, Controller 

or Server and Controller . 
servers or *JOBCTL 
controllers To start all existing Domino servers, controllers, or both on a system: 

1. Locate the system where the Domino servers reside. 
2. Select Network. 
3. Select Domino Servers. 
4. In Select Action, select one of the following: Start > All 

Servers, Start > All Controllers or Start > All Servers and 
Controllers. 
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Special 
Operations Authorities Steps to follow 

needed 
Stop Domino 
servers or 
controllers 

*JOBCTL To stop a Domino server, controller, or both on a system: 
1. Locate the system where the Domino server resides. 
2. Select Network. 
3. Select Domino Servers. 
4. Click the pop menu from a Domino server in the server list. 
5. Select Stop and click one of the following: Server, Server 

Immediately, Server and Controller  or Server and Controller 
Immediately. 

To stop all existing Domino servers, controllers, or both on a system: 
1. Locate the system where the Domino servers reside. 
2. Select Network. 
3. Select Domino Servers. 
4. In Select Action, select one of the following: Stop > All 

Servers, Stop > All Servers and Controllers , Stop > All 
Servers Immediately or Stop > All Servers and Controllers 
Immediately. 

Launch *JOBCTL To launch WebAdmin.nsf: 
WebAdmin.nsf 1. Locate the system where the Domino server resides. 

2. Select Network. 
3. Select Domino Servers. 
4. Click the pop menu from a Domino server in the server list 

and select Server Administration . 
5. Specify the HTTP port and click OK. 

Add a Domino 
Application 

*ALLOBJ 
*SECADM 
*IOSYSCFG 

To add a Domino Application to a Domino server: 
1. Locate the system where the Domino server resides. 
2. Select Network. 
3. Select Domino Servers. 
4. Click the pop menu from a Domino server in the server list 

and select Add Application. 

Usage notes: 
The Domino server must already be set up on the system.z 

The licensed program and option being added must bez 

installed on the system. 
Add QuickPlace *ALLOBJ To add QuickPlace or Sametime to a Domino server: 
or Sametime to 
a Domino 

*JOBCTL 
*SECADM 

1. Locate the system where the Domino server resides. 
2. Select Network. 

server *IOSYSCFG 3. Select Domino Servers. 
4. Click the pop menu from a Domino server in the server list 

and select either of the following: Add QuickPlace or Add 
Sametime. 

Remove *ALLOBJ To remove QuickPlace or Sametime from a Domino server: 
QuickPlace or *JOBCTL 1. Locate the system where the Domino server resides. 
Sametime from *SECADM 2. Select Network. 
a Domino *IOSYSCFG 3. Select Domino Servers. 
server 4. Click the pop menu from a Domino server in the server list 

and select either of the following: Remove QuickPlace or 
Remove Sametime. 
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Special 
Operations Authorities Steps to follow 

needed 
To view the active jobs related to the Domino servers on a system: 

View the active 1. Locate the system where the Domino servers reside. 
jobs related to 
the Domino *NONE 2. Select Network. 

3. Select Domino Servers. 
servers 4. In Select Action, select Domino Jobs. The jobs are displayed 

in a new window, sorted by subsystem. 
To see the version of the Domino plug-in that you are using: 

Display the 1. Locate the system where the Domino server resides. 
Domino plug-in *NONE 2. Select Network. 
version 3. Select Domino Servers. 

4. In Select Action, select Display Plugin Version . 

Working with 
Domino servers 

You must have 
at least one of 
the following: 

*ALLOBJ 
*JOBCTL 
*SECADM 
*IOSYSCFG 

To work with existing Domino servers on a system: 
1. Locate the system where the Domino servers reside. 
2. Select Network. 
3. Select Domino Servers. 
4. The Domino servers list appears in a new window. 
5. Click the pop menu from a Domino server of your choice to 

bring up a context menu where you can select different 
operations to apply to the Domino server. Ability to run an 
operation depends on the special authorities it requires, as 
described in this table. 

Usage notes: 
You can sort the Domino servers by name or by creation datez 

in the new window. To sort the servers by name, click Server 
Name at the top of that column. To sort the Domino servers 
by creation date, click Server Name again. 
To view the Domino server status the user profile must havez 

*USE object authority  to the QUSRNOTES library. 

Other operations over Domino tasks on the Web 

z	 FIND TOOLBAR only searches for the first satisfied result, next search begins from previous 
search result. 

z	 On TABLE ACTIONS TOOLBAR, Select All only takes effect on current page, this functionality 
isn't supported by the Domino tasks on the Web, it uses the "Start All Domino servers or 
controllers" and "Stop All Domino servers or controllers" operations to work with all severs. 

z	 On TABLE ACTIONS TOOLBAR, when Edit Sort is used with Server Name, by descending the 
list appears by the date created in default and by ascending the list is shown alphabetically, 
sorting list by "Status" or "Version" are not enabled. 

z	 After USER AUTHORITY is changed, possibly the WAS (WebSphere Application Server) 

instance will need to be restarted to take effect.


z	 Launch WebAdmin.nsf is used as instance of "Start Domino console" and "Server Administration" 
options used on Domino plug-in for iSeries Navigator. 

Operations not supported 

z	 Configure a new Domino server. 
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Domino for System i 

System i: WRKDOMSVR new options - 14, 15, 16 and F23

The following options were added to the CL command WRKDOMSVR:


F23=More options

Displays more options that you can use to perform operations on the Domino Servers in the list.                                


14=Work with support files 
Use this option to work with support files in '<data directory>/ IBM_TECHNICAL_SUPPORT/' IFS 
directory that is used by the Domino server. This option runs the Work with Object Links (WRKLNK) 
command. To perform operations using the WRKLNK command, you must have the following authorities: 

z	 *USE authority to the command used by the operation and the appropriate authority to the objects on 
which the operation is to be performed. 

z	 *R authority to the directory containing the object links and *X authority to the other directories in the 
path. Object authority is not required when displaying the object name only.                                                 

15=Work with NSDs 
Use this option to work with NSD files in '<data directory>/ IBM_TECHNICAL_SUPPORT/nsd*' IFS 
directory that is used by the Domino server. This option runs the Work with Object Links (WRKLNK) 
command. To perform operations using the WRKLNK command, you must have the following authorities: 

z	 *USE authority to the command used by the operation and the appropriate authority to the objects on 
which the operation is to be performed. 

z	 *R authority to the directory containing the object links and *X authority to the other directories in the 
path. Object authority is not required when displaying the object name only.  

16=Dump server call stacks 
Use this option to dump call stacks of all the threads of jobs from the selected server. This option runs the 
Dump Domino Server Call Stacks (DMPDOMSVRC) command. 

Sametime Help 

Lotus Notes 

Sametime Contacts Help

You can find Help for the Sametime instant messaging features by choosing Help -> Help Contents and 

then selecting Sametime Contacts in the navigator.  Please note that some of the features described in

the Help may not be available to you.
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Lotus Notes 

Sametime Show Online Settings 
There are two settings to Show Online Users only for Instant Messaging.  One is persistent, meaning that 
the setting is stored after the client session has ended, the other is not.  Please see the graphics below for 
more information. 

Persistent Not Persistent 
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Notices and Trademarks 

Notices 

Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), 
Domino for System i, Domino for System z 

License agreement 
Any information or reference related to license terms in this document is provided to you for your 
information.  However, your use of Notes and Domino, and any other IBM program referenced in this 
document, is solely subject to the terms and conditions of the IBM International Program License 
Agreement (IPLA) and related License Information (LI) document accompanying each such program.  
You may not rely on this document should there be any questions concerning your right to use Notes and 
Domino. 

IBM Product Licenses are available for reference at: http://www-03.ibm.com/software/sla/sladb.nsf 

Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), 
Domino for System i, Domino for System z 

Notices 
This information was developed for products and services offered in the USA. IBM may not offer the 
products, services, or features discussed in this document in all countries. Consult your local IBM 
representative for information on the products and services currently available in your area. Any reference 
to an IBM product, program, or service is not intended to state or imply that only that IBM product, 
program, or service may be used. Any functionally equivalent product, program, or service that does not 
infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to 
evaluate and verify the operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this document. 
The furnishing of this document does not give you any license to these patents. You can send license 
inquiries, in writing, to: 

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property 
Department in your country/region or send inquiries, in writing, to: 

IBM World Trade Asia Corporation Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106, Japan 
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The following paragraph does not apply to the United Kingdom or any other country/region where such 
provisions are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE. 

Some states do not allow disclaimer of express or implied warranties in certain transactions; therefore, 
this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are periodically 
made to the information herein; these changes will be incorporated in new editions of the publication. IBM 
may make improvements and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 

References in this publication to IBM products, programs, or services do not imply that they will be 
available in all countries in which IBM operates. Product release dates and/or capabilities referenced in 
this publication may change at any time at IBM’s sole discretion based on market opportunities or other 
factors, and are not intended to be a commitment to future product or feature availability in any way. 

Any references in this information to non-IBM Web sites are provided for convenience only and do not in 
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part 
of the materials for this IBM product, and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes appropriate without 
incurring any obligation to you. 

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the 
exchange of information between independently created programs and other programs (including this 
one) and (ii) the mutual use of the information that has been exchanged, should contact: 

Lotus Software 
IBM Software Group 
One Rogers Street 
Cambridge, MA 02142 
USA 

Such information may be available, subject to appropriate terms and conditions, including in some cases 
payment of a fee. 

The licensed program described in this document and all licensed material available for it are provided by 
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement, or by 
any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled environment. Therefore, the 
results obtained in other operating environments may vary significantly. Some measurements may have 
been made on development-level systems, and there is no guarantee that these measurements will be 
the same on generally available systems.  Furthermore, some measurements may have been estimated 
through extrapolation. Actual results may vary. Users of this document should verify the applicable data 
for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of those products, their 
published announcements, or other publicly available sources. IBM has not tested those products and 
cannot confirm the accuracy of performance, compatibility, or any other claims related to non-IBM 
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of 
those products. 
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All statements regarding IBM's future direction or intent are subject to change or withdrawal without 
notice, and represent goals and objectives only. 

This information contains examples of data and reports used in daily business operations. To illustrate 
them as completely as possible, the examples include the names of individuals, companies, brands, and 
products.  All of these names are fictitious and any similarity to the names and addresses used by an 
actual business enterprise is entirely coincidental. 

Trademarks 

Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), 
Domino for System i, Domino for System z 

Trademarks 
IBM, the IBM logo, AIX, DB2, Domino, iSeries, i5/OS, Lotus, Lotus Notes, LotusScript, Notes, QuickPlace, 
Sametime, System i, System i5, System z, WebSphere, z/OS, and zSeries are trademarks or registered 
trademarks of IBM Corporation in the United States, other countries, or both. 

Additional IBM copyright information can be found at: http://www.ibm.com/legal/copytrade.shtml 
TM

This product is Built on Eclipse  (http://www.eclipse.org). 

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. in the United 
States, other countries, or both. 

Microsoft, Windows, Windows Vista, and the Windows logo are trademarks of Microsoft Corporation in the 
United States, other countries, or both. 

Intel and Pentium are trademarks of Intel Corporation in the United States, other countries, or both. 

Macrovision and InstallShield are registered trademarks of Macrovision Corporation. 

The Graphics Interchange Format© is the Copyright property of CompuServe Incorporated.  GIF(sm) is a 
Service Mark property of CompuServe Incorporated. 

UNIX is a registered trademark of The Open Group in the United States and other countries. 

Linux is a trademark of Linus Torvalds in the United States, other countries, or both. 

Other company, product and service names may be trademarks or service marks of others. 
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